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Read Me First

= Notes on Online Manual Usage
= How to Print

Notes on Online Manual Usage

» Reproduction, diversion or copying of any text, photo or image published in the Online Manual
(hereinafter referred to as "this guide"), in whole or in part, is prohibited.

* In principle, Canon shall change or delete the contents of this guide without prior notice to customers.
In addition, Canon may suspend or stop the disclosure of this guide due to unavoidable reasons.
Canon shall not be liable for any damage suffered by customers as a result of changes in or deletion
of information in this guide, or suspension/stoppage of disclosure of this guide.

» Although the contents of this guide have been prepared with utmost care, please contact the service
center if you find any incorrect or missing information.

* In principle, the descriptions in this guide are based on the product at the time of its initial sale.

» This guide does not disclose the manuals of all the products sold by Canon. See the manual supplied
with the product when using a product that is not described in this guide.

How to Print

Use the print function of your Web browser to print this guide.

To set to print background colors and images, follow the steps below.

> Note

* In Windows 8, print in the desktop version.

* In Internet Explorer 9, 10, or 11

1. Select {@} (Tools) > Print > Page setup....
2. Select the Print Background Colors and Images checkbox.

* In Internet Explorer 8

1. Press the Alt key to display the menus.

Alternatively, from Tools, select Toolbars > Menu Bar to display the menus.
2. Select Page Setup... from the File menu.
3. Select the Print Background Colors and Images checkbox.

* In Mozilla Firefox

1. Press the Alt key to display the menus.
Alternatively, click Firefox, then select Menu Bar from the right arrow of Options to display the
menus.

2. Select Page Setup... from the File menu.

3. Select the Print Background (colors & images) checkbox in Format & Options.

* In Google Chrome

1. Select = (Chrome Menu) > Print....
2. Select the Background colors & images checkbox in Options.



How to Use the Online Manual

Symbols Used in This Document

A\ Warning
Instructions that, if ignored, could result in death or serious personal injury caused by incorrect
operation of the equipment. These must be observed for safe operation.

/A Caution
Instructions that, if ignored, could result in personal injury or material damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

3% Important
Instructions including important information. To avoid damage and injury or improper use of the
product, be sure to read these indications.

»>» Note

Instructions including notes for operation and additional explanations.

Instructions explaining basic operations of your product.

»» Note

* Icons may vary depending on your product.

Touch-enabled Device Users

For touch actions, you need to replace "right-click" in this document with the action set on the operating
system. For example, if the action is set to "press and hold" on your operating system, replace "right-click"

with "press and hold."



Trademarks and Licenses

» Microsoft is a registered trademark of Microsoft Corporation.

» Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

* Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other
countries.

* Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or
other countries.

* Mac, Mac OS, AirPort, Safari, Bonjour, iPad, iPhone and iPod touch are trademarks of Apple Inc.,
registered in the U.S. and other countries. AirPrint and the AirPrint logo are trademarks of Apple Inc.

* 10S is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under
license.

» Google Cloud Print, Google Chrome, Android, Google Play and Picasa are either registered trademarks
or trademarks of Google Inc.

» Adobe, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB (1998) are either
registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other
countries.

» Photo Rag is a trademark of Hahnemdhle FineArt GmbH.

* Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.

»» Note

» The formal name of Windows Vista is Microsoft Windows Vista operating system.

Copyright (c) 2003-2004, Apple Computer, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Computer, Inc. ("Apple") nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO
EVENT SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE.

Apache License
Version 2.0, January 2004

http://www.apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION



1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii)
beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under
the License, as indicated by a copyright notice that is included in or attached to the work (an example
is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other
modifications represent, as a whole, an original work of authorship. For the purposes of this License,
Derivative Works shall not include works that remain separable from, or merely link (or bind by name)
to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity
authorized to submit on behalf of the copyright owner. For the purposes of this definition, "submitted"
means any form of electronic, verbal, or written communication sent to the Licensor or its
representatives, including but not limited to communication on electronic mailing lists, source code
control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor for
the purpose of discussing and improving the Work, but excluding communication that is
conspicuously marked or otherwise designated in writing by the copyright owner as "Not a
Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and
otherwise transfer the Work, where such license applies only to those patent claims licensable by
such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of



their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent
litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the
Work or a Contribution incorporated within the Work constitutes direct or contributory patent
infringement, then any patent licenses granted to You under this License for that Work shall terminate
as of the date such litigation is filed.

. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and

2. You must cause any modified files to carry prominent notices stating that You changed the files;
and

3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright,
patent, trademark, and attribution notices from the Source form of the Work, excluding those
notices that do not pertain to any part of the Derivative Works; and

4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that
You distribute must include a readable copy of the attribution notices contained within such
NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in at
least one of the following places: within a NOTICE text file distributed as part of the Derivative
Works; within the Source form or documentation, if provided along with the Derivative Works; or,
within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not
modify the License. You may add Your own attribution notices within Derivative Works that You
distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such
additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or

different license terms and conditions for use, reproduction, or distribution of Your modifications,

or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of
the Work otherwise complies with the conditions stated in this License.

. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.

. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS I1S" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without
limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or
FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any risks associated with Your
exercise of permissions under this License.

. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of
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goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages
or losses), even if such Contributor has been advised of the possibility of such damages.

. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof,
You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other
liability obligations and/or rights consistent with this License. However, in accepting such obligations,
You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any

liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
such warranty or additional liability.

END OF TERMS AND CONDITIONS
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Enter keywords in the search window and click E (Search).

You can search for target pages in this guide.

Search Tips

You can search for target pages by entering keywords in the search window.

Canon » Language
Search Tips &

Online Manual

You can see manuals of your product and applications.

Product Manuals

You can learm how to handle and operate your product.

»» Note

» The displayed screen may vary.

* When searching from this page or the "Home" page without entering your product's model name or your
application's name, all products supported by this guide will be considered for the search.
If you want to narrow down the search results, add your product's model name or your application's
name to the keywords.

» Searching for Functions
Enter your product's model name and a keyword for the function you want to learn about
Example: When you want to learn how to load paper
Enter "(your product's model name) load paper" in the search window and perform a search
» Troubleshooting Errors
Enter your product's model name and a support code

Example: When the following error screen appears
Enter "(your product's model name) 1000" in the search window and perform a search

12



Cancn BN scries N

poor Code ; 1000

Paper has fun aut.
Mada Type : Plain Paper
Fage Size : Letler B.5"%11" 22¢28cm

1. Load paperinto the rear bray, 2, Pressihe printer’s Stat
button

If Emaor Parsicts

»» Note

» The displayed screen varies depending on your product.

» Searching for Application Functions

Enter your application's name and a keyword for the function you want to learn about

Example: When you want to learn how to print collages with My Image Garden
Enter "My Image Garden collage" in the search window and perform a search

» Searching for Reference Pages

Enter your model name and a reference page title*

* You can find reference pages more easily by entering the function name as well.

Example: When you want to browse the page referred to by the following sentence on a scanning

procedure page

Refer to "Color Settings Tab" for your model from Home of the Online Manual for details.
Enter "(your product's model name) scan Color Settings Tab" in the search window and perform a

search
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Notes on Operation Explanations

In this guide, most of the operations are described based on the windows displayed when Windows 8.1
operating system (called Windows 8.1 below) or Windows 8 operating system (called Windows 8 below) is

used.
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Useful Functions Available on the Machine

» View Photos Easily Using My Image Garden

» Connection Methods Available on the Machine
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View Photos Easily Using My Image Garden

Organize Images Easily

In My Image Garden, you can register the names of people and events to photos.
You can organize photos easily as you can display them not only by folder but also by calendar, event,
and person. This also allows you to find the target photos easily when you search for them later on.

<Calendar View>

Display Recommended Items in Slide Shows

Based on the information registered to photos, Quick Menu automatically selects the photos on your
computer and creates recommended items such as collages and cards. The created items appear in slide
shows.

Place Photos Automatically

Delightful items are created easily as the selected photos are placed automatically according to the
theme.

16



Other Various Functions

My Image Garden has many other useful functions.

Refer to "What You Can Do with My Image Garden" for details.
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Connection Methods Available on the Machine

The following connection methods are available on the machine.

USB Connection

&
o

USB Connection

Connect the scanner and a computer with a USB cable. Prepare a USB cable.

18



Overview of the Machine

» Safety Guide

@ Safety Precautions
@ Regulatory and Safety Information

v

Main Components

v

Placing Items
& Place the Item on the Platen
@ [tems You Can Place & How to Place Items

v

Maintenance

v

Precautions for Safe Transport of the Machine

Y

Legal Limitations on Use of Your Product and Use of Images

Y

Specifications
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Safety Guide

» Safety Precautions

» Regulatory and Safety Information
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Safety Precautions

Choosing a location

Do not install the machine in a location that is unstable or subject to excessive vibration.

Do not install the machine in locations that are very humid or dusty, in direct sunlight, outdoors, or
close to a heating source.

To avoid the risk of fire or electric shocks, use the machine under the operating environment specified
in the On-screen Manual.

Do not push the scanner into a narrow cabinet or put a tablecloth on it or place on a thick rug. If the
scanner generates heat by doing so, it may cause damage.

Do not set up in areas where there are excessive fluctuations in temperature. Also do not move the
scanner from low-temperature areas to high temperature areas. Condensation may cause image
errors. Leave the scanner enough time to gradually adapt to the new conditions before use.

Do not place the scanner in areas with high humidity, areas subject to direct sunlight, areas with high
temperatures and areas near flame sources. Fire or electrical shock may result.

Leave enough space (approximately 8 in. (20 cm)) around the scanner when setting up.

Power supply

When unplugging the USB cable, always pull on the main body. Pulling the cable may damage the
wires and lead to fire or electrical shock.

Do not apply excessive force to plug or unplug USB cable.

Do not damage or modify the USB cable.

Do not place heavy objects on, pull or excessively bend, twist or tie the USB cable.

Do not twist or tie the USB cable.

Plug the USB cable completely into the connector.

Working around the machine

When setting up the stand, read carefully the paper manual for setting up the stand and place the
scanner on the stand correctly.

Keep the document cover closed except when necessary.

Never put your hands or fingers in the scanner while it is scanning.

Hold the scanner firmly with both hands at two ends when carrying it.

Do not place any objects on the scanner, especially paper clips, staples and other metallic part or
containers filled with alcohol, thinners or other flammable liquid.

Always release the scanner lock before connecting the scanner to a computer.

Running the scanner while it is locked will damage the scanner.

When loading a thick book on the platen glass, do not press hard on the document cover.

The platen glass may break.

Do not release the document cover until it completely opens/closes.

Do not place items that weigh 2.0 kg (4.4 Ibs.) or more on the platen glass. Also, do not press heavily
(i.e., more than 2.0 kg (4.4 Ibs.)) on the document cover or the platen glass.

Do not drop heavy books or objects on the scanner. Also do not give a shock to the platen glass. The
platen glass may break.

When not in use for extended periods, unplug the USB cable for safety.
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Regulatory and Safety Information

For models containing lithium battery

» Dispose of used batteries according to the local regulations.
 Risk of explosion if battery is replaced by an incorrect type.

Users in the U.S.A.

FCC Notice (U.S.A. Only)
For 120V, 60Hz model
Model Number: K10403

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference
received, including interference that may cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this equipment
does cause harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

» Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

» Consult the dealer or an experienced radio/TV technician for help.

Use of a shielded cable is required to comply with Class B limits in Subpart B of Part 15 of the FCC Rules.

Do not make any changes or modifications to the equipment unless otherwise specified in the manual. If
such changes or modifications should be made, you could be required to stop operation of the equipment.

Canon U.S.A,, Inc.

One Canon Park
Melville, New York 11747
1-800-652-2666

Only for European Union and EEA (Norway, Iceland and Liechtenstein)

h2d

This symbol indicates that this product is not to be disposed of with your household waste, according to
the WEEE Directive (2012/19/EU) and national legislation. This product should be handed over to a
designated collection point, e.g., on an authorized one-for-one basis when you buy a new similar product
or to an authorized collection site for recycling waste electrical and electronic equipment (EEE). Improper
handling of this type of waste could have a possible negative impact on the environment and human

22



health due to potentially hazardous substances that are generally associated with EEE. At the same time,
your cooperation in the correct disposal of this product will contribute to the effective usage of natural
resources. For more information about where you can drop off your waste equipment for recycling, please
contact your local city office, waste authority, approved WEEE scheme or your household waste disposal
service. For more information regarding return and recycling of WEEE products, please visit www.canon-
europe.com/weee.

Korisnici u Srbiji

)24

Ovaj simbol oznagava da ovaj proizvod ne sme da se odlaZe sa ostalim kuénim otpadom, u skladu sa
WEEE Direktivom (2012/19/EU) i nacionalnim zakonima. Ovaj proizvod treba predati odredenom centru
za prikupljanje, npr. na osnovi "jedan-za-jedan" kada kupujete sli¢an novi proizvod, ili ovlaS¢enom centru
za prikupljanje za reciklazu istroSene elektri¢ne i elektronske opreme (EEE). Nepravilno rukovanje ovom
vrstom otpada mozZe da ima moguce negativne posledice po Zivotnu sredinu i ljudsko zdravlje usled
potencijalno opasnih materijala koji se uglavhom vezuju za EEE. U isto vreme, vaSa saradnja na
ispravnom odlaganju ovog proizvoda ¢e doprineti efikasnom koriS¢enju prirodnih resursa. Za vise
informacija o tome gde mozete da predate vasu staru opremu radi recikliranje, vas molimo, da
kontaktirate lokalne gradske vlasti, komunalne sluZbe, odobreni plan reciklaZe ili Gradsku ¢&istoéu. Za viSe
informacija o vra¢anju i recikliranju WEEE proizvoda, posetite stranicu www.canon-europe.com/weee.

India only.

)i¢

This product is not to be disposed of with your household waste, according to the e-waste (Management
and Handling) Rules, 2011.

This product should be handed over to a designated collection point, e.g., to an authorized collection site
for recycling waste electrical and electronic equipment (EEE). Improper handling of this type of waste
could have a possible negative impact on the environment and human health due to potentially hazardous
substances that are generally associated with EEE. At the same time, your cooperation in the correct
disposal of this product will contribute to the effective usage of natural resources. For more information
regarding return and recycling of WEEE products, please visit http://www.canon.co.in/environment/.

Also, this product complies with the "India E-waste Rule 2011" and prohibits use of lead, mercury,
hexavalent chromium, polybrominated biphenyls or polybrominated diphenyl ethers in concentrations
exceeding 0.1 % by weight and 0.01 % by weight for Cadmium, except for the exemptions set in Schedule
Il of the Rule.

Environmental Information

Reducing your environmental impact while saving money

Power Consumption and Activation Time

The amount of electricity a device consumes depends on the way the device is used. This product is
designed and set in a way to allow you to reduce your electricity costs. After the last print it switches to
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Ready Mode. In this mode it can print again immediately if required. If the product is not used for a time,
the device switches to its Power Save Mode. The devices consume less power (Watt) in these modes.
If you wish to set a longer Activation Time or would like to completely deactivate the Power Save Mode,
please consider that this device may then only switch to a lower energy level after a longer period of
time or not at all.

Canon does not recommend extending the Activation Times from the optimum ones set as default.

Energy Star®

The Energy Star® programme is a voluntary scheme to promote the development and purchase of
energy efficient models, which help to minimise environmental impact.
Products which meet the stringent requirements of the Energy Star® programme for both environmental

benefits and the amount of energy consumption will carry the Energy Star® logo accordingly.

Paper types

This product can be used to print on both recycled and virgin paper (certified to an environmental
stewardship scheme), which complies with EN12281 or a similar quality standard. In addition it can
support printing on media down to a weight of 64g/m2, lighter paper means less resources used and a
lower environmental footprint for your printing needs.

Regulatory Model Code (RMC) is for identification and proof that the product complies with the
regulations. Please note that RMC is different from the marketing model number of the product.

i)

EMERGY STAR
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Main Components

(1)
(2)
(3)

(1) document cover
Presses down the placed item.

(2) scanning unit
The main part of the scanner that emits light and scans items.

(3) platen
Place the item to be scanned.

(4) alignment mark
Align a corner of the item with this mark.

(5) scanner buttons
You can scan easily according to your purpose by simply pressing a button.
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PDF buttons
SCAN START button
FINISH button

AUTO SCAN button
COPY button
SEND button

(6)
(7)

(6) scanner lock switch
Lock or unlock the scanning unit.

(7) stand locking slot
Insert the hook of the stand when setting the scanner upright.

(8)

(8) USB connector
Connect the supplied USB cable.

32 Important

» There is no power switch or power lamp on this scanner. No AC adapter or power cord is required.
When you connect a computer and the scanner with the USB cable and turn on the computer, the
scanner also turns on.

26



Placing Items

» Place the Iltem on the Platen

» Items You Can Place & How to Place Items
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Place the Item on the Platen

Place the item you want to scan on the platen.

»» Note

» To scan by using the stand, refer to "Using the Stand".

1. Place the item on the platen.
1. Open the document cover.

2. Place the item on the platen with the side to scan facing down.

= |tems You Can Place & How to Place Items

2% Important

* Be sure to observe the following when placing the item on the platen. The scanner may not work
correctly or the glass may break.

» Do not place any objects weighing 4.4 Ib (2 kg) or more on the platen
» Do not put any pressure of 4.4 Ib (2 kg) or more on the platen

2. Close the document cover gently.

32 Important

« After placing the item on the platen, be sure to close the document cover properly before starting
to scan.
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Using the Stand

1. Place the item on the platen.
1. Open the document cover.

2. Place the item with the side to scan facing the platen and align it with the alignment mark.

= [tems You Can Place & How to Place Items

2% Important

* If you open the document cover wide, the scanner may fall over.
* Portions placed over (A) (0.094 inch (2.4 mm) from the left edge of the platen) or (B) (0.106 inch (2.7
mm) from the front edge) cannot be scanned.

A)

(8)

2. Close the document cover gently.

While scanning, hold the document cover lightly with your hand to keep it closed.
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2% Important

* When scanning with the scanner positioned upright, do not subject it to vibration during operation.
The correct image results may not be obtained (for example, images blur).

* When using the scanner in the upright position, the item type may not be detected automatically.
Specify the item type and scan.

= Scanning Documents
= Scanning Photos
= Scanning with Favorite Settings
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Items You Can Place & How to Place Items

The position to place an item may vary depending on the item to be scanned. Place the item in the correct
position according to the item to be scanned. If you do not place the item correctly, it may not be scanned
correctly.

The items you can place on the platen are as follows.

Property Details

Document, magazine, or newspaper

Types of items . . .
Printed photo, postcard, business card, or disc (BD/DVD/CD, etc.)

Size (width x height) Max. 8.5 inches x 11.7 inches (21.6 cm x 29.7 cm)

Placing the Item to Be Aligned with the Alignment Mark ()

When scanning documents, magazines, or newspapers

When scanning by specifying a standard size (A4, Letter, etc.)
Place the item with the side to scan facing down and align it with the alignment mark (#1).

Portions placed on the diagonally striped area cannot be scanned.

o Y

P

LTR

22 Important

* Portions placed over (A) (0.094 inch (2.4 mm) from the left edge of the platen) or (B) (0.106 inch (2.7
mm) from the front edge) cannot be scanned.

A)

(B)

Placing the Item in the Center of the Platen

When scanning one printed photo, postcard, business card or BD/DVD/CD

Place the item at least 0.4 inch (1 cm) away from the edges of the platen, with the side to scan facing
down.
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Portions placed on the diagonally striped area cannot be scanned.
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Placing Multiple Items

When scanning multiple printed photos, postcards, or business cards

Place the items at least 0.4 inch (1 cm) away from the edges of the platen, with the side to scan facing
down.

Place them at least 0.4 inch (1 cm) apart from each other as well.
You can place up to four E-sized or L-sized items or two 2L-sized or postcard-sized items.

Portions placed on the diagonally striped area cannot be scanned.

L O T T

)

[

Iw

)

®
-
H..r..r..r::::::::::::::::::::::::

(A)0.4 inch (1 cm)
2> Note

 Positions of slanted items (up to approximately 10 degrees) are corrected automatically by the Skew
Correction function. Slanted photos with a long edge of approximately 7.1 inches (18 cm) or more
cannot be corrected.

» Non-rectangular or irregular shaped photos (such as photos that have been cut to various shapes)
may not be scanned correctly.
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Maintenance

22 Important

+ Disconnect the USB cable from the computer before cleaning the machine.

» Do not use tissue paper, paper towels, rough-textured cloth, or similar materials for cleaning so as not
to scratch the surface.

* Never use alcohol, thinner, benzene, etc. The exterior may deform, discolor, or dissolve.

With a soft dry cloth, wipe the platen (A), the inner side of the document cover (white sheet) (B), and the
exterior (C). For stubborn dirt, clean with a well wrung damp cloth, then wipe off moisture with a soft dry
cloth. Wipe thoroughly, especially the glass surface so as not to leave any residue.

(B)

(©)

22 Important

» Do not press the document cover or platen heavily. The glass may break and cause injury.

» Wipe off moisture thoroughly. Scanning with moisture left on the glass surface and document cover
may affect the image.

» Do not wet the connectors or metal parts on the rear side of the machine. If they get wet, wipe them
thoroughly with a dry cloth.

» Do not wipe with a wet cloth that has not been wrung well or directly spray water or detergent onto the
machine. Moisture may get inside the machine and adhere to the inner side of the platen or sensor,
causing an image defect or malfunction.
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Precautions for Safe Transport of the Machine

When relocating the machine, make sure of the following.

22 Important

+ Pack the machine in a sturdy box so that it is placed with its bottom facing down, using sufficient
protective material to ensure safe transport.

* When a shipping agent is handling transport of the machine, have its box marked "FRAGILE" or
"HANDLE WITH CARE" with the bottom of the machine facing down.

1. Disconnect the USB cable.
2. Secure the document cover with adhesive tape to keep it closed.

3. Move the scanner lock switch on the bottom of the machine to the direction of the lock mark
(E ), then pack the machine in the bag.

4. Cover the four sides of the machine with the protective material when packing the machine
in the box.
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Legal Limitations on Use of Your Product and Use of Images

It may be unlawful to make copies of, scan, print, or use reproductions of the following documents.

The list provided is non-exhaustive. When in doubt, check with a legal representative in your jurisdiction.

* Paper money

* Money orders

* Certificates of deposit

» Postage stamps (canceled or uncanceled)

+ ldentifying badges or insignias

» Selective service or draft papers

» Checks or drafts issued by governmental agencies
» Motor vehicle licenses and certificates of title

» Traveler's checks

» Food stamps

» Passports

» Immigration papers

* Internal revenue stamps (canceled or uncanceled)
» Bonds or other certificates of indebtedness

» Stock certificates

» Copyrighted works/works of art without permission of copyright owner
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Specifications

General Specifications

Scanner type Flatbed
Sensor type CIS
Light source 3-color (RGB) LED

4800 x 4800 dpi

Optical resolution * * Optical resolution represents the maximum sampling rate based on ISO
14473.
Selectable resolution 25 - 19200 dpi (ScanGear)

Color: 48 bit (16 bit input for each color (RGB))/48 bit or 24 bit output (16 bit or

Scanning bit depth 8 bit output for each color (RGB))

Grayscale: 16 bit or 8 bit output

Hi-Speed USB *

* The fastest speed in Hi-Speed USB mode on Windows PC. Transfer time is
not included. Scanning speed varies according to the item types, scan settings,
or specifications of the computer.

Interface

Maximum document size Ad/Letter (8.5" x 11.7"/216 x 297 mm)

Scanner buttons 5 buttons (PDF x 2, AUTO SCAN, COPY, SEND)

Temperature: 41 to 95 °F (5 to 35 °C)

Operating environment
2 e Humidity: 10 - 90 % RH (no condensation)

Power supply Supplied via USB port (No external adapter required)

In operation: 2.5 W

Stand-by: 1.4 W *1

P ti
ower consumption Off: 11 mW *1

*1 USB connection to PC.

Approx. 9.9 (W) x 14.4 (D) x 1.6 (H) inches

External dimensions
Approx. 250 (W) x 365 (D) x 39 (H) mm

Weight Approx. 3.4 b (1.6 kg.)

Minimum System Requirements

Conform to the operating system's requirements when higher than those given here.

Windows

Windows 8, Windows 8.1

Windows 7, Windows 7 SP1

Operating system Windows Vista SP1, Windows Vista SP2
Windows XP SP3 32-bit only
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Browser

Internet Explorer 8 or later

Hard disk space

3.1GB
Note: For bundled software installation.

The necessary amount of hard disk space may be changed without notice.

Display

XGA 1024 x 768

Mac OS

Operating system

Mac OS X v10.6.8 or later

Browser

Safari 5 or later

Hard disk space

1.5 GB
Note: For bundled software installation.

The necessary amount of hard disk space may be changed without notice.

Display

XGA 1024 x 768

* An internet connection is required to view the Online Manual.

* Windows: .NET Framework 4 or 4.5 must be installed to use the Windows software.

* Windows: A CD-ROM Drive or internet connection is required during software installation.
* Windows: XPS Essentials Pack is required to print on Windows XP.

* Windows: Operation can only be guaranteed on a computer with Windows 8.1, Windows 8, Windows

7, Windows Vista or Windows XP pre-installed.

* Windows: Some functions may not be available with Windows Media Center.

* Mac OS: Hard Disk must be formatted as Mac OS Extended (Journaled) or Mac OS Extended.

* Mac OS: For Mac OS, an internet connection is required during software installation.

* Windows: The TWAIN driver (ScanGear) is based on the TWAIN 1.9 Specification and requires the
Data Source Manager bundled with the operating system.

Information in this guide is subject to change without notice.
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Scanning

T
<>

Scanning from a Computer

Scanning Using the Scanner Buttons
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Scanning from a Computer

» Scanning with IJ Scan Utility

» Scanning with Application Software that You are Using (ScanGear)
» Useful Information on Scanning

» Other Scanning Methods

» Placing Items (When Scanning from a Computer)
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Scanning with IJ Scan Utility

» What Is IJ Scan Utility (Scanner Software)?
» Starting IJ Scan Utility

» Easy Scanning with Auto Scan 7Basic

» Scanning Documents

» Scanning Photos

» Scanning with Favorite Settings

» Scanning Items Larger than the Platen (Image Stitch)
» Scanning Multiple Items at One Time

» Saving after Checking Scan Results

» Sending Scanned Images via E-mail

» Extracting Text from Scanned Images (OCR)

» |J Scan Utility Screens

40



What Is IJ Scan Utility (Scanner Software)?

IJ Scan Utility is an application that allows you to easily scan documents, photos, etc.

You can complete from scanning to saving at one time by simply clicking the corresponding icon in the 1J
Scan Utility main screen.

=5 Canon U Scan Utility “

Prachact Nama: CanaScan hd

= =) Wl =) B 5

At Doument Photo Cushom Stitch ScanGear

instractons Sethings...

What You Can Do with IJ Scan Utility

Scan Easily according to Purposes

You can scan by simply clicking an icon such as Auto to scan easily, Document to sharpen text in a
document or magazine for better readability, or Photo to scan with settings suitable for photos,
according to the item type or your purpose.

»» Note

» Refer to "lJ Scan Utility Main Screen" for details on the IJ Scan Utility main screen.

Save Scanned Images Automatically

Scanned images are automatically saved in a preset folder. You can change the folder as required.

»» Note

* The default save folders are as follows.

* Windows 8.1: Documents folder

* Windows 8: My Documents folder

* Windows 7: My Documents folder

» Windows Vista: Documents folder

* Windows XP: My Documents folder

» Refer to "Settings Dialog Box" for how to specify a folder.

Integrate with Applications

You can utilize scanned images through integration with other applications; display scanned images in
your favorite application, attach them to e-mails, extract text from images, and more.
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ANESEH DY

PEG Inage Qually:

POF Cofrgy esshon:

[ Creale a POF fie Tak supperts keyword ssarch

[] Save b & subvisider with current date

appbcaton Setngs
18] Doy i i nppbcation: [mwmww
() Eend b o appication: 1. Preview

() Eend ba & falders Hone:

(0 Artmey b o anad: 1. Hone (Atkach Marualy)
) Stet OCR: ) Cutpust o Text
() Do pt St sy pqscation

2% Important

+ Some functions are available only when My Image Garden is installed.

12> Note

» Refer to "Settings Dialog Box" for how to set the applications to integrate with.
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Starting IJ Scan Utility

Follow the steps below to start IJ Scan Utility.

Windows 8.1/Windows 8:

Select IJ Scan Utility on the Start screen to start IJ Scan Ultility.

If IJ Scan Utility is not displayed on the Start screen, select the Search charm, then search for "IJ Scan
Utility".

Windows 7/Windows Vista/Windows XP:

From the Start menu, select All Programs > Canon Utilities > IJ Scan Utility > IJ Scan Utility to start IJ
Scan Utility.

L1, Canon I Scan Utility

Prodisct Namea: CaraSean

X
m )| =

Aubo Dooument Photo Cushom Stibch

inslnuctions ' | Sethngs...
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Easy Scanning with Auto Scan

You can scan easily by automatically detecting the item type.

22 Important

 The following types of items may not be scanned correctly. In that case, adjust the cropping frames
(scan areas) in whole image view of ScanGear (scanner driver) and scan again.

» Photos that have a whitish background

* Items printed on white paper, hand-written documents, business cards, etc.
» Thin items

» Thick items

1. Place items on the platen of your scanner.

= Placing Items (When Scanning from a Computer)

2. Start IJ Scan Utility.

3. Click Auto.

=5 Cancn L} Scan Utility [ x|

Praduict Name: CaraSean bt

=) =] W =) Bl

Dooument Fhoto Custom Stibch ScanGear

Enstruachons Settngs...

Scanning starts.

»» Note

+ Click Cancel to cancel the scan.

» To apply suitable corrections based on the item type, click Settings..., then select the Apply
recommended image correction checkbox in the Settings (Auto Scan) dialog box.

» Scanned images are saved in the folder set for Save in in the Settings (Auto Scan) dialog box
displayed by clicking Settings.... In the Settings (Auto Scan) dialog box, you can also make advanced
scan settings.

+ Refer to the following pages to scan by specifying the item type.

= Scanning Photos
= Scanning Documents
= Scanning with Favorite Settings
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Scanning Documents

You can scan items placed on the platen with settings suitable for documents.

1. Place the item on the platen.

= Placing Items (When Scanning from a Computer)

2. Start IJ Scan Utility.

3. Click Settings..., then set the paper size, resolution, etc. in the Settings (Document Scan)

dialog box as required.

When setting is completed, click OK.

4. Click Document.

= Canon L' Scan Utility

K
m|a |l = W s

Autg Deament Photo Cushom Stitch

instructons ' | Settings...

Scanning starts.

»» Note

 Click Cancel to cancel the scan.

» Scanned images are saved in the folder set for Save in in the Settings (Document Scan) dialog box
displayed by clicking Settings.... In the Settings (Document Scan) dialog box, you can also make
advanced scan settings.
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Scanning Photos

You can scan photos placed on the platen with settings suitable for photos.

1. Place the photo on the platen.

= Placing Items (When Scanning from a Computer)

2. Start IJ Scan Utility.

3. Click Settings..., then set the paper size, resolution, etc. in the Settings (Photo Scan)

dialog box as required.

When setting is completed, click OK.

4. Click Photo.

|2 Canon L/ Scan Utility

Praduct Name: CanaScan

EX|
m G| W= B s
Ak Deoument Phate FCanGear

Cisshoen Fibch

instructons ' | Settings...

Scanning starts.

»» Note

+ Click Cancel to cancel the scan.

» Scanned images are saved in the folder set for Save in in the Settings (Photo Scan) dialog box
displayed by clicking Settings.... In the Settings (Photo Scan) dialog box, you can also make
advanced scan settings.
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Scanning with Favorite Settings

You can scan items placed on the platen with your favorite settings saved beforehand.

This is convenient for saving frequently used settings or when specifying scan settings in detail.

1. Start IJ Scan Utility.

2. Click Settings..., then set the item type, resolution, etc. in the Settings (Custom Scan)
dialog box as required.

When setting is completed, click OK.
2> Note

» Once the settings are made, you can scan with the same settings from the next time.

3. Place the item on the platen.

= Placing Items (When Scanning from a Computer)

4. Click Custom.

=5 Canan U Scan Utility

Pradiuct Nama: Carabean

EX|
m )| M| = | s

Auto Deoment Fhoto Custom Stibch

nstnuctons ' [ Sattings...

Scanning starts.

»» Note

+ Click Cancel to cancel the scan.

» Scanned images are saved in the folder set for Save in in the Settings (Custom Scan) dialog box
displayed by clicking Settings.... In the Settings (Custom Scan) dialog box, you can also make
advanced scan settings.
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Scanning Items Larger than the Platen (Image Stitch)

You can scan the left and right halves of an item larger than the platen and combine them back into one
image. Iltems up to approximately twice as large as the platen are supported.

13 Note

» The following explains how to scan from the item to be placed on the left side.

1. Start IJ Scan Utility.

2. Click Settings..., then set the item type, resolution, etc. in the Settings (Scan and Stitch)
dialog box as required.

When setting is completed, click OK.

3. Click Stitch.

The Image Stitch window appears.

4. In Select Output Size, select an output size according to the paper size.

Select Qutput Stee

a3 fasxz)

Sopn Dedtion

[5can fiam Lot

Soan Image 1

Start Scanaing Image 1 |
—

Sean Iniage 2

Start Seanning Image &

[ Adust oropping Samas

5. Make sure that Scan from Left is selected in Scan Direction.
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XIA|g2a 9

Sgan Image 2

Start Scanning Image £

[ Bechust cropping Sames

6. Place the item that is to be displayed on the left side of the screen face-down on the platen.

7. Click Start Scanning Image 1.

Sean Image 2

Start Scanning Image

[T ] Aechust erapping Samas

The first item is scanned and appears in 1.
22> Note

¢ Click Cancel to cancel the scan.

8. Place the item that is to be displayed on the right side of the screen face-down on the
platen.
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9. Click Start Scanning Image 2.

XA &aa

Start Scanning Image L

Sean Image 2

The second item is scanned and appears in 2.

23> Note

¢ Click Cancel to cancel the scan.

10. Adjust the scanned images as required.

Use the Toolbar to rotate or zoom in/out, or drag the images to adjust their positions.

Select Output Size

A3 a4 )

Soan Image 1

Start Seanning Image ©

Sean Tmage 2

Start Scanning Image &

23 Note

 Select the Adjust cropping frames checkbox to specify the area to be saved.
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= Adjusting Cropping Frames in the Image Stitch Window

» To scan an item again, select the image in the Preview area or the thumbnail at the top of the

screen, then click x (Delete). The selected image is deleted, allowing you to scan the item
again.

11. Click Save.

Select helput Size

[a3aexz

Somn Deegton

5230 tram Lent

Soan Image 1

=tart Scanming Image L

Lean Iinage 2

Start Seanning Imane

The combined image is saved.

23 Note

+ Refer to "Image Stitch Window" for details on the Image Stitch window.

* You can make advanced scan settings in the Settings (Scan and Stitch) dialog box displayed by
clicking Settings....
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Scanning Multiple Items at One Time

You can scan two or more photos (small items) placed on the platen at one time and save each image
individually.

32 Important

» The following types of items may not be scanned correctly. In that case, adjust the cropping frames
(scan areas) in whole image view of ScanGear (scanner driver) and scan again.

» Photos that have a whitish background

* |tems printed on white paper, hand-written documents, business cards, etc.
* Thin items

» Thick items

Refer to "Scanning Multiple Documents at One Time with ScanGear (Scanner Driver)" for your model
from Home of the Online Manual for details.

Using Auto Scan:

Whether there are multiple items or not is detected automatically. Click Auto and scan.

= Easy Scanning with Auto Scan

Not Using Auto Scan:

In the Settings dialog box, set Paper Size to Auto scan and scan.

> Note

» The screens for scanning with favorite settings are used as examples in the following descriptions.

1. Place the items on the platen.

= Placing Items (When Scanning from a Computer)

2. Start IJ Scan Utility.

3. Click Settings....

= Canaon 1) Scan Utility [ x|

Praduct Name: CanaScan b

= =) | =) B 5

Autg Deament Phot Cushom Stitch ScanGear

instnxctons Sethngs...

The Settings dialog box appears.

4. Click Custom Scan.
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5. Select Select Source according to the items to be scanned.

FPEG Inage Quakby

[ 5ave toa subfnidar wth current dabe:

[ ched: scan results

Appcaton Sattngs
() Dy v a0 appbcation:

6. Select Auto scan for Paper Size, then click OK.
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JPEG Image Cualbyr
[ '5ave to.a subdnider with cunrent dabe
[ ched: scan results

Appboaten Battings
() Oy Wi ppbcation:

The IJ Scan Utility main screen appears.

23» Note

» Refer to the following pages for details on the setting items in the Settings dialog box.

= Settings (Document Scan) Dialog Box
= Settings (Photo Scan) Dialog Box
= Settings (Custom Scan) Dialog Box

7. Click Custom.

Multiple items are scanned at one time.

13 Note

+ Click Cancel to cancel the scan.

» Scanned images are saved in the folder set for Save in in the corresponding Settings dialog box
displayed by clicking Settings.... In each Settings dialog box, you can also make advanced scan
settings.
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Saving after Checking Scan Results

You can check the scan results, then save the images to a computer.

=% Important

* You cannot check the scan results before saving when scanned using Auto scan or the scanner
buttons.

13 Note

» The screens for scanning photos are used as examples in the following descriptions.

1. Start IJ Scan Utility.

2. Click Settings....

The Settings dialog box appears.

3. Click Photo Scan.

JPEG Imags Cualby:
[ '5ave to.a subdnider wth unrent date

[ ched: scan results

Appboaten Settngs
() Oy Wi appbcation:

4. Select the Check scan results checkbox, then click OK.
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JPEG Imags Cualby:
[ '5ave to.a subdnider with unrent date
[ Ched: scan results

Appboaten Bettngs
() Oy Wi appbcation:

The IJ Scan Utility main screen appears.

23» Note

» Refer to the following pages for details on the setting items in the Settings dialog box.

= Settings (Document Scan) Dialog Box
= Settings (Photo Scan) Dialog Box

= Settings (Custom Scan) Dialog Box
= Settings (Scan and Stitch) Dialog Box
= Settings (ScanGear) Dialog Box

5. Click Photo.

Scanning starts.

When scanning is completed, the Save Settings dialog box appears.

22> Note

¢ Click Cancel to cancel the scan.

6. Change the image order or file save options as required.

You can change the image order or file save options in the Save Settings dialog box.
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»» Note

* The default save folders are as follows.

* Windows 8.1: Documents folder

* Windows 8: My Documents folder

* Windows 7: My Documents folder

» Windows Vista: Documents folder

+ Windows XP: My Documents folder

. Click OK.

Scanned images are saved according to the settings.
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Sending Scanned Images via E-mail

You can send scanned images via e-mail.

22> Note

» The screens for scanning photos are used as examples in the following descriptions.

1. Start IJ Scan Utility.

2. Click Settings....

The Settings dialog box appears.

3. Click Photo Scan.

JPEG Image Qualiby:
[ '5ave toa subduider with cunrent dabe

[ chad: semn rasults

hppheatan Satting
() Oy e v Bppbcation:

4. Select Attach to e-mail in Application Settings, then select an e-mail client.
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JPEG Imags Qualby:

[ 5ave to.a subdnider with unrent dabe

[ chedk scan results
Appenten Sattngs

{71 D wih an appbcation:

(Z15and to an appication:

(2 5end b fobder:

(8] Attach b & madr

{T1Do notskart any apphcation

22> Note

* You can add e-mail clients to use for attachments from the pull-down menu.
« If None (Attach Manually) is selected, manually attach scanned and saved images to e-mail.

5. Click OK.

JPEG Image Qualbyr
[l mave s subfobcher with cunnent dabe
[ ched: semn results

Appboaen Settngs

(2 Bipen wizh an apphcation:
(21 Band to.an epplcation:
(T1sand to a folder:

(8] Attach b e mad:

(7100 nobskart any apphcation

The IJ Scan Utility main screen appears.

12> Note

» Refer to the following pages for details on the setting items in the Settings dialog box.

= Settings (Auto Scan) Dialog Box
= Settings (Document Scan) Dialog Box
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= Settings (Photo Scan) Dialog Box
= Settings (Custom Scan) Dialog Box
= Settings (ScanGear) Dialog Box

6. Click Photo.

£ Canon L/ Scan Utility

Praduct Name: CanaSean

EX|
i) = | 5
Autg Dooument Fhoto SCanGear

instructons ' | Setings. .

Scanning starts.

When scanning is completed, the specified e-mail client starts and the images will be attached to a new
message.

»» Note

* Click Cancel to cancel the scan.

» The scanned images are saved according to the settings made in the Settings dialog box.

* When the Check scan results checkbox is selected in the Settings dialog box, the Save Settings
dialog box appears. After you set the save options and click OK, the scanned images are saved
and automatically attached to a new message of the specified e-mail client.

7. Specify the recipient, enter the subject and message, then send e-mail.

Refer to the manual of your e-mail client for e-mail settings.
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Extracting Text from Scanned Images (OCR)

Scan text in scanned magazines and newspapers and display it in your text editor.

22> Note

* You can extract text when scanning via Document, Custom, or ScanGear.
» The screens for scanning documents are used as examples in the following descriptions.

1. Start IJ Scan Utility.

2. Click Settings....

Canon I Scan Utility

N | =)

The Settings dialog box appears.

3. Click Document Scan.

= &2

B awesan

EII'S Decismeen b Soan

[ Creabe & FOF fe $at supports keyword saarch
[J5ave ton subfolder with current dabe
[ chechc s results

Al AT AT

12> Note

» For Resolution, only 300 dpi or 400 dpi can be set when Start OCR is selected in Application
Settings.

4. Select Start OCR for Application Settings, then select the application in which you want
to display the result.
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Aute Soan

JPEG Image Qualibyr
[ mave o sbfobcer with curment dabe
[ hed: semn rasults

Appbennan et
{71 Dy v Bppbcation:
(Z1 5end to-an 2pphcation:
(Z15and to a folder:

(71 artach boe-mad:

(8] Start DCR

{TIDo notskart any spphcation

22> Note

« If a compatible application is not installed, the text in the image is extracted and appears in your
text editor.
Text to be displayed is based on Document Language in the Settings (General Settings) dialog
box. Select the language you want to extract in Document Language and scan.

* You can add the application from the pull-down menu.

5. Click OK.

At Goan

FPEG Inage Quakty
[ 5w to s subinicler wth current dabe

[ Ched: scan results

Appbcaan Sattg
(71 D wigh an appbcation;
(715and toan sppication:
(Z15end to.n folder
(Z1 dittach bo-e-mad:

(8] Stert DCR:

(7100 notskart any apphcation

The IJ Scan Utility main screen appears.
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»» Note

» Refer to the following pages for details on the setting items in the Settings dialog box.

= Settings (Document Scan) Dialog Box
= Settings (Custom Scan) Dialog Box
= Settings (ScanGear) Dialog Box

. Click Document.

Canon IV Scan Uility

Pragiuct Name: Canasean

Enstruchors | Settings...

Scanning starts.

When scanning is completed, the scanned images are saved according to the settings, and the extracted
text appears in the specified application.

> Note

* Click Cancel to cancel the scan.
» Text displayed in your text editor is for guidance only. Text in the image of the following types of
documents may not be detected correctly.

Documents containing text with font size outside the range of 8 points to 40 points (at 300 dpi)
Slanted documents

Documents placed upside down or documents with text in the wrong orientation (rotated
characters)

Documents containing special fonts, effects, italics, or hand-written text

Documents with narrow line spacing

Documents with colors in the background of text

Documents containing multiple languages
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IJ Scan Utility Screens

» |J Scan Utility Main Screen

» Settings Dialog Box

©E £ & £ £ £ £ © ® © ¥

Settings (Auto Scan) Dialog Box
Settings (Document Scan) Dialog Box
Settings (Photo Scan) Dialog Box
Settings (Custom Scan) Dialog Box
Settings (Scan and Stitch) Dialog Box
Settings (ScanGear) Dialog Box
Settings (AUTO SCAN) Dialog Box
Settings (PDF) Dialog Box

Settings (COPY) Dialog Box

Settings (SEND) Dialog Box

Settings (General Settings) Dialog Box

» Save Settings Dialog Box

» Image Stitch Window
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IJ Scan Utility Main Screen

Follow the steps below to start IJ Scan Utility.

Windows 8.1 / Windows 8:

Select IJ Scan Utility on the Start screen to start IJ Scan Ultility.

If IJ Scan Utility is not displayed on the Start screen, select the Search charm, then search for "IJ Scan
Utility".

Windows 7/Windows Vista/Windows XP:

From the Start menu, select All Programs > Canon Utilities > IJ Scan Utility > IJ Scan Utility to start IJ
Scan Utility.

You can complete from scanning to saving at one time by simply clicking the corresponding icon.

Sy Canon 1) 5can Utility “

Prachact Nama: CanaScan hd

= =) Wl =) B 5

At Doument Photo Cushom Stitch ScanGear

instractons Sethings...

Product Name
Displays the name of the product that IJ Scan Utility is currently set to use.

If the displayed product is not the one you want to use, select the desired product from the list.

Auto
Detects the item type automatically and saves them to a computer. The data format for saving will also
be set automatically.

Save settings and the response after scanning can be specified in the Settings (Auto Scan) dialog
box.

Document
Scans items as documents and saves them to a computer.
Scan/save settings and the response after scanning can be specified in the Settings (Document Scan)
dialog box.

Photo
Scans items as photos and saves them to a computer.

Scan/save settings and the response after scanning can be specified in the Settings (Photo Scan)
dialog box.

Custom
Scans items with your favorite settings and saves the images to a computer. The item type can be
automatically detected.

Scan/save settings and the response after scanning can be specified in the Settings (Custom Scan)
dialog box.

Stitch
Displays the Image Stitch window in which you can scan the left and right halves of an item larger than
the platen and combine the scanned images back into one image.
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Scan/save settings and the response after scanning can be specified in the Settings (Scan and Stitch)
dialog box.
ScanGear

Starts ScanGear (scanner driver) in which you can make image corrections and color adjustments
when scanning.

Scan/save settings and applications can be specified in the Settings (ScanGear) dialog box.

Instructions
Opens this guide.

Settings...
Displays the Settings dialog box in which you can specify the scan/save settings and the response after
scanning.
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Settings Dialog Box

[ =
There are three tabs in the Settings dialog box: (Scanning from a Computer), * (Scanning Using

A0
the Scanner Buttons), and ] (General Settings). When you click a tab, the view in the red frame switches
and you can make advanced settings to functions on each tab.

Settings (Auto Scan)

|

|standard

:EIH'n‘.h'd

[ Create & FOF fie $at supports keyword search

[ 5awe bz & sutduider with current date

Agpbcatan Setings
80 e wih axn axppication:
(71 Cand ba  Bpploabon:
1 Gand ba & Salders
7 Anizcy by & wnad:

71D rot skt any applcaton

E: (Scanning from a Computer) Tab

You can specify how to respond when scanning from IJ Scan Utility or My Image Garden.

= Settings (Auto Scan) Dialog Box
Settings (Document Scan) Dialog Box
Settings (Photo Scan) Dialog Box
Settings (Custom Scan) Dialog Box
Settings (Scan and Stitch) Dialog Box
Settings (ScanGear) Dialog Box

L 2R 20 B B

-
“¥" (Scanning Using the Scanner Buttons) Tab

You can specify how to respond when scanning using the scanner buttons.

= Settings (AUTO SCAN) Dialog Box
= Settings (PDF) Dialog Box

= Settings (COPY) Dialog Box

= Settings (SEND) Dialog Box
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32 Important

r
» When the Settings dialog box is displayed from My Image Garden, the ¥ (Scanning Using the

Scanner Buttons) tab does not appear.

]
Iﬁ (General Settings) Tab

You can set the product to use, file size restriction on e-mail attachment, language to detect text in
images, and folder in which to save images temporarily.

= Settings (General Settings) Dialog Box
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Settings (Auto Scan) Dialog Box
Click Auto Scan on the (Scanning from a Computer) tab to display the Settings (Auto Scan) dialog
box.

In the Settings (Auto Scan) dialog box, you can make advanced scan settings to scan by automatically
detecting the item type.

Settings (Aulo Scan)

=) S )

Save Settingn 2
Fie Hame: MG b ( }
E] Photo Ecan
Save e 4 Doouments w
|i|*1 Custom Soan Dt Format: autn w
JPEG Inage Qualty: Standard w
[ﬂ] Szan end S51ch
FOF Compressans Standard -
% SeprCanr [] Create & POF fie St supports keyword search

[ 5awe ta a sutduider with current date

Appbcton Setngs

80 Dpeen wih axn axppcation: U Canon My Irmage Garden - (3}
(1 Eand o B biont | Peeview

(1 Send ta a foders e

() Akt b & vnsd: . Hone (Altach Marualy)

1D i S sy dxoyca i

nstructions Defaults =3

= (1) Scan Options Area
= (2) Save Settings Area
= (3) Application Settings Area

3% Important

» When the Settings dialog box is displayed from My Image Garden, the setting items for Application
Settings do not appear.

Supported Items

Photos, postcards, business cards, magazines, newspapers, documents, and BD/DVD/CD.

32 Important

» To scan the following types of items, specify the item type and size in the Settings (Document Scan)
dialog box, Settings (Photo Scan) dialog box, or Settings (Custom Scan) dialog box, then click
Photo, Document, or Custom in the IJ Scan Utility main screen. You cannot scan correctly with Auto.

* A4 size photos

» Text documents smaller than 2L (5 inches x 7 inches) (127 mm x 178 mm), such as paperback
pages with the spine cut off

* Items printed on thin white paper

» Long narrow items such as panoramic photos
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» Reflective disc labels may not be scanned as expected.
* Place items to be scanned on the platen correctly. Otherwise, items may not be scanned correctly.

Refer to "Placing Items (When Scanning from a Computer)" for how to place items.

»» Note

» To reduce moire in scans, set Select Source to Magazine in the Settings (Document Scan) dialog
box or Settings (Custom Scan) dialog box, then click Document or Custom in the IJ Scan Utility main
screen.

(1) Scan Options Area

Apply recommended image correction
Applies suitable corrections automatically based on the item type.

32 Important

» The color tone may differ from the source image due to corrections. In that case, deselect the
checkbox and scan.

»>» Note

» Scanning takes longer than usual when you enable this function.

(2) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

»» Note

» When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To change the folder, specify the
destination folder in the Select Destination Folder dialog box displayed by selecting Add... from the
pull-down menu.

The default save folders are as follows.

* Windows 8.1: Documents folder

* Windows 8: My Documents folder

» Windows 7: My Documents folder

» Windows Vista: Documents folder

» Windows XP: My Documents folder

3% Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

Data Format
Auto is selected. The following data formats are automatically applied according to the item type
when saving.

 Photos, postcards, BD/DVD/CD, and business cards: JPEG
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+ Magazines, newspapers, and documents: PDF

32 Important

» The save format may differ depending on how you place the item.

= Placing Items (When Scanning from a Computer)

JPEG Image Quality
You can specify the image quality of JPEG files.

PDF Compression
Select the compression type for saving PDF files.

Standard
It is recommended that you normally select this setting.
High
Compresses the file size when saving, allowing you to reduce the load on your network/server.
Create a PDF file that supports keyword search

Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

»» Note

A0
» PDF files that are searchable in the language selected in Document Language on the [
(General Settings) tab of the Settings dialog box are created.

Save to a subfolder with current date
Select this checkbox to create a current date folder in the folder specified in Save in and save
scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

(3) Application Settings Area

Open with an application
Select this when you want to enhance or correct the scanned images.

You can specify the application from the pull-down menu.

Send to an application
Select this when you want to use the scanned images as they are in an application that allows you to
browse or organize images.

You can specify the application from the pull-down menu.

Send to a folder
Select this when you also want to save the scanned images to a folder other than the one specified in
Save in.

You can specify the folder from the pull-down menu.

Attach to e-mail
Select this when you want to send e-mails with the scanned images attached.

You can specify the e-mail client you want to start from the pull-down menu.
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Do not start any application
Saves to the folder specified in Save in.

»» Note

+ Specify the application or folder in the Select Application or Select Destination Folder dialog box
displayed by selecting Add... from the pull-down menu.

Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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Settings (Document Scan) Dialog Box

Click Document Scan on the E: (Scanning from a Computer) tab to display the Settings (Document
Scan) dialog box.

In the Settings (Document Scan) dialog box, you can make advanced scan settings to scan items as
documents.

-
Elj uts Sean ) )
E'I; Ceecusreent Soan Cilor Mool Codor w
Paper Size: Lether w
E] Phaho Scan
Foaspiurtion: 3000 el w
'_l| Custom Soan :-r:lmﬁu:msarmgs
Save Get
@ o o Satch e ! .
File izt | bl (2}
% SeprCan Sawe e , DCoouments w
Duata Fodrnat: |POF Ptzple Pages) w
POF Cofrpr essons :EIanchn:I w
[ Create a POF fie St supports keyword search
[ 5ave ta & sutduider with current dabe
[[] chek scam results
Apobcaton Settncs
() Dy i o ppsbcation: .5 Carnan My mage Ganden Ll (3}
71 Cand ba  Bppicabon: 1. Preview
(1 Send ta m folders Hane
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= (1) Scan Options Area
= (2) Save Settings Area
= (3) Application Settings Area

32 Important

» When the Settings dialog box is displayed from the Scan screen of My Image Garden, the setting items
for Application Settings do not appear.

(1) Scan Options Area

Select Source
Select the type of item to be scanned.

» Scanning documents: Document
» Scanning magazines: Magazine

Color Mode
Select the color mode in which to scan the item.
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Paper Size
Select the size of the item to be scanned.

When you select Custom, a screen in which you can specify the paper size appears. Select a Unit,
then enter the Width and Height, and then click OK.

Custom 5ize Setting E
wideh nches (1,00 -8.50)
Heightz | 1100 | ivches {100 - 11.68)
Lirat: inches W
| oK | Defalts | Cencel

»>» Note

+ Click Defaults to restore the specified settings to the default settings.

Resolution
Select the resolution of the item to be scanned.

The higher the resolution (value), the more detail in your image.

= Resolution

»>» Note

» Only 300 dpi or 400 dpi can be set when Start OCR is selected in Application Settings.

Image Processing Settings

Click .| (Plus) to set the following.
2> Note

* When Color Mode is Black and White, only Reduce gutter shadow, Correct slanted text
document, and Detect the orientation of text document and rotate image appear.

Apply Auto Document Fix
Select this checkbox to sharpen text in a document or magazine for better readability.

22 Important

» The color tone may differ from the source image due to corrections. In that case, deselect
the checkbox and scan.

»» Note

» Scanning takes longer than usual when you enable this function.

Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.

Reduce show-through
Sharpens text in an item or reduces show-through in newspapers, etc.

Reduce moire
Reduces moire patterns.
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Printed materials are displayed as a collection of fine dots. "Moire" is a phenomenon where
uneven gradation or a stripe pattern appears when such photos or pictures printed with fine dots
are scanned.

»» Note

» Scanning takes longer than usual when you enable Reduce moire.

Reduce gutter shadow
Reduces gutter shadows that appear between pages when scanning open booklets.

»» Note

» Use ScanGear (scanner driver)'s Advanced Mode tab to correct gutter shadows when
scanning non-standard size items or specified areas.
Refer to "Gutter Shadow Correction" for your model from Home of the Online Manual for
details.

Correct slanted text document
Detects the scanned text and corrects the angle (within -0.1 to -10 degrees or +0.1 to +10
degrees) of the document.

22 Important

 The following types of documents may not be corrected properly since the text cannot be
detected correctly.

* Documents in which the text lines are inclined more than 10 degrees or the angles vary
by line

* Documents containing both vertical and horizontal text

» Documents with extremely large or small fonts

» Documents with small amount of text

» Documents containing figures/images

+ Hand-written text

+ Documents containing both vertical and horizontal lines (tables)

»» Note

» Scanning takes longer than usual when you enable Correct slanted text document.

Detect the orientation of text document and rotate image
Automatically rotates the image to the correct orientation by detecting the orientation of text in
the scanned document.

32 Important

» Only text documents written in languages that can be selected from Document Language
in the Settings (General Settings) dialog box are supported.

» The orientation may not be detected for the following types of settings or documents since
the text cannot be detected correctly.

* Resolution is outside the range of 300 dpi to 600 dpi

» Font size is outside the range of 8 points to 48 points

» Documents containing special fonts, effects, italics, or hand-written text
* Documents with patterned backgrounds

In that case, select the Check scan results checkbox and rotate the image in the Save
Settings dialog box.
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(2) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

»>» Note

* When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To change the folder, specify the
destination folder in the Select Destination Folder dialog box displayed by selecting Add... from the
pull-down menu.

The default save folders are as follows.

* Windows 8.1: Documents folder

» Windows 8: My Documents folder

* Windows 7: My Documents folder

* Windows Vista: Documents folder

* Windows XP: My Documents folder

22 Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

Data Format
Select the data format in which to save the scanned images.

You can select JPEG/Exif, TIFF, PNG, PDF, or PDF (Multiple Pages).
22 Important

* You cannot select JPEG/Exif when Color Mode is Black and White.
* When Start OCR is selected in Application Settings, you cannot select PDF or PDF (Multiple
Pages).

PDF Compression
Select the compression type for saving PDF files.

Standard
It is recommended that you normally select this setting.

High
Compresses the file size when saving, allowing you to reduce the load on your network/server.

32 Important

» This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.
» When Black and White is selected in Color Mode, this option does not appear.

JPEG Image Quality
You can specify the image quality of JPEG files.

32 Important

 This appears only when JPEG/EXxif is selected in Data Format.
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Create a PDF file that supports keyword search
Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

32 Important

» This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.

»» Note

A0
» PDF files that are searchable in the language selected in Document Language on the [
(General Settings) tab of the Settings dialog box are created.

Save to a subfolder with current date
Select this checkbox to create a current date folder in the folder specified in Save in and save
scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Check scan results
Displays the Save Settings dialog box after scanning.

32 Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

(3) Application Settings Area

Open with an application
Select this when you want to enhance or correct the scanned images.

You can specify the application from the pull-down menu.

Send to an application
Select this when you want to use the scanned images as they are in an application that allows you to
browse or organize images.

You can specify the application from the pull-down menu.

Send to a folder
Select this when you also want to save the scanned images to a folder other than the one specified in
Save in.

You can specify the folder from the pull-down menu.

Attach to e-mail
Select this when you want to send e-mails with the scanned images attached.

You can specify the e-mail client you want to start from the pull-down menu.

Start OCR
Select this when you want to convert text in the scanned image into text data.

You can specify the application from the pull-down menu.

Do not start any application
Saves to the folder specified in Save in.
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> Note

» Specify the application or folder in the Select Application or Select Destination Folder dialog box
displayed by selecting Add... from the pull-down menu.

Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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Settings (Photo Scan) Dialog Box

Click Photo Scan on the E: (Scanning from a Computer) tab to display the Settings (Photo Scan)
dialog box.

In the Settings (Photo Scan) dialog box, you can make advanced scan settings to scan items as photos.

= |2 [ if
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= (1) Scan Options Area
= (2) Save Settings Area
= (3) Application Settings Area

32 Important

* When the Settings dialog box is displayed from My Image Garden, the setting items for Application
Settings do not appear.

(1) Scan Options Area

Select Source
Photo is selected.

Color Mode
Select the color mode in which to scan the item.

Paper Size
Select the size of the item to be scanned.

When you select Custom, a screen in which you can specify the paper size appears. Select a Unit,
then enter the Width and Height, and then click OK.
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»» Note

+ Click Defaults to restore the specified settings to the default settings.

Resolution
Select the resolution of the item to be scanned.

The higher the resolution (value), the more detail in your image.
= Resolution
Image Processing Settings

Click | * (Plus) to set the following.

3% Important

* When Color Mode is Black and White, Image Processing Settings is not available.

Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.

(2) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

»» Note

» When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To change the folder, specify the
destination folder in the Select Destination Folder dialog box displayed by selecting Add... from the
pull-down menu.

The default save folders are as follows.

* Windows 8.1: Documents folder

» Windows 8: My Documents folder

* Windows 7: My Documents folder

» Windows Vista: Documents folder

* Windows XP: My Documents folder

22 Important

» When the Settings dialog box is displayed from My Image Garden, this option does not appear.
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Data Format
Select the data format in which to save the scanned images.

You can select JPEG/EXxif, TIFF, or PNG.
32 Important

* You cannot select JPEG/Exif when Color Mode is Black and White.

JPEG Image Quality
You can specify the image quality of JPEG files.

22 Important

* This appears only when JPEG/EXxif is selected in Data Format.

Save to a subfolder with current date
Select this checkbox to create a current date folder in the folder specified in Save in and save
scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Check scan results
Displays the Save Settings dialog box after scanning.

22 Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

(3) Application Settings Area

Open with an application
Select this when you want to enhance or correct the scanned images.

You can specify the application from the pull-down menu.

Send to an application
Select this when you want to use the scanned images as they are in an application that allows you to
browse or organize images.

You can specify the application from the pull-down menu.

Send to a folder
Select this when you also want to save the scanned images to a folder other than the one specified in
Save in.

You can specify the folder from the pull-down menu.

Attach to e-mail
Select this when you want to send e-mails with the scanned images attached.

You can specify the e-mail client you want to start from the pull-down menu.

Do not start any application
Saves to the folder specified in Save in.

»>» Note

» Specify the application or folder in the Select Application or Select Destination Folder dialog box
displayed by selecting Add... from the pull-down menu.
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Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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Settings (Custom Scan) Dialog Box
Click Custom Scan on the (Scanning from a Computer) tab to display the Settings (Custom Scan)
dialog box.

In the Settings (Custom Scan) dialog box, you can make advanced scan settings to scan according to your
preference.

POF Cofmpe esons Standard

[ Create & FOF fie $at soports ke yword search

[ 5awe ta a sutduider with current date

Apobc aton Sektnc:
) Cpen e i cgpication: | canzn My Irmage Garden

(1 Eaned o e ppibea bion: 1. Peeview

1 Gand ba o Salders Hore

7 Artz by & enad: 1. Hone (Sitach Marualy)
(I 5taet OCR: ] Dutpat i Teat

710 Pk SERT Ay BepnaBan

= (1) Scan Options Area
= (2) Save Settings Area
= (3) Application Settings Area

32 Important

* When the Settings dialog box is displayed from the Scan screen of My Image Garden, the setting items
for Application Settings do not appear.

(1) Scan Options Area

Select Source

Select the type of item to be scanned. Select Auto to detect the item type automatically and to set
Color Mode, Paper Size, and Resolution automatically as well.

22 Important

* Item types supported by Auto are photos, postcards, business cards, magazines, newspapers,
documents, and BD/DVD/CD.
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» To scan the following types of items, specify the item type or size. You cannot scan correctly with
Auto.
* A4 size photos

» Text documents smaller than 2L (5 inches x 7 inches) (127 mm x 178 mm), such as
paperback pages with the spine cut off

* ltems printed on thin white paper

» Long narrow items such as panoramic photos

» Reflective disc labels may not be scanned as expected.

* Place items correctly according to the type of item to be scanned. Otherwise, items may not be
scanned correctly.

Refer to "Placing Iltems (When Scanning from a Computer)" for how to place items.

»>» Note

» To convert text in the image into text data after scanning, specify Select Source instead of
selecting Auto.

» To reduce moire, set Select Source to Magazine.

Color Mode
Select the color mode in which to scan the item.

»» Note

» Only Color is available when Select Source is Auto.

Paper Size
Select the size of the item to be scanned.

When you select Custom, a screen in which you can specify the paper size appears. Select a Unit,
then enter the Width and Height, and then click OK.

Custom 5Size Setting ﬂ
idth nches (100 -8.50)
Height: . 11,00 | rches (100 - 11.68)
Uret: inches w
| oK _ Defaults Il Cancel

»» Note

» Only Auto is available when Select Source is Auto.

+ Click Defaults in the screen in which you can specify the paper size to restore the specified
settings to the default settings.

Resolution
Select the resolution of the item to be scanned.

The higher the resolution (value), the more detail in your image.

= Resolution

»>» Note

* Only Auto is available when Select Source is Auto.
» Only 300 dpi or 400 dpi can be set when Start OCR is selected in Application Settings.
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Image Processing Settings

Click | T | (Plus) to set the following. Available setting items vary by Select Source.

* When Select Source is Auto:

Apply recommended image correction
Applies suitable corrections automatically based on the item type.

32 Important

» The color tone may differ from the source image due to corrections. In that case,
deselect the checkbox and scan.

»» Note

» Scanning takes longer than usual when you enable this function.

* When Select Source is Photo:

3% Important

* When Color Mode is Black and White, Image Processing Settings is not available.

Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.

* When Select Source is Magazine or Document:

»» Note

* When Color Mode is Black and White, only Reduce gutter shadow, Correct slanted text
document, and Detect the orientation of text document and rotate image appear.

Apply Auto Document Fix
Select this checkbox to sharpen text in a document or magazine for better readability.

32 Important

» The color tone may differ from the source image due to corrections. In that case,
deselect the checkbox and scan.

»» Note

» Scanning takes longer than usual when you enable this function.

Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.

Reduce show-through
Sharpens text in an item or reduces show-through in newspapers, etc.

Reduce moire
Reduces moire patterns.

Printed materials are displayed as a collection of fine dots. "Moire" is a phenomenon where
uneven gradation or a stripe pattern appears when such photos or pictures printed with fine
dots are scanned.

»» Note

» Scanning takes longer than usual when you enable Reduce moire.
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Reduce gutter shadow
Reduces gutter shadows that appear between pages when scanning open booklets.

»» Note

» Use ScanGear (scanner driver)'s Advanced Mode tab to correct gutter shadows when
scanning non-standard size items or specified areas.
Refer to "Gutter Shadow Correction" for your model from Home of the Online Manual for
details.

Correct slanted text document
Detects the scanned text and corrects the angle (within -0.1 to -10 degrees or +0.1 to +10
degrees) of the document.

32 Important

» The following types of documents may not be corrected properly since the text cannot
be detected correctly.

* Documents in which the text lines are inclined more than 10 degrees or the angles
vary by line

» Documents containing both vertical and horizontal text

» Documents with extremely large or small fonts

» Documents with small amount of text

» Documents containing figures/images

» Hand-written text

» Documents containing both vertical and horizontal lines (tables)

»» Note

» Scanning takes longer than usual when you enable Correct slanted text document.

Detect the orientation of text document and rotate image
Automatically rotates the image to the correct orientation by detecting the orientation of text
in the scanned document.

22 Important

* Only text documents written in languages that can be selected from Document
Language in the Settings (General Settings) dialog box are supported.

» The orientation may not be detected for the following types of settings or documents
since the text cannot be detected correctly.

» Resolution is outside the range of 300 dpi to 600 dpi

» Font size is outside the range of 8 points to 48 points

» Documents containing special fonts, effects, italics, or hand-written text
» Documents with patterned backgrounds

In that case, select the Check scan results checkbox and rotate the image in the Save
Settings dialog box.

(2) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

86



»» Note

» When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To change the folder, specify the

destination folder in the Select Destination Folder dialog box displayed by selecting Add... from the

pull-down menu.
The default save folders are as follows.

* Windows 8.1: Documents folder

* Windows 8: My Documents folder

» Windows 7: My Documents folder

» Windows Vista: Documents folder

» Windows XP: My Documents folder

22 Important

» When the Settings dialog box is displayed from My Image Garden, this option does not appear.

Data Format
Select the data format in which to save the scanned images.

You can select JPEG/Exif, TIFF, PNG, PDF, PDF (Multiple Pages), or Auto.
32 Important

* When Auto is selected, the save format may differ depending on how you place the item.

= Placing Iltems (When Scanning from a Computer)

* You cannot select JPEG/Exif when Color Mode is Black and White.
+ When Start OCR is selected in Application Settings, you cannot select PDF, PDF (Multiple
Pages), or Auto.

»>» Note

» Auto appears only when Auto is selected for Select Source.

JPEG Image Quality
You can specify the image quality of JPEG files.

32 Important

» This appears only when JPEG/EXxif or Auto is selected in Data Format.

PDF Compression
Select the compression type for saving PDF files.

Standard
It is recommended that you normally select this setting.

High
Compresses the file size when saving, allowing you to reduce the load on your network/server.

22 Important

* This appears only when PDF, PDF (Multiple Pages), or Auto is selected in Data Format.
* When Black and White is selected in Color Mode, this option does not appear.
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Create a PDF file that supports keyword search
Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

32 Important

» This appears only when PDF, PDF (Multiple Pages), or Auto is selected in Data Format.

»» Note

A0
» PDF files that are searchable in the language selected in Document Language on the [
(General Settings) tab of the Settings dialog box are created.

Save to a subfolder with current date
Select this checkbox to create a current date folder in the folder specified in Save in and save
scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Check scan results
Displays the Save Settings dialog box after scanning.

32 Important

» This does not appear when Select Source is Auto.
* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

(3) Application Settings Area

Open with an application
Select this when you want to enhance or correct the scanned images.

You can specify the application from the pull-down menu.

Send to an application
Select this when you want to use the scanned images as they are in an application that allows you to
browse or organize images.

You can specify the application from the pull-down menu.

Send to a folder
Select this when you also want to save the scanned images to a folder other than the one specified in
Save in.

You can specify the folder from the pull-down menu.

Attach to e-mail
Select this when you want to send e-mails with the scanned images attached.

You can specify the e-mail client you want to start from the pull-down menu.

Start OCR
Select this when you want to convert text in the scanned image into text data.

You can specify the application from the pull-down menu.

Do not start any application
Saves to the folder specified in Save in.
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> Note

» Specify the application or folder in the Select Application or Select Destination Folder dialog box
displayed by selecting Add... from the pull-down menu.

Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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Settings (Scan and Stitch) Dialog Box
Click Scan and Stitch on the (Scanning from a Computer) tab to display the Settings (Scan and
Stitch) dialog box.

In the Settings (Scan and Stitch) dialog box, you can make advanced scan settings for scanning items
larger than the platen.
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= (1) Scan Options Area
= (2) Save Settings Area
= (3) Application Settings Area

22 Important

* When the Settings dialog box is displayed from the Scan screen of My Image Garden, the setting items
for Application Settings do not appear.

(1) Scan Options Area
Select Source
Select the type of item to be scanned.

» Scanning photos: Photo
» Scanning documents: Document
» Scanning magazines: Magazine

22> Note

» To reduce moire, set Select Source to Magazine.
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Color Mode
Select the color mode in which to scan the item.

Resolution
Select the resolution of the item to be scanned.

The higher the resolution (value), the more detail in your image.
= Resolution
Image Processing Settings

Click . * (Plus) to set the following. Available setting items vary by Select Source.

22 Important

» When Color Mode is Black and White, Image Processing Settings is not available.

* When Select Source is Photo:
Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.
* When Select Source is Magazine or Document:

Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.

Reduce show-through
Sharpens text in an item or reduces show-through in newspapers, etc.

Reduce moire
Reduces moire patterns.

Printed materials are displayed as a collection of fine dots. "Moire" is a phenomenon where
uneven gradation or a stripe pattern appears when such photos or pictures printed with fine
dots are scanned.

»» Note

» Scanning takes longer than usual when you enable Reduce moire.

(2) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

»» Note

* When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To change the folder, specify the
destination folder in the Select Destination Folder dialog box displayed by selecting Add... from the
pull-down menu.

The default save folders are as follows.

* Windows 8.1: Documents folder
* Windows 8: My Documents folder
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» Windows 7: My Documents folder
* Windows Vista: Documents folder
» Windows XP: My Documents folder

32 Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

Data Format
Select the data format in which to save the scanned images.

You can select JPEG/Exif, TIFF, PNG, PDF, or PDF (Multiple Pages).
32 Important

* You cannot select JPEG/Exif when Color Mode is Black and White.

PDF Compression
Select the compression type for saving PDF files.

Standard
It is recommended that you normally select this setting.
High
Compresses the file size when saving, allowing you to reduce the load on your network/server.

22 Important

* This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.
» When Black and White is selected in Color Mode, this option does not appear.

Create a PDF file that supports keyword search

Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

22 Important

» This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.

»» Note

A0
» PDF files that are searchable in the language selected in Document Language on the ]
(General Settings) tab of the Settings dialog box are created.

JPEG Image Quality
You can specify the image quality of JPEG files.

32 Important

» This appears only when JPEG/Exif is selected in Data Format.

Save to a subfolder with current date

Select this checkbox to create a current date folder in the folder specified in Save in and save
scanned images in it. The folder will be created with a name such as "20XX_01_01"

(Year_Month_Date).
If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Check scan results
Displays the Save Settings dialog box after scanning.
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32 Important

» When the Settings dialog box is displayed from My Image Garden, this option does not appear.

(3) Application Settings Area

Open with an application
Select this when you want to enhance or correct the scanned images.

You can specify the application from the pull-down menu.

Send to an application
Select this when you want to use the scanned images as they are in an application that allows you to
browse or organize images.

You can specify the application from the pull-down menu.

Send to a folder
Select this when you also want to save the scanned images to a folder other than the one specified in
Save in.

You can specify the folder from the pull-down menu.

Do not start any application
Saves to the folder specified in Save in.

»» Note

» Specify the application or folder in the Select Application or Select Destination Folder dialog box
displayed by selecting Add... from the pull-down menu.

Instructions

Opens this guide.

Defaults

You can restore the settings in the displayed screen to the default settings.
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Settings (ScanGear) Dialog Box
Click ScanGear on the (Scanning from a Computer) tab to display the Settings (ScanGear) dialog
box.

In the Settings (ScanGear) dialog box, you can specify how to save images when scanning items by
starting ScanGear (scanner driver) and how to respond after saving them.
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= (1) Save Settings Area
= (2) Application Settings Area

22 Important

» When the Settings dialog box is displayed from My Image Garden, the setting items for Application
Settings do not appear.

(1) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

»» Note

* When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To change the folder, specify the

destination folder in the Select Destination Folder dialog box displayed by selecting Add... from the
pull-down menu.

The default save folders are as follows.
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» Windows 8.1: Documents folder

* Windows 8: My Documents folder

» Windows 7: My Documents folder

* Windows Vista: Documents folder

» Windows XP: My Documents folder

32 Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

Data Format
Select the data format in which to save the scanned images.

You can select JPEG/Exif, TIFF, PNG, PDF, or PDF (Multiple Pages).
3> Note

* When PDF or PDF (Multiple Pages) is selected, images up to 9600 pixels x 9600 pixels can be
scanned.

* When the Enable large image scans checkbox is selected in Save Settings, or when Start
OCR is selected in Application Settings, you can select JPEG/Exif, TIFF, or PNG.

JPEG Image Quality
You can specify the image quality of JPEG files.

22 Important

» This appears only when JPEG/EXxif is selected in Data Format.

PDF Compression
Select the compression type for saving PDF files.

Standard
It is recommended that you normally select this setting.

High
Compresses the file size when saving, allowing you to reduce the load on your network/server.

32 Important

» This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.

Create a PDF file that supports keyword search
Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

32 Important

» This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.

»» Note

A0
» PDF files that are searchable in the language selected in Document Language on the [
(General Settings) tab of the Settings dialog box are created.

Save to a subfolder with current date
Select this checkbox to create a current date folder in the folder specified in Save in and save
scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).
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If this checkbox is not selected, files are saved directly in the folder specified in Save in.

Enable large image scans
Select this checkbox to scan images up to 50000 pixels x 50000 pixels and 4.0 GB.

32 Important

* When this checkbox is selected, you cannot select Send to an application, Send to a folder,
Attach to e-mail, or Start OCR.
* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

»» Note

* When this checkbox is not selected, images up to 10208 pixels x 14032 pixels can be scanned.

Check scan results
Displays the Save Settings dialog box after scanning.

22 Important

» When the Settings dialog box is displayed from My Image Garden, this option does not appear.

(2) Application Settings Area

Open with an application
Select this when you want to enhance or correct the scanned images.

You can specify the application from the pull-down menu.

Send to an application
Select this when you want to use the scanned images as they are in an application that allows you to
browse or organize images.

You can specify the application from the pull-down menu.

Send to a folder
Select this when you also want to save the scanned images to a folder other than the one specified in
Save in.

You can specify the folder from the pull-down menu.

Attach to e-mail
Select this when you want to send e-mails with the scanned images attached.

You can specify the e-mail client you want to start from the pull-down menu.

Start OCR
Select this when you want to convert text in the scanned image into text data.

You can specify the application from the pull-down menu.

Do not start any application
Saves to the folder specified in Save in.

»>» Note

+ Specify the application or folder in the Select Application or Select Destination Folder dialog box
displayed by selecting Add... from the pull-down menu.

Instructions
Opens this guide.

96



Defaults
You can restore the settings in the displayed screen to the default settings.
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Settings (PDF) Dialog Box

r
Click PDF onthe # (Scanning Using the Scanner Buttons) tab to display the Settings (PDF) dialog box.

In the Settings (PDF) dialog box, you can specify how to respond when saving images to a computer as
PDF files after scanning them using the scanner button.
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= (1) Scan Options Area
= (2) Save Settings Area
= (3) Application Settings Area

(1) Scan Options Area

Select Source
Document is selected.

Color Mode
Select the color mode in which to scan the item.

Paper Size
Select the size of the item to be scanned.
When you select Custom, a screen in which you can specify the paper size appears. Select a Unit,
then enter the Width and Height, and then click OK.
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»» Note

+ Click Defaults to restore the specified settings to the default settings.

Resolution
Select the resolution of the item to be scanned.

The higher the resolution (value), the more detail in your image.
= Resolution
Image Processing Settings

Click | * (Plus) to set the following.

¥ Note

* When Color Mode is Black and White, only Reduce gutter shadow, Correct slanted text
document, and Detect the orientation of text document and rotate image appear.

Apply Auto Document Fix
Select this checkbox to sharpen text in a document or magazine for better readability.

32 Important

» The color tone may differ from the source image due to corrections. In that case, deselect
the checkbox and scan.

»» Note

» Scanning takes longer than usual when you enable this function.

Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.

Reduce show-through
Sharpens text in an item or reduces show-through in newspapers, etc.

Reduce moire
Reduces moire patterns.
Printed materials are displayed as a collection of fine dots. "Moire" is a phenomenon where

uneven gradation or a stripe pattern appears when such photos or pictures printed with fine dots

are scanned.

»» Note

» Scanning takes longer than usual when you enable Reduce moire.

Reduce gutter shadow
Reduces gutter shadows that appear between pages when scanning open booklets.
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»» Note

» Use ScanGear (scanner driver)'s Advanced Mode tab to correct gutter shadows when
scanning non-standard size items or specified areas.
Refer to "Gutter Shadow Correction" for your model from Home of the Online Manual for
details.

Correct slanted text document
Detects the scanned text and corrects the angle (within -0.1 to -10 degrees or +0.1 to +10
degrees) of the document.

22 Important

 The following types of documents may not be corrected properly since the text cannot be
detected correctly.

* Documents in which the text lines are inclined more than 10 degrees or the angles vary
by line

* Documents containing both vertical and horizontal text

» Documents with extremely large or small fonts

» Documents with small amount of text

» Documents containing figures/images

» Hand-written text

» Documents containing both vertical and horizontal lines (tables)

»» Note

» Scanning takes longer than usual when you enable Correct slanted text document.

Detect the orientation of text document and rotate image
Automatically rotates the image to the correct orientation by detecting the orientation of text in
the scanned document.

32 Important

» Only text documents written in languages that can be selected from Document Language
in the Settings (General Settings) dialog box are supported.

= Settings (General Settings) Dialog Box

» The orientation may not be detected for the following types of settings or documents since
the text cannot be detected correctly.

* Resolution is outside the range of 300 dpi to 600 dpi

» Font size is outside the range of 8 points to 48 points

» Documents containing special fonts, effects, italics, or hand-written text
* Documents with patterned backgrounds

(2) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.
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»» Note

» When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To change the folder, specify the
destination folder in the Select Destination Folder dialog box displayed by selecting Add... from the
pull-down menu.

The default save folders are as follows.

* Windows 8.1: Documents folder

* Windows 8: My Documents folder

» Windows 7: My Documents folder

» Windows Vista: Documents folder

» Windows XP: My Documents folder

22 Important

» When the Settings dialog box is displayed from My Image Garden, this option does not appear.

Data Format
You can select PDF or PDF (Multiple Pages).

PDF Compression
Select the compression type for saving PDF files.

Standard
It is recommended that you normally select this setting.

High
Compresses the file size when saving, allowing you to reduce the load on your network/server.

32 Important

* When Black and White is selected in Color Mode, this option does not appear.

Create a PDF file that supports keyword search
Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

»» Note

A0
» PDF files that are searchable in the language selected in Document Language on the [
(General Settings) tab of the Settings dialog box are created.

Save to a subfolder with current date
Select this checkbox to create a current date folder in the folder specified in Save in and save
scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.
(3) Application Settings Area

Open with an application
Select this when you want to enhance or correct the scanned images.
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You can specify the application from the pull-down menu.

Send to an application
Select this when you want to use the scanned images as they are in an application that allows you to
browse or organize images.

You can specify the application from the pull-down menu.

Send to a folder
Select this when you also want to save the scanned images to a folder other than the one specified in
Save in.

You can specify the folder from the pull-down menu.

Do not start any application
Saves to the folder specified in Save in.

»» Note

» Specify the application or folder in the Select Application or Select Destination Folder dialog box
displayed by selecting Add... from the pull-down menu.

Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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Settings (AUTO SCAN) Dialog Box

r
Click AUTO SCAN onthe ¥ (Scanning Using the Scanner Buttons) tab to display the Settings (AUTO
SCAN) dialog box.

In the Settings (AUTO SCAN) dialog box, you can specify how to respond when saving images to a
computer after scanning them using the scanner button by automatically detecting the item.
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= (1) Scan Options Area
= (2) Save Settings Area
= (3) Application Settings Area

Supported Items
Photos, postcards, business cards, magazines, newspapers, documents, and BD/DVD/CD.

22 Important

» To scan the following types of items, specify the item type and size in the Settings (Document Scan)
dialog box or Settings (Photo Scan) dialog box, then click Document or Photo in the IJ Scan Utility
main screen. You cannot scan correctly with Auto.

* A4 size photos

» Text documents smaller than 2L (5 inches x 7 inches) (127 mm x 178 mm), such as paperback
pages with the spine cut off

* Items printed on thin white paper

» Long narrow items such as panoramic photos

» Reflective disc labels may not be scanned as expected.

* Place items correctly according to the type of item to be scanned. Otherwise, items may not be scanned
correctly.

Refer to "Placing Items (When Scanning from a Computer)" for how to place items.
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»» Note

» To reduce moire, set Select Source to Magazine in the Settings (Document Scan) dialog box, then
click Document in the IJ Scan Utility main screen.

(1) Scan Options Area

Apply recommended image correction
Applies suitable corrections automatically based on the item type.

22 Important

» The color tone may differ from the source image due to corrections. In that case, deselect the
checkbox and scan.

»» Note

» Scanning takes longer than usual when you enable this function.

(2) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the " _20XX0101_0001" format.

»>» Note

» When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To change the folder, specify the
destination folder in the Select Destination Folder dialog box displayed by selecting Add... from the
pull-down menu.

The default save folders are as follows.

* Windows 8.1: Documents folder

» Windows 8: My Documents folder

* Windows 7: My Documents folder

» Windows Vista: Documents folder

* Windows XP: My Documents folder

Data Format
Auto is selected. The following data formats are automatically applied according to the item type
when saving.

* Photos, postcards, BD/DVD/CD, and business cards: JPEG
* Magazines, newspapers, and documents: PDF

22 Important

* The save format may differ depending on how you place the item.

Refer to "Placing ltems (When Scanning from a Computer)" for how to place items.

JPEG Image Quality
You can specify the image quality of JPEG files.
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PDF Compression
Select the compression type for saving PDF files.

Standard
It is recommended that you normally select this setting.
High
Compresses the file size when saving, allowing you to reduce the load on your network/server.
Create a PDF file that supports keyword search

Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

»» Note

1
» PDF files that are searchable in the language selected in Document Language on the ]
(General Settings) tab of the Settings dialog box are created.

Save to a subfolder with current date
Select this checkbox to create a current date folder in the folder specified in Save in and save
scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

(3) Application Settings Area

Open with an application
Select this when you want to enhance or correct the scanned images.

You can specify the application from the pull-down menu.

Send to an application
Select this when you want to use the scanned images as they are in an application that allows you to
browse or organize images.

You can specify the application from the pull-down menu.

Send to a folder
Select this when you also want to save the scanned images to a folder other than the one specified in
Save in.

You can specify the folder from the pull-down menu.

Attach to e-mail
Select this when you want to send e-mails with the scanned images attached.

You can specify the e-mail client you want to start from the pull-down menu.

Do not start any application
Saves to the folder specified in Save in.

»>» Note

» Specify the application or folder in the Select Application or Select Destination Folder dialog box
displayed by selecting Add... from the pull-down menu.

Instructions
Opens this guide.
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Defaults
You can restore the settings in the displayed screen to the default settings.

106



Settings (COPY) Dialog Box

A
Click COPY onthe # (Scanning Using the Scanner Buttons) tab to display the Settings (COPY) dialog
box.

In the Settings (COPY) dialog box, you can specify how to respond when printing images on a printer after
scanning them using the scanner button.

»» Note

» Selectable paper sizes and types vary by printer.

+ When multiple items are placed on the platen and Auto is selected for Select Source, each item is
scanned individually and printed on a separate sheet of paper. To print multiple items on one sheet of
paper, select an option other than Auto and select a standard size (A4, Letter, etc.) for Paper Size.

Settings (COPY)
e I
= & | if
éfl poE T Ol
Selact Spuroe: Cooument w (1 )
& AUTOECAN Colar Mode Codor w
Popes Size: Lithar v
S
Reaspiutors 300 dpd w
.ﬁ nrm Scale 0% w
_+ | Image Processng Satings
Priniler Satbngs
Poper Sizes W (2)
Hursber of Copless 1 =
Printar; = Froperbas..,
Instruckons Defaults [+ 4

= (1) Scan Options Area
= (2) Printer Settings Area

(1) Scan Options Area

Select Source
Select the type of item to be scanned. Select Auto to detect the item type automatically and to set
Color Mode, Paper Size, and Resolution automatically as well.

22 Important

* Item types supported by Auto are photos, postcards, business cards, magazines, newspapers,
documents, and BD/DVD/CD.

» To scan the following types of items, specify the item type or size. You cannot scan correctly with
Auto.
* A4 size photos

» Text documents smaller than 2L (5 inches x 7 inches) (127 mm x 178 mm), such as
paperback pages with the spine cut off

107



* ltems printed on thin white paper
» Long narrow items such as panoramic photos

» Reflective disc labels may not be scanned as expected.

* Place items correctly according to the type of item to be scanned. Otherwise, items may not be
scanned correctly.

Refer to "Placing Items (When Scanning from a Computer)" for how to place items.

»» Note

» To reduce moire, set Select Source to Magazine.

Color Mode
Select the color mode in which to scan the item.

Paper Size
Select the size of the item to be scanned.

When you select Custom, a screen in which you can specify the paper size appears. Select a Unit,
then enter the Width and Height, and then click OK.

Custom 5ize Setting ﬂ
ik nches (100 -8.50)
Height: . 11.00 | nches (100 - 11.68)
Lt inches W
| oK . Defaults Il Cancel

»» Note

* Only Auto is available when Select Source is Auto.

* Click Defaults in the screen in which you can specify the paper size to restore the specified
settings to the default settings.

Resolution
Select the resolution of the item to be scanned.

The higher the resolution (value), the more detail in your image.

= Resolution

»» Note

* Only Auto is available when Select Source is Auto.

Scale
Select a scale according to the paper to print on and purpose of use.

Select Fit to Paper to resize the scanned image automatically to fit the paper to print on. Since the
image's aspect ratio is maintained, margins may appear at the top and bottom or on the left and right
depending on the size of the item and paper.

Select Custom to enter a value in Scale Setting. Enter a percentage (25 % to 400 %) and click OK.

»» Note

» Scanned images are printed on paper of the size specified on your printer.
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Refer to the manual of your printer for details.

Brightness
Adjust the image brightness.

Move the slider to the left to darken and right to brighten the image.

32 Important

+ This function is available only when Magazine or Document is selected for Select Source.
 This function is not available when Auto scan is selected for Paper Size.

Image Processing Settings

Click | * | (Plus) to set the following. Available setting items vary by Select Source.

* When Select Source is Photo:

»» Note

* When Color Mode is Black and White, Image Processing Settings is not available.

Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.

* When Select Source is Magazine or Document:

»» Note

* When Color Mode is Black and White, only Reduce gutter shadow appears.

Apply Auto Document Fix
Select this checkbox to sharpen text in a document or magazine for better readability.

22 Important

 The color tone may differ from the source image due to corrections. In that case,
deselect the checkbox and scan.

»» Note

» Scanning takes longer than usual when you enable this function.

Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.

Reduce show-through
Sharpens text in an item or reduces show-through in newspapers, etc.

Reduce moire
Reduces moire patterns.
Printed materials are displayed as a collection of fine dots. "Moire" is a phenomenon where
uneven gradation or a stripe pattern appears when such photos or pictures printed with fine
dots are scanned.

»» Note

» Scanning takes longer than usual when you enable Reduce moire.

Reduce gutter shadow
Reduces gutter shadows that appear between pages when scanning open booklets.
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»» Note

» Use ScanGear (scanner driver)'s Advanced Mode tab to correct gutter shadows when
scanning non-standard size items or specified areas.
Refer to "Gutter Shadow Correction" for your model from Home of the Online Manual for
details.

* When Select Source is Auto:

Apply recommended image correction
Applies suitable corrections automatically based on the item type.

22 Important

 The color tone may differ from the source image due to corrections. In that case,
deselect the checkbox and scan.

»» Note

» Scanning takes longer than usual when you enable this function.

(2) Printer Settings Area

Paper Size
Select the size of the paper to print on.

»» Note

» Selectable paper sizes depend on the selected printer.

Number of Copies
Specify the number of copies to print.

Y

Click == (up and down buttons) to the right of the value or enter a value.
Specify up to 99 copies.

Printer
Select a printer to use when multiple printers are connected.
Click Properties... to open a dialog box to configure the printer settings.

Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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Settings (SEND) Dialog Box

r 3
Click SEND on the ¥ (Scanning Using the Scanner Buttons) tab to display the Settings (SEND) dialog

box.

In the Settings (SEND) dialog box, you can specify how to respond when attaching images to an e-mail,
sending them to an application, or saving them to a folder after scanning them using the scanner button.

Settings (SEND)

JPEG Image Cualiby:

[ 5awve b subsfobcbar with cunrant dabe

Appbeaten Settng
Send Mathoct

= (1) Scan Options Area
= (2) Save Settings Area
= (3) Application Settings Area

(1) Scan Options Area

Select Source
Select the type of item to be scanned.

13 Note

» To reduce moire, set Select Source to Magazine.

Color Mode
Select the color mode in which to scan the item.

Paper Size
Select the size of the item to be scanned.
When you select Custom, a screen in which you can specify the paper size appears. Select a Unit,
then enter the Width and Height, and then click OK.
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Custom 5Size Setting E

it e (1.00-.50)
Height: . 11,00 | rches (100 - 11.68)
Linit: inches W

| OK [ Defaults I Cancel

»» Note

* Click Defaults in the screen in which you can specify the paper size to restore the specified
settings to the default settings.

Resolution
Select the resolution of the item to be scanned.

The higher the resolution (value), the more detail in your image.
= Resolution
Image Processing Settings

Click . * (Plus) to set the following. Available setting items vary by Select Source.

* When Select Source is Photo:

»» Note

* When Color Mode is Black and White, Image Processing Settings is not available.

Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.

* When Select Source is Magazine or Document:

»» Note

* When Color Mode is Black and White, only Reduce gutter shadow, Correct slanted text
document, and Detect the orientation of text document and rotate image appear.

Apply Auto Document Fix
Select this checkbox to sharpen text in a document or magazine for better readability.

22 Important

» The color tone may differ from the source image due to corrections. In that case,
deselect the checkbox and scan.

»» Note

» Scanning takes longer than usual when you enable this function.

Sharpen outline
Emphasizes the outline of the subjects to sharpen the image.

Reduce show-through
Sharpens text in an item or reduces show-through in newspapers, etc.

Reduce moire
Reduces moire patterns.
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Printed materials are displayed as a collection of fine dots. "Moire" is a phenomenon where
uneven gradation or a stripe pattern appears when such photos or pictures printed with fine
dots are scanned.

»» Note

» Scanning takes longer than usual when you enable Reduce moire.

Reduce gutter shadow
Reduces gutter shadows that appear between pages when scanning open booklets.

»» Note

» Use ScanGear (scanner driver)'s Advanced Mode tab to correct gutter shadows when
scanning non-standard size items or specified areas.
Refer to "Gutter Shadow Correction" for your model from Home of the Online Manual for
details.

Correct slanted text document
Detects the scanned text and corrects the angle (within -0.1 to -10 degrees or +0.1 to +10
degrees) of the document.

22 Important

 The following types of documents may not be corrected properly since the text cannot
be detected correctly.

* Documents in which the text lines are inclined more than 10 degrees or the angles
vary by line

* Documents containing both vertical and horizontal text

» Documents with extremely large or small fonts

» Documents with small amount of text

» Documents containing figures/images

Hand-written text

» Documents containing both vertical and horizontal lines (tables)

»» Note

» Scanning takes longer than usual when you enable Correct slanted text document.

Detect the orientation of text document and rotate image
Automatically rotates the image to the correct orientation by detecting the orientation of text
in the scanned document.

32 Important

» Only text documents written in languages that can be selected from Document
Language in the Settings (General Settings) dialog box are supported.

= Settings (General Settings) Dialog Box

» The orientation may not be detected for the following types of settings or documents
since the text cannot be detected correctly.

* Resolution is outside the range of 300 dpi to 600 dpi

» Font size is outside the range of 8 points to 48 points

+ Documents containing special fonts, effects, italics, or hand-written text
* Documents with patterned backgrounds
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(2) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

»>» Note

* When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To change the folder, specify the
destination folder in the Select Destination Folder dialog box displayed by selecting Add... from the
pull-down menu.

The default save folders are as follows.

* Windows 8.1: Documents folder

» Windows 8: My Documents folder

* Windows 7: My Documents folder

* Windows Vista: Documents folder

* Windows XP: My Documents folder

22 Important

* When the Settings dialog box is displayed from My Image Garden, this option does not appear.

Data Format
Select the data format in which to save the scanned images.

You can select JPEG/Exif, TIFF, PNG, PDF, or PDF (Multiple Pages).
22 Important

* You cannot select JPEG/Exif when Color Mode is Black and White.

JPEG Image Quality
You can specify the image quality of JPEG files.

32 Important

» This appears only when JPEG/EXxif is selected in Data Format.

PDF Compression
Select the compression type for saving PDF files.

Standard
It is recommended that you normally select this setting.

High
Compresses the file size when saving, allowing you to reduce the load on your network/server.

22 Important

* This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.
» When Black and White is selected in Color Mode, this option does not appear.

Create a PDF file that supports keyword search
Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.
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32 Important

» This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.

»» Note

1
» PDF files that are searchable in the language selected in Document Language on the [
(General Settings) tab of the Settings dialog box are created.

Save to a subfolder with current date

Select this checkbox to create a current date folder in the folder specified in Save in and save

scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.

(3) Application Settings Area
Send Method

Specify the e-mail client to use for attaching scanned images, application to which to send them, or
folder in which to save them.

> Note

» Specify the e-mail client, application, or folder in the Select Send Method dialog box displayed by
selecting Add... from the pull-down menu.

Instructions
Opens this guide.

Defaults

You can restore the settings in the displayed screen to the default settings.
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Settings (General Settings) Dialog Box

0
Click the (General Settings) tab to display the Settings (General Settings) dialog box.

In the Settings (General Settings) dialog box, you can set the product to use, file size restriction on images
to be attached to an e-mail or to be sent, language to detect text in images, and folder in which to save
images temporarily.

22 Important

* When the Settings dialog box is displayed from My Image Garden, some options may not appear.

Settings (General Settings)
= = | iff
—= T f
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Fuider to Save Temparary Fias
Browse.as
Instructons Default oK

Product Name
Displays the name of the product that IJ Scan Utility is currently set to use.

If the displayed product is not the one you want to use, select the desired product from the list.

File Size for Attach to E-mail and Send Image
You can restrict the size of scanned images to be attached to an e-mail or to be sent.
You can select Small (Suitable for 640 x 480 Windows), Medium (Suitable for 800 x 600 Windows),
Large (Suitable for 1024 x 768 Windows), or No Change.

Document Language
Select the language for detecting text in images.

Folder to Save Temporary Files
Displays the folder in which to save images temporarily. Click Browse... to specify the destination
folder.

Instructions
Opens this guide.

Defaults
You can restore the settings in the displayed screen to the default settings.
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Save Settings Dialog Box

Select the Check scan results checkbox in Save Settings of the Settings dialog box to display the Save
Settings dialog box after scanning.

You can specify the data format and destination while viewing the thumbnails of scan results.

22 Important

+ After scanning from My Image Garden or scanning using the scanner buttons, the Save Settings dialog
box does not appear.

Save Settings “
[ &8
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[C]5ave b a subfalder with current date
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= (1) Preview Operation Buttons
= (2) Scan Results Area
= (3) Save Settings Area

(1) Preview Operation Buttons

£ a
BN (Rotate Left 90°)/(Rotate Right 90°)
Rotates scanned images 90 degrees counter-clockwise or clockwise.

£ an
Select the image you want to rotate, then click -Q-I'I (Rotate Left 90°) or IQ—I (Rotate Right 90°).
32 Important

» The preview operation buttons do not appear when the Enable large image scans checkbox is
selected in the Settings (ScanGear) dialog box.

(2) Scan Results Area

Displays the thumbnails of the scanned images. You can change the save order of images via drag-and-
drop. The file names for saving appear below the thumbnails.
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(3) Save Settings Area

File Name
Enter the file name of the image to be saved. When you save a file, the date and four digits are
appended to the set file name in the "_20XX0101_0001" format.

»>» Note

* When you select the Save to a subfolder with current date checkbox, the date and four digits
are appended to the set file name.

Save in
Displays the folder in which to save the scanned images. To change the folder, specify the
destination folder in the Select Destination Folder dialog box displayed by selecting Add... from the
pull-down menu.

The default save folders are as follows.

* Windows 8.1: Documents folder

» Windows 8: My Documents folder

* Windows 7: My Documents folder

* Windows Vista: Documents folder

* Windows XP: My Documents folder

Data Format
Select the data format in which to save the scanned images.

You can select JPEG/Exif, TIFF, PNG, PDF, or PDF (Multiple Pages).
22 Important

* You cannot select PDF or PDF (Multiple Pages) in the following cases.

* When scanned by clicking Photo in the IJ Scan Utility main screen

» The Enable large image scans checkbox is selected in Save Settings of the Settings
(ScanGear) dialog box

» Start OCR is selected in Application Settings of the Settings (Document Scan), Settings
(Custom Scan), or Settings (ScanGear) dialog box

* You cannot select JPEG/Exif when Color Mode is Black and White.

JPEG Image Quality
You can specify the image quality of JPEG files.

3% Important

» This appears only when JPEG/Exif is selected in Data Format.

PDF Compression
Select the compression type for saving PDF files.

Standard
It is recommended that you normally select this setting.

High

Compresses the file size when saving, allowing you to reduce the load on your network/server.

22 Important

» This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.
* When Black and White is selected in Color Mode, this option does not appear.

118



Create a PDF file that supports keyword search
Select this checkbox to convert text in images into text data and create PDF files that support
keyword search.

32 Important

» This appears only when PDF or PDF (Multiple Pages) is selected in Data Format.

»» Note

A0
» PDF files that are searchable in the language selected in Document Language on the [
(General Settings) tab of the Settings dialog box are created.

Save to a subfolder with current date
Select this checkbox to create a current date folder in the folder specified in Save in and save
scanned images in it. The folder will be created with a name such as "20XX_01_01"
(Year_Month_Date).

If this checkbox is not selected, files are saved directly in the folder specified in Save in.
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Image Stitch Window

Click Stitch in the IJ Scan Utility main screen to display the Image Stitch window.

You can scan the left and right halves of an item larger than the platen and combine them back into one
image. You can scan items up to approximately twice as large as the platen.

Select Qutput Size

|a3adxz)

Sean Direction

|sesn B Len

Sean Image 1

= (1) Settings and Operation Buttons
= (2) Toolbar

= (3) Thumbnail View Area

= (4) Preview Area

22> Note

» The displayed items vary depending on the select source and view.

(1) Settings and Operation Buttons

Select Output Size
B4 (B5 x 2)
Scans the left and right halves of a B4 size item separately.

A3 (Ad x 2)
Scans the left and right halves of an A3 size item separately.

11 x 17 (Letter x 2)
Scans the left and right halves of an item twice as large as Letter size separately.

Full Platen x 2
Scans the left and right halves of an item twice as large as the platen separately.

Scan Direction
Scan from Left
Displays the first scanned image on the left side.

Scan from Right
Displays the first scanned image on the right side.
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Scan Image 1
Start Scanning Image 1
Scans the first item.

Lran Image 1

Start Scanning Image L

Sean Linage 2

Scan Image 2
Start Scanning Image 2
Scans the second item.

Soan Image 1

Start Scanming Image L

9 Gean Tmage 2

&tart Seanning Imane

Adjust cropping frames
You can adjust the scan area in preview.

If no area is specified, the image of the size selected in Select Output Size will be saved. If an area
is specified, only the image in the cropping frame will be scanned and saved.

= Adjusting Cropping Frames in the Image Stitch Window
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Save
Save
Saves the two scanned images as one image.

Cancel
Cancels Stitch scan.

(2) Toolbar

You can delete the scanned images or adjust the previewed images.

x (Delete)

Deletes the scanned image.

| \I
N (Enlarge/Reduce)
Allows you to enlarge or reduce the preview image.

Left-clicking the Preview area enlarges the displayed image.

Right-clicking the Preview area reduces the displayed image.

£
Eal’ (Rotate Left)

Rotates the preview image 90 degrees counter-clockwise.

Y
= (Invert Vertically)
Rotates the preview image 180 degrees.

3
By (Rotate Right)
Rotates the preview image 90 degrees clockwise.

&  (Open Guide)
Opens this page.

(3) Thumbnail View Area

Displays the thumbnails of the scanned images. Appears blank if none has been scanned.

(4) Preview Area

Displays the scanned images. You can adjust the layout by dragging the scanned image or check the
results of the settings made in "(1) Settings and Operation Buttons."
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When no image has been scanned:

After scanning the first item by clicking Start Scanning Image 1:

The image is scanned in the direction specified in Scan Direction, and 2 appears next to it.

After scanning the second item by clicking Start Scanning Image 2:

The two scanned images appear.

Related Topic

= Scanning ltems Larger than the Platen (Image Stitch)
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Scanning with Application Software that You are Using (ScanGear)

» What Is ScanGear (Scanner Driver)?

» Scanning with Advanced Settings Using ScanGear (Scanner Driver)

» Starting ScanGear (Scanner Driver)

» Scanning in Basic Mode

» Scanning in Advanced Mode

» Scanning Multiple Documents at One Time with ScanGear (Scanner Driver)
» Correcting Images and Adjusting Colors with ScanGear (Scanner Driver)
» ScanGear (Scanner Driver) Screens

» Placing Items (When Scanning from a Computer)

» Adjusting Cropping Frames (ScanGear)

» General Notes (Scanner Driver)

» Updating the ScanGear (Scanner Driver)
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What Is ScanGear (Scanner Driver)?

ScanGear (scanner driver) is software required for scanning documents. It enables you to specify the output
size and make image corrections when scanning.

ScanGear can be started from IJ Scan Utility or applications that are compatible with a standard interface
called TWAIN. (ScanGear is a TWAIN-compatible driver.)

What You Can Do with This Software

This software enables you to preview scan results or set document type and output size, etc. when
scanning documents. It is useful when you want to scan in a specific color tone, as it allows you to make
various corrections and adjust brightness, contrast, etc.

Screens

There are two modes: Basic Mode and Advanced Mode.

Switch modes by clicking a tab on the upper right of the screen.

Basic Mode | Advanced Mode

23» Note

» ScanGear starts in the last used mode.
» Settings are not retained when you switch modes.

Basic Mode

Use the Basic Mode tab to scan easily by following three simple on-screen steps ( o e and
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Advanced Mode

Use the Advanced Mode tab to specify the color mode, output resolution, image brightness, color tone,
etc. when scanning.
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Scanning with Advanced Settings Using ScanGear (Scanner
Driver)

» Starting ScanGear (Scanner Driver)
» Scanning in Basic Mode
» Scanning in Advanced Mode

» Scanning Multiple Documents at One Time with ScanGear (Scanner Driver)
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Starting ScanGear (Scanner Driver)

Use ScanGear (scanner driver) to make image corrections and color adjustments when scanning. ScanGear
can be started from IJ Scan Ultility or other applications.

Starting IJ Scan Utility

Follow these steps to start ScanGear from IJ Scan Utility.

1. Start IJ Scan Utility.

Refer to "Starting IJ Scan Utility" for your model from Home of the Online Manual for how to start IJ
Scan Utility.

2. Click ScanGear in the IJ Scan Utility main screen.

The ScanGear screen appears.

Starting from an Application

Follow these steps (example) to start ScanGear from an application.

The procedure varies depending on the application. For details, refer to the application's manual.
1. Start the application.
2. On the menu of the application, select the machine.

3. Select the command to scan a document.

The ScanGear screen appears.
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Scanning in Basic Mode

Use the Basic Mode tab to scan easily by following the on-screen steps.

Refer to "Scanning Multiple Documents at One Time with ScanGear (Scanner Driver)" to scan multiple
documents at one time.

% Important

» The following types of documents may not be scanned correctly. In that case, click @ (Thumbnail)
on the Toolbar to switch to whole image view and scan.

» Photos that have a whitish background

» Documents printed on white paper, hand-written text, business cards, etc.
* Thin documents

» Thick documents

» The following types of documents may not be scanned correcitly.

* Documents smaller than 1.2 inches (3 cm) square
* Photos that have been cut to various shapes

1. Place the document on the Platen, then start ScanGear (scanner driver).

= Placing Items (When Scanning from a Computer)
= Starting ScanGear (Scanner Driver)

2. Set Select Source according to the document placed on the Platen .
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29> Note

» To scan magazines containing many color photos, select Magazine (Color).

3. Click Preview.

Preview image appears in the Preview area.
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122> Note

» Colors are adjusted based on the document type selected in Select Source.

4. Set Destination.

5. Set Output Size according to purpose.

Output size options vary by the item selected in Destination.

6. Adjust the cropping frames (scan areas) as required.

Adjust the size and position of the cropping frames on the preview image.

= Adjusting Cropping Frames (ScanGear)

7. Set Image corrections as required.

8. Click Scan.
Scanning starts.

23 Note

* Click 0 (Information) to open a dialog box in which you can check the current scan settings
(document type, etc.).

» A response of ScanGear after scanning can be specified in Status of ScanGear dialog after scanning
on the Scan tab of the Preferences dialog box.

Related Topic

= Basic Mode Tab
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Scanning in Advanced Mode

Use the Advanced Mode tab to specify the color mode, output resolution, image brightness, color tone, etc.
when scanning.

Refer to "Scanning Multiple Documents at One Time with ScanGear (Scanner Driver)" to scan multiple
documents at one time.

2 3% Important

» The following types of documents may not be scanned correcitly. In that case, click @ (Thumbnail)
on the Toolbar to switch to whole image view and scan.

» Photos that have a whitish background

» Documents printed on white paper, hand-written text, business cards, etc.
» Thin documents

» Thick documents

» The following types of documents may not be scanned correctly.

* Documents smaller than 1.2 inches (3 cm) square
» Photos that have been cut to various shapes

1. Place the document on the Platen, then start ScanGear (scanner driver).

= Placing Items (When Scanning from a Computer)
= Starting ScanGear (Scanner Driver)

2. Click the Advanced Mode tab.

The tab switches to Advanced Mode.
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22> Note

« Settings are not retained when you switch modes.

3. Set Input Settings according to the document or purpose.
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4. Click Preview.

Preview images appear in the Preview area.

T e E

5. Set OQutput Settings.

6. Adjust the cropping frame (scan area), correct image, and adjust colors as required.

= Adjusting Cropping Frames (ScanGear)

= Image Settings
= Color Adjustment Buttons

7. Click Scan.
Scanning starts.

22> Note

+ Click @ (Information) to open a dialog box in which you can check the current scan settings
(document type, etc.).

» A response of ScanGear after scanning can be specified in Status of ScanGear dialog after scanning
on the Scan tab of the Preferences dialog box.

Related Topic

= Advanced Mode Tab
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Scanning Multiple Documents at One Time with ScanGear
(Scanner Driver)

You can scan two or more photos (small documents) on the Platen at one time on the Basic Mode tab and
Advanced Mode tab.

This section explains how to scan multiple documents from the Basic Mode tab.

32 Important

+ To scan multiple documents as a single image, scan in whole image view.
» The following types of documents may not be cropped correctly. In that case, adjust the cropping
frames (scan areas) in whole image view and scan.

» Photos that have a whitish background

» Documents printed on white paper, hand-written text, business cards, etc.
» Thin documents

» Thick documents

= Scanning Multiple Documents in Whole Image View

» The following types of documents may not be scanned correctly.

» Documents smaller than 1.2 inches (3 cm) square
* Photos that have been cut to various shapes

»» Note

* You can also scan multiple documents at one time from the Advanced Mode tab. Use the Advanced
Mode tab to make advanced scan settings such as the color mode, output resolution, image brightness,
and color tone.

» Refer to the corresponding sections below for details on the Basic Mode tab and Advanced Mode tab.

= Basic Mode Tab
= Advanced Mode Tab

1. Place the document on the Platen, then start ScanGear (scanner driver).

= Placing ltems (When Scanning from a Computer)
= Starting ScanGear (Scanner Driver)

2. Set Select Source according to the document placed on the Platen.
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3. Click Preview.

Thumbnails of the preview images appear in the Preview area. Cropping frames are specified
automatically according to the document size.
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4. Set Destination.
5. Set Output Size according to purpose.

6. Adjust the cropping frames and set Image corrections as required.

22> Note

* You can correct each image separately. Select the frame you want to correct.
* In thumbnail view, you can only create one cropping frame per image. To create multiple cropping
frames in an image, scan in whole image view.

= Scanning Multiple Documents in Whole Image View
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7. Select the images you want to scan.

Select the checkboxes of the images you want to scan.
8. Click Scan.

Scanning Multiple Documents in Whole Image View

Follow these steps if thumbnails are not displayed correctly when previewed or if you want to scan
multiple documents as a single image.

23> Note

* Positions of slanted documents are not corrected in whole image view.

1. After previewing images, click @ (Thumbnail) on the Toolbar.

Switch to whole image view.
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=

|
+ When the whole image is displayed, the icon changesto ' (Whole Image).

2. Set Destination.

3. Set Output Size according to purpose.

Invert aspect ratio will be enabled when Output Size is set to anything but Flexible. Click this button
to rotate the cropping frame. Click again to return it to the original orientation.

4. Adjust the cropping frames.
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Adjust the size and position of the cropping frames on the preview image. You can also create two or
more cropping frames.

If an area is not specified, the document will be scanned at the document size (Auto Crop). If an area
is specified, only the portion in the specified area will be scanned.

= Adjusting Cropping Frames (ScanGear)

5. Set Image corrections as required.

6. Click Scan.

Areas framed by broken lines are scanned.

»» Note

» A response of ScanGear after scanning can be specified in Status of ScanGear dialog after scanning
on the Scan tab of the Preferences dialog box.
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Correcting Images and Adjusting Colors with ScanGear (Scanner
Driver)

» Correcting Images (Unsharp Mask, Reduce Dust and Scratches, Fading
Correction, etc.)

» Adjusting Colors Using a Color Pattern
» Adjusting Saturation and Color Balance
» Adjusting Brightness and Contrast

» Adjusting Histogram

» Adjusting Tone Curve

» Setting Threshold
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Correcting Images (Unsharp Mask, Reduce Dust and Scratches,
Fading Correction, etc.)

The Image Settings functions on the Advanced Mode tab of ScanGear (scanner driver) allow you to
enhance the outline of the subjects, reduce dust/scratches, and correct faded colors when scanning images.

‘:.‘:.‘:..‘.‘ ‘:.‘:.

Setting Items

Click ¥ (Arrow) of a function and select an item from the pull-down menu.

e Dust and Soratdhes !
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32 Important

» Do not apply these functions to images without moire, dust/scratches, or faded colors. The color tone
may be adversely affected.

» Refer to "Image Settings" for details and precautions on each function.

23%» Note

» Refer to "Scanning in Advanced Mode" to start the Advanced Mode tab of ScanGear and scan.

Adjusting the image brightness and color tone

Set Image Adjustment to Auto, Photo, Magazine, or Document according to the document type.

None Auto
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Reducing show-through in text documents or lightening the base color in
recycled paper, newspapers, etc. when scanning documents

Set Reduce Show-through to ON.

OFF ON

Sharpening slightly out-of-focus images

Set Unsharp Mask to ON.

OFF ON

Reducing gradations and stripe patterns

Set Descreen to ON.
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»» Note

+ Printed photos and pictures are displayed as a collection of fine dots. "Moire" is a phenomenon
where uneven gradation or a stripe pattern appears when such photos or pictures printed with fine
dots are scanned. Descreen is the function for reducing this moire effect.

Reducing dust and scratches

Set Reduce Dust and Scratches to Low, Medium, or High according to the degree of dust and
scratches.

None Medium

O

Correcting photos that have faded with time or due to colorcast

Set Fading Correction to Low, Medium, or High according to the degree of fading or colorcast.

None Medium

Reducing graininess

Set Grain Correction to Low, Medium, or High according to the degree of graininess.

None Medium

Correcting shadows that appear between pages when scanning open booklets

Set Gutter Shadow Correction to Low, Medium, or High according to the degree of shadows.

None Medium
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Adjusting Colors Using a Color Pattern

You can preview color changes and reproduce natural colors by using the color pattern function in
ScanGear (scanner driver)'s Basic Mode tab.
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Color Adjustment

Correct colors that have faded with time or due to colorcast. "Colorcast" is a phenomenon where a
specific color affects the entire picture due to the weather or ambient strong colors.
Click an arrow in Color Adjustment to emphasize the corresponding color.

Cyan & red, magenta & green, and yellow & blue are complementary color pairs (each pair produces a
shade of gray when mixed). You can reproduce the natural colors of the scene by reducing the cast color
and increasing the complementary color.

It is recommended that you find a portion in the image where it should be white, and adjust the colors so
that the portion turns white.
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Preview image appears in the center. Preview image colors change as you adjust them.
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Below is an example of correcting a bluish image.

Since Blue and Green are too strong, click the Yellow and Magenta arrows to correct.

Before

»» Note

» Color adjustments are applied only to the cropping frames (scan areas) or the frame selected in
thumbnail view.

* You can select multiple frames or cropping frames by clicking them while pressing the Ctrl key.

* You can also select a color tone from the color pattern displayed on the left of the Color Pattern
screen.

* You can also use this function to add a specific tint to an image. Increase the magenta to add a warm
tint, and increase the blue to add a cool tint.
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Adjusting Saturation and Color Balance

You can brighten colors that have faded with time or due to colorcast by using e (Saturation/Color
Balance) in ScanGear (scanner driver)'s Advanced Mode tab.

Saturationy/Color Balance
Imbge Settmgs e, —
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¥>» Note

* Click Defaults to reset all adjustments in the current window.

Saturation
Adjust the image's saturation (vividness). You can brighten colors that have faded with time, etc.

Move 4 (Slider) under Saturation to the left to decrease the saturation (darken the image), and to the
right to increase the saturation (brighten the image). You can also enter a value (-127 to 127).

Sahuraton !

L

Low High

° s ¢
Saturation decreased Original image Saturation increased

w X s - -
e w .

»>» Note

» The natural color tone of the original image may be lost if you increase saturation too much.

Color Balance

Adjust images that have a colorcast. "Colorcast" is a phenomenon where a specific color affects the entire
picture due to the weather or ambient strong colors.
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Move 4 (Slider) under Color Balance to the left or right to emphasize the corresponding color.
Cyan & Red

Magenta & Green

Yellow & Blue

These are complementary color pairs (each pair produces a shade of gray when mixed). You can
reproduce the natural colors of the scene by reducing the cast color and increasing the complementary
color.

It is usually difficult to correct the image completely by adjusting only one color pair. It is recommended
that you find a portion in the image where it should be white, and adjust all three color pairs so that the
portion turns white.

You can also enter a value (-127 to 127).

Below is an example of an image in which the "Cyan & Red" pair has been adjusted.

Coler Balames

Cyan
g .

Cyan is increased Red is increased
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Adjusting Brightness and Contrast

You can adjust images that are too dark or bright, or too flat due to lack of contrast by using
(Brightness/Contrast) in ScanGear (scanner driver)'s Advanced Mode tab.
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2> Note

. Click ¥ (Down arrow) to switch to detailed view. Click A (Up arrow) to return to the previous view.
* Click Defaults to reset all adjustments in the current window.

Channel

Each dot of an image is a mixture of Red, Green, and Blue in various proportions (gradation). These
colors can be adjusted individually as a "channel."

Master
Adjust the Red, Green, and Blue combined.

Red
Adjust the Red channel.

Green
Adjust the Green channel.

Blue
Adjust the Blue channel.

»>» Note

* Only Grayscale will be displayed in Channel when Color Mode is Grayscale.
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Brightness
Adjust the image brightness.

Move 4 (Slider) under Brightness to the left to darken and right to brighten the image. You can also
enter a value (-127 to 127).

Erightness ; o K
Diark Bright
= =
Darkened Original image Brightened

> Note

» Highlights may be lost if you brighten the image too much, and shadows may be lost if you darken

the image too much.

Contrast

"Contrast" is the degree of difference between the brighter and darker parts of an image. Increasing
contrast will increase the difference, thus sharpening the image. Decreasing contrast will decrease the
difference, thus softening the image.

Move 4 (Slider) under Contrast to the left to decrease and right to increase the contrast of the image.

You can also enter a value (-127 to 127).

Conirast ] %
Low High
0 == °
Decreased contrast Original image Increased contrast

=

»» Note

* Increasing the contrast is effective in adding a three-dimensional feel to soft images. However,
shadows and highlights may be lost if you increase the contrast too much.
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Adjusting Histogram

You can adjust the image color tone by using a graph (histogram) showing brightness distribution, via b

(Histogram) in ScanGear (scanner driver)'s Advanced Mode tab.

Histogram  BEM
Imbge Selimgy
= Chanred @ Madter e
Impge Adurinent : Auto h
Lirsharp Magk ; ol w *
Chesiresn 2 COFF ¥ /
CUE | v v
! Befindts T
F i Pt
Ao || & || 2 255
Gray Balanoe ¢ o
SR G a:
Do Faits: e
»» Note

* Click Defaults to reset all adjustments in the current window.

Channel

Each dot of an image is a mixture of Red, Green, and Blue in various proportions (gradation). These
colors can be adjusted individually as a "channel."

Master
Adjust the Red, Green, and Blue combined.

Red
Adjust the Red channel.

Green
Adjust the Green channel.

Blue
Adjust the Blue channel.

»» Note

* Only Grayscale will be displayed in Channel when Color Mode is Grayscale.

Reading Histograms

You can see the histogram of a specified area for each Channel. The higher the histogram peak, the
more data is distributed to that level.
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(1) Bright area

(2) Dark area

(3) Whole image

_— - = iy _m
More data is distributed to the More data is distributed to the Data is widely distributed between the
highlight side. shadow side. highlight and shadow.

Adjusting Histograms (Using the Slider)

Select a Channel, then move 4 (Black-point Slider) or 2> (White-point Slider) to specify the level to be

set as the shadow or highlight.

———

 All parts to the left of . (Black-point Slider) will be black (level 0).

* The parts at .~ (Mid-point Slider) will turn to the color exactly between the black-point and white-

point.

+ All parts to the right of .2 (White-point Slider) will turn white (level 255).

When Image Adjustment is set to anything but None, the adjustments shown below are performed

automatically.

Moving the Black-point and White-point Sliders

Move the Black-point Slider or White-point Slider to adjust brightness.

Images with more data distributed to the highlight side

Move the Black-point Slider toward the highlight side.

Images with more data distributed to the shadow side

Move the White-point Slider toward the shadow side.

Images with widely distributed data

Move the Black-point Slider toward the highlight side, and White-point Slider toward the shadow side.
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Moving the Mid-point Slider

Move the Mid-point Slider to specify the level to be set as the middle of the tonal range.

Images with more data distributed to the highlight side

Move the Mid-point Slider toward the highlight side.

Images with more data distributed to the shadow side

Move the Mid-point Slider toward the shadow side.

Adjusting Histograms (Using the Droppers)

When you select a Channel and click the Black-point, Mid-point, or White-point Dropper, the mouse
pointer on the preview image changes to a dropper. Click a Dropper displayed below the histogram to

change the setting.

Histogram  BEM|
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Gray Balance @
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* The point clicked with i (Black-point Dropper) will be the darkest point. You can also enter a value
(0 to 245).

* The point clicked with i (Mid-point Dropper) will be the middle of the tonal range. You can also
enter a value (5 to 250).
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Y

» The point clicked with
value (10 to 255).

(White-point Dropper) will be the brightest point. You can also enter a

* Click d (Dropper) for Gray Balance and click the area you want to adjust the color in the preview
image.

The clicked point will be set as the achromatic color reference, and the rest of the image is adjusted
accordingly. For instance, if snow in a photo appears bluish, click the bluish part to adjust the whole image
and reproduce natural colors.
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Adjusting Tone Curve

You can adjust the brightness of an image by selecting the type of graph (tone curve) showing the balance

of tone input and output, via /] (Tone Curve Settings) in ScanGear (scanner driver)'s Advanced Mode
tab.
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3> Note

+ Click Defaults to reset all adjustments in the current window.

Channel

Each dot of an image is a mixture of Red, Green, and Blue in various proportions (gradation). These
colors can be adjusted individually as a "channel."

Master
Adjust the Red, Green, and Blue combined.

Red
Adjust the Red channel.

Green
Adjust the Green channel.

Blue
Adjust the Blue channel.

2> Note

* Only Grayscale will be displayed in Channel when Color Mode is Grayscale.

Reading Tone Curves

With ScanGear, scanning images via a scanner is the input, and displaying to a monitor is the output.
"Tone Curve" shows the balance of tone input and output for each Channel.
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Highlight
Output brightness
Shadow -

Shadow Highlight

Input brightness

Adjusting Tone Curve

In Select Tone Curve, select a tone curve from No correction, Overexposure, Underexposure, High
contrast, Reverse the negative/positive image, and Edit custom curve.

No correction (No adjustment)

Overexposure (Convex curve)

The midtone data of the input side is stretched toward the highlight of the output side, resulting in a bright-
toned image when viewed on a monitor.

Underexposure (Concave curve)

The midtone data of the input side is stretched toward the shadow of the output side, resulting in a dark-
toned image when viewed on a monitor.

High contrast (S curve)

The highlight and shadow of the input side are enhanced, resulting in a high-contrast image.

Reverse the negative/positive image (Downward-sloping line)

The input and output sides are reversed, resulting in a negative-positive inverted image.
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Edit custom curve

You can drag specific points on the Tone Curve to freely adjust the brightness of the corresponding areas.
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Setting Threshold

You can sharpen text in a document or reduce show-through in newspapers by adjusting the threshold level

A

via (Threshold) in ScanGear (scanner driver)'s Advanced Mode tab.

Thml‘ml‘d

A Custom *

»» Note

* This function is available when Color Mode is Black and White.
+ Click Defaults to reset all adjustments in the current window.

Adjusting Threshold

The brightness of color and grayscale images is expressed in a value between 0 and 255. However, in
creating black and white images, all colors are mapped to either black (0) or white (255). "Threshold" is
the borderline value that determines a color as black or white.

Move 4 (Slider) to the right to increase the threshold value and thus increase the black areas. Move the
slider to the left to decrease the value and thus increase the white areas. You can also enter a value (0 to
255).

Threshald Level : [128 (=

Light Dark
@

°
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ScanGear (Scanner Driver) Screens

» Basic Mode Tab
» Advanced Mode Tab

@ Input Settings

@ Output Settings

@ Image Settings

@ Color Adjustment Buttons

» Preferences Dialog Box

Scanner Tab
Preview Tab

Scan Tab

Color Settings Tab

E & & €
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Basic Mode Tab

This mode allows you to scan easily by following the on-screen steps.

This section describes the settings and functions available on the Basic Mode tab.
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= (1) Settings and Operation Buttons

= (2) Toolbar
= (3) Preview Area

23 Note

» The displayed items vary by document type and view.

(1) Settings and Operation Buttons

Select Source
Photo (Color)
Scan color photos.

Magazine (Color)
Scan color magazines.

Document (Color)
Scan documents in color.

Document (Grayscale)
Scan documents in black and white.

13 Note

* When you select a document type, the unsharp mask function will be active. The image
adjustment function which adjusts images based on the document type will also be active.
* If you select Magazine (Color), the descreen function will be active.

Display Preview Image
Preview
Performs a trial scan.
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22> Note

» When using the machine for the first time, scanner calibration starts automatically. Wait a
while until the preview image appears.

Destination
Select what you want to do with the scanned image.

Print
Select this to print the scanned image on a printer.

Image display
Select this to view the scanned image on a monitor.

OCR
Select this to use the scanned image with OCR software.

"OCR software" is software that converts text scanned as an image into text data that can be
edited in word processors and other programs.

Output Size
Select an output size.

Output size options vary by the item selected in Destination.
Flexible
Allows you to freely adjust the cropping frames (scan areas).
In thumbnail view:

Drag the mouse over a thumbnail to display a cropping frame. When a cropping frame is
displayed, the portion within the cropping frame will be scanned. When no cropping frame is
displayed, each frame is scanned individually.

In whole image view:

When no cropping frame is displayed, the entire Preview area will be scanned. When a cropping
frame is displayed, the portion within the cropping frame will be scanned.
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Paper Size (L, A4, etc.)
Select an output paper size. The portion within the cropping frame will be scanned at the size of
the selected paper size. You can drag the cropping frame to enlarge/reduce it while maintaining
the aspect ratio.

Monitor Size (1024 x 768 pixels, etc.)
Select an output size in pixels. A cropping frame of the selected monitor size will be displayed
and the portion within the cropping frame will be scanned. You can drag the cropping frame to
enlarge/reduce it while maintaining the aspect ratio.

Add/Delete...
Opens the Add/Delete the Output Size dialog box, in which you can specify custom output
sizes. You can select this option when Destination is Print or Image display.

Add/Delete the Qutput Size
Dutpet Save Masve ¢ Cutput Sine List 2
Hew Sasting |
Width .00
Hesght: | 400
Uit 3 ehed v

In the Add/Delete the Output Size dialog box, you can specify multiple output sizes and save
them at one time. Saved items will be registered to the Output Size list and can be selected,
along with the predefined items.

Adding:

Enter Output Size Name, Width, and Height, then click Add. For Unit, you can select inches or
mm when Destination is Print but you can only select pixels when Destination is Image
display. The name of the added size appears in Output Size List. Click Save to save the items
listed in Output Size List.

Deleting:

Select the output size you want to delete in Output Size List, then click Delete. Click Save to
save the items listed in Output Size List.

22 Important

* You cannot delete predefined output sizes such as A4 and 1024 x 768 pixels.

»» Note

» Save up to 10 items.

» An error message appears when you enter a value outside the setting range. Enter a value
within the setting range.

»>» Note

* For details on whether or how the cropping frame is initially displayed on a preview image, refer
to Cropping Frame on Previewed Images in "Preview Tab" (Preferences dialog box).

““Invert aspect ratio
Available when Output Size is set to anything but Flexible.

Click this button to rotate the cropping frame. Click again to return it to the original orientation.
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Adjust cropping frames

You can adjust the scan area within the Preview area.

If an area is not specified, the document will be scanned at the document size (Auto Crop). If an area
is specified, only the portion in the cropping frame will be scanned.

= Adjusting Cropping Frames (ScanGear)

Image corrections
Allows you to apply corrections to images.

22 Important

» Apply Auto Document Fix and Correct fading are available when Recommended is selected
on the Color Settings tab of the Preferences dialog box.

»» Note

+ Available functions vary by the document type selected in Select Source.

Apply Auto Document Fix
Sharpens text in a document or magazine for better readability.

3» Important

» Scanning may take longer than usual when this checkbox is selected.

» The color tone may change from the source image due to corrections. In that case, deselect
the checkbox and scan.

» Correction may not be applied properly if the scan area is too small.

Correct fading
Corrects and scans photos that have faded with time or have a colorcast.
Reduce gutter shadow

Corrects shadows that appear between pages when scanning open booklets.

32 Important

» For precautions on using this function, refer to "Gutter Shadow Correction."

Color Pattern...

Allows you to adjust the image's overall color. You can correct colors that have faded due to
colorcast, etc. and reproduce natural colors while previewing color changes.

= Adjusting Colors Using a Color Pattern

22 Important

+ This setting is not available when you select Color Matching on the Color Settings tab of
the Preferences dialog box.

Perform Scan
Scan
Starts scanning.

»» Note

* When scanning starts, the progress will be displayed. Click Cancel to cancel the scan.

Preferences...

Opens the Preferences dialog box in which you can make scan/preview settings.
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Close
Closes ScanGear (scanner driver).

(2) Toolbar
You can adjust or rotate preview images. The buttons displayed on the Toolbar vary by view.

In thumbnail view:

In whole image view:

i ;F -i-l :ﬂi el 1 U/

—

= el
lﬂ] (Thumbnail) / J (Whole Image)
Switches the view in the Preview area.

= (3) Preview Area

c
= (Rotate Left)
Rotates the preview image 90 degrees counter-clockwise.

» The result will be reflected in the scanned image.
* The image returns to its original state when you preview again.

3
o (Rotate Right)
Rotates the preview image 90 degrees clockwise.

» The result will be reflected in the scanned image.
» The image returns to its original state when you preview again.

b _"l"
)"d& (Auto Crop)

Displays and adjusts the cropping frame automatically to the size of the document displayed in the
Preview area. The scan area is reduced every time you click this button if there are croppable areas
within the cropping frame.

KX
KX

(Check All Frames)
Available when two or more frames are displayed.

Selects the checkboxes of the image in thumbnail view.

aono
Oono

(Uncheck All Frames)
Available when two or more frames are displayed.

Deselects the checkboxes of the image in thumbnail view.

BE
EJE (select All Frames)

Available when two or more frames are displayed.

Selects the images in thumbnail view and outlines them in blue.
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(Select All Cropping Frames)
Available when two or more cropping frames are specified.

Turns the cropping frames into thick broken lines and applies the settings to all of them.

~X

"""" (Remove Cropping Frame)
Removes the selected cropping frame.

d (Information)

Displays the version of ScanGear and the current scan settings (document type, etc.).

“ (Open Guide)

Opens this page.

(3) Preview Area

This is where a trial image appears after you click Preview. You can also check the results of the settings
(image corrections, color adjustments, etc.) made in "(1) Settings and Operation Buttons."

When lﬂ] (Thumbnail) is displayed on the Toolbar:

Cropping frames are specified according to the document size, and thumbnails of scanned images are
displayed. Only the images with the checkbox selected will be scanned.

»» Note

» When multiple images are previewed, different outlines indicate different selection status.

» Focus Frame (thick blue outline): The displayed settings will be applied.

» Selected Frame (thin blue outline): The settings will be applied to the Focus Frame and Selected
Frames simultaneously. You can select multiple images by clicking them while pressing the Ctrl
key.

» Unselected (no outline): The settings will not be applied.

« Double-click a frame to zoom in on the image. Click B8 (Frame Advance) at the bottom of the
screen to display the previous or next frame. Double-click the frame again to return the display to its
non-magnified state.
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=
When (Whole Image) is displayed on the Toolbar:

Items on the Platen are scanned and displayed as a single image. All portions in the cropping frames will
be scanned.

»>» Note

* You can specify the cropping frame on the displayed image. In thumbnail view, you can only create
one cropping frame per image. In whole image view, you can create multiple cropping frames.

= Adjusting Cropping Frames (ScanGear)

Related Topic

= Scanning in Basic Mode
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Advanced Mode Tab

This mode allows you to make advanced scan settings such as the color mode, output resolution, image
brightness, and color tone.

This section describes the settings and functions available on the Advanced Mode tab.
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= (1) Settings and Operation Buttons
= (2) Toolbar
= (3) Preview Area

13 Note

» The displayed items vary by document type and view.

(1) Settings and Operation Buttons

Favorite Settings
You can name and save a group of settings (Input Settings, Output Settings, Image Settings, and
Color Adjustment Buttons) on the Advanced Mode tab, and load it as required. It is convenient to

save a group of settings if you will be using it repeatedly. You can also use this to reload the default
settings.

Select Add/Delete... from the pull-down menu to open the Add/Delete Favorite Settings dialog box.

Enter Setting Name and click Add; the name appears in Favorite Settings List.
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When you click Save, the item appears in the Favorite Settings list and can be selected, along with
the predefined items.

To delete an item, select it in Favorite Settings List and click Delete. Click Save to save the settings
displayed in Favorite Settings List.

»» Note

* You can set Add/Delete... in Favorite Settings after preview.
» Save up to 10 items.

Input Settings
Specify the input settings such as the document type and size.

Output Settings
Specify the output settings such as the output resolution and size.

Image Settings
Enable/disable various image correction functions.

Color Adjustment Buttons
Fine corrections to the image brightness and color tones can be made including adjustments to the
image's overall brightness or contrast and adjustments to its highlight and shadow values (histogram)
or balance (tone curve).

Zoom
Zooms in on a frame, or zooms in on the image in the area specified with a cropping frame (scan
area). When zoomed in, Zoom changes to Undo. Click Undo to return the display to its non-
magnified state.
In thumbnail view:

When multiple images are displayed in thumbnail view, clicking this button zooms in on the selected

frame. Click B[ & (Frame Advance) at the bottom of the screen to display the previous or next
frame.

»» Note

* You can also zoom in on an image by double-clicking the frame. Double-click the frame again to
return the display to its non-magnified state.

In whole image view:
Rescans the image in the area specified with a cropping frame at higher magnification.

»>» Note

* Zoom rescans the document and displays high-resolution image in Preview.

N (Enlarge/Reduce) on the Toolbar zooms in on the preview image quickly. However, the
resolution of the displayed image will be low.

Preview
Performs a trial scan.
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Scan
Starts scanning.

23 Note

* When scanning starts, the progress will be displayed. Click Cancel to cancel the scan.

* When scanning is completed, a dialog box prompting you to select the next action may appear.
Follow the prompt to complete. For details, refer to Status of ScanGear dialog after scanning
in Scan Tab (Preferences dialog box).

« It will take time to process the images if the total size of the scanned images exceeds a certain
size. In that case, a warning message appears; it is recommended that you reduce the total size.
To continue, scan in whole image view.

Preferences...
Opens the Preferences dialog box in which you can make scan/preview settings.

Close
Closes ScanGear (scanner driver).

(2) Toolbar

You can adjust or rotate preview images. The buttons displayed on the Toolbar vary by view.

In thumbnail view:

FEREEES

In whole image view:

¥¥ OO0 @EI‘@ &)

FFE OO0 EE
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IRl 1 4

: 2 |
@ (Thumbnail) / — (Whole Image)
Switches the view in the Preview area.

—
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= (3) Preview Area

— (Clear)
Deletes the preview image from the Preview area.

It also resets the Toolbar and color adjustment settings.

(Crop)
Allows you to specify the scan area by dragging the mouse.

(Move Image)
Allows you to drag the image until the part you want to see is displayed when an image enlarged in
the Preview area does not fit in the screen. You can also move the image using the scroll bars.

S\ (Enlarge/Reduce)
Allows you to zoom in on the Preview area by clicking the image. Right-click the image to zoom out.

c
Eal’ (Rotate Left)
Rotates the preview image 90 degrees counter-clockwise.

» The result will be reflected in the scanned image.
* The image returns to its original state when you preview again.

3
o] (Rotate Right)
Rotates the preview image 90 degrees clockwise.

» The result will be reflected in the scanned image.
* The image returns to its original state when you preview again.

] _“i
ﬂgl_\ (Auto Crop)

Displays and adjusts the cropping frame automatically to the size of the document displayed in the
Preview area. The scan area is reduced every time you click this button if there are croppable areas
within the cropping frame.

KE
KR

(Check All Frames)
Available when two or more frames are displayed.

Selects the checkboxes of the image in thumbnail view.

oo
oo

(Uncheck All Frames)
Available when two or more frames are displayed.

Deselects the checkboxes of the image in thumbnail view.

EE
EE (select All Frames)

Available when two or more frames are displayed.

Selects the images in thumbnail view and outlines them in blue.

Available when two or more cropping frames are specified.

Turns the cropping frames into thick broken lines and applies the settings to all of them.
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X

(Remove Cropping Frame)
Removes the selected cropping frame.

d (Information)

Displays the version of ScanGear and the current scan settings (document type, etc.).

4 _
= (Open Guide)

Opens this page.

(3) Preview Area

This is where a trial image appears after you click Preview. You can also check the results of the settings
(image corrections, color adjustments, etc.) made in "(1) Settings and Operation Buttons."

When = (Thumbnail) is displayed on the Toolbar:

Cropping frames are specified according to the document size, and thumbnails of scanned images are
displayed. Only the images with the checkbox selected will be scanned.

»» Note

* When multiple images are previewed, different outlines indicate different selection status.

» Focus Frame (thick blue outline): The displayed settings will be applied.

» Selected Frame (thin blue outline): The settings will be applied to the Focus Frame and Selected
Frames simultaneously. You can select multiple images by clicking them while pressing the Ctrl
key.

» Unselected (no outline): The settings will not be applied.

=
When (Whole Image) is displayed on the Toolbar:

Iltems on the Platen are scanned and displayed as a single image. All portions in the cropping frames will
be scanned.
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23> Note

* You can specify the cropping frame on the displayed image. In thumbnail view, you can only create
one cropping frame per image. In whole image view, you can create multiple cropping frames.

= Adjusting Cropping Frames (ScanGear)

Related Topic

= Scanning in Advanced Mode
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Input Settings
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Input Settings allows you to set the following items:

Select Source
The type of document to be scanned is displayed.

Paper Size
Select the size of the document to be scanned. This setting is available in whole image view only.

When you select a size, the Preview area size changes accordingly.

22 Important

+ Some applications have a limit to the amount of scan data they can receive. Available scan range
is as follows.

+ 21000 pixels x 30000 pixels or less (and 1.8 GB or less in data size)

« If you change Paper Size after previewing, the preview image will be deleted.

22> Note

« If you are not sure which size you should select for Paper Size, set Paper Size to Full Platen, then

measure the size of the document and enter the values into a (Width) and 18 (Height).

Color Mode
Select how to scan the document.

Color
Select this mode to scan color documents or to create color images. This mode renders the image
in 256 levels (8 bit) of R(ed), G(reen), and B(lue).

Color(48bit)
Select this mode to scan color photos. This mode renders the image in 65536 levels (16 bit) of
R(ed), G(reen), and B(lue).
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Grayscale
Select this mode to scan black and white photos or to create black and white images. This mode
renders the image in 256 levels (8 bit) of black and white.

Black and White
Select this mode to scan photos and documents in black and white. This mode renders the image
in black and white. The contrast in the image is divided at certain levels (threshold level) into black

A

and white and is rendered in two colors. The threshold level can be set with

32 Important

(Threshold).

+ Some applications cannot display images scanned in Color(48bit).
» Color(48bit) is displayed only when the Enable 48/16 bit Output checkbox is selected on the
Scan tab of the Preferences dialog box.

Input Size
In thumbnail view, the cropped document size is displayed after preview.

In whole image view, the Paper Size is displayed before preview, and the cropping frame (scan area)
size is displayed after preview.

You can adjust the cropping frame size by entering the values into = (Width) and H (Height).

Click g (Change Aspect Ratio) and change it to g (Keep Aspect Ratio) to maintain the aspect ratio
when you specify the cropping frame size.

32 Important

* Input size settings are available only when Output Size in Output Settings is Flexible. If you
select a size other than Flexible, a cropping frame calculated from Output Size and Output
Resolution is displayed, and its aspect ratio is fixed.

»» Note

» The values you can enter will be within the range of the selected document size. The minimum size
is 96 pixels x 96 pixels when Output Resolution is 600 dpi, scaled at 100 %.

* When Auto Crop is performed in whole image view, the aspect ratio will not be maintained since
the size will be prioritized.

» Refer to "Adjusting Cropping Frames (ScanGear)" for details on cropping frames.
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Output Settings

Output Settings allows you to set the following items:

Output Resolution
Select the resolution to scan at.

The higher the resolution (value), the more detail in your image.

Select a resolution from the options displayed by clicking the button, or enter a value within the range of
25 dpi to 19200 dpi (in 1 dpi increments).

Refer to "Resolution” for your model from Home of the Online Manual for details.

Output Size
Select an output size.

Select Flexible to set custom sizes or select a size for printing or displaying. Select Add/Delete... to set
custom size and save it as a new output size option.

Flexible
You can specify the output resolution and scale, and adjust the cropping frames (scan areas).
In thumbnail view:

Drag the mouse over a thumbnail to display a cropping frame. When a cropping frame is displayed,
the portion within the cropping frame will be scanned. When no cropping frame is displayed, each
frame is scanned individually.

In whole image view:

When no cropping frame is displayed, the entire Preview area will be scanned. When a cropping
frame is displayed, the portion within the cropping frame will be scanned.

23> Note

» To enlarge/reduce the scanned image, enter values into = (Width) and = (Height) in
Output Settings or specify a value (by 1 %) for %. Although the maximum value available for
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% depends on the Output Resolution, it can be specified for up to 19200 dpi (the maximum
available output resolution).

Paper Size (L, A4, etc.) & Monitor Size (1024 x 768 pixels, etc.)

B (width), = (Height), and scale cannot be specified. The preview image will be cropped
according to the selected output size and resolution. The portion within the cropping frame will be
scanned at the size of the selected paper/monitor size. You can drag the cropping frame to
enlarge, reduce, or move it while maintaining the aspect ratio.

Add/Delete...
Opens the Add/Delete the Output Size dialog box, in which you can specify custom output sizes.

Add/Delete the Output Size. |

Do i iy 2 et Sene List @

Print e
Curtgn® e Maer |

Memw Selbng
vidth: [ 600
Heght: | 400
Uit : fkes v
Add
Cancel

In the Add/Delete the Output Size dialog box, you can specify multiple output sizes and save
them at one time. Saved items will be registered to the Output Size list and can be selected, along
with the predefined items.

Adding:

Select Print or Image display for Destination, then enter Output Size Name, Width, and Height,
then click Add. For Unit, you can select inches or mm when Destination is Print but you can only
select pixels when Destination is Image display. The name of the added size appears in Output
Size List. Click Save to save the items listed in Output Size List.

Deleting:

Select the output size you want to delete in Output Size List, then click Delete. Click Save to save
the items listed in Output Size List.

32 Important

* You cannot delete predefined output sizes such as A4 and 1024 x 768 pixels.

> Note

» Save up to 10 items for each destination.
* An error message appears when you enter a value outside the setting range. Enter a value
within the range displayed in the message.

»» Note

 Refer to "Adjusting Cropping Frames (ScanGear)" for details on cropping frames.
 For details on whether or how the cropping frame is initially displayed on a preview image, refer to
Cropping Frame on Previewed Images in "Preview Tab" (Preferences dialog box).

i (Switch Aspect Ratio)
Available when Output Size is set to anything but Flexible.

173



Click this button to rotate the cropping frame. Click again to return it to the original orientation.

Data Size
The data size when scanned with the current settings is displayed.

»» Note

* When the data size exceeds a certain size, the value appears in red. In that case, a warning
message appears when you click Scan. It is recommended that you adjust the settings to reduce
Data Size. To continue, scan in whole image view.
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Image Settings
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32 Important

» Do not apply these functions to images without moire, dust/scratches, or faded colors. The color tone
may be adversely affected.
» Image correction results may not be reflected in the preview image.

23 Note

+ Selectable settings depend on Color Mode settings.
» Scanning may take longer than usual when you use Image Settings.

Image Settings allows you to set the following items:

Image Adjustment
When Image Adjustment is set, the brightness of the specified portion of the image is optimized. Images
can be adjusted according to the automatically detected document type or the specified document type.
The result of the adjustment will be reflected in the entire image.

None
Image Adjustment will not be applied.

Auto
Applies Image Adjustment by automatically detecting the document type. It is recommended that
you normally select this setting.

Photo
Applies Image Adjustment suitable for photos.

Magazine
Applies Image Adjustment suitable for magazines.

Document
Applies Image Adjustment suitable for text documents.
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3» Important

* You can set Image Adjustment after preview.

* You can set this setting when Recommended is selected on the Color Settings tab of the
Preferences dialog box.

»» Note

« If the image is not adjusted properly with Auto, specify the document type.
» The color tone may change from the source image due to the Image Adjustment. In that case, set
Image Adjustment to None.

Reduce Show-through
Use this function to reduce show-through in duplex documents or lighten the base color in recycled
paper and other colored paper when scanning documents.

OFF
Show-through will not be reduced.

ON
Select this to reduce show-through in duplex documents or lighten the base color. It is
recommended that you normally select this setting.

32 Important

* Reduce Show-through can be set when Recommended is selected on the Color Settings tab of
the Preferences dialog box and Document or Magazine is selected for Image Adjustment.

Unsharp Mask
Emphasizes the outline of the subjects to sharpen the image when scanning photos.

OFF
Unsharp Mask will not be applied.
ON
Emphasizes the outline of the subjects to sharpen the image. It is recommended that you normally
select this setting.
Descreen
Printed photos and pictures are displayed as a collection of fine dots. "Moire" is a phenomenon where

uneven gradation or a stripe pattern appears when such photos or pictures printed with fine dots are
scanned. Descreen is the function for reducing this moire effect.

OFF
Moire will not be reduced.

ON

Reduces moire. It is recommended that you normally select this setting.

»» Note

» Even if Descreen is set to ON, some moire effects may remain if Unsharp Mask is set to ON. In
that case, set Unsharp Mask to OFF.

Reduce Dust and Scratches

Scanned photos may contain white dots caused by dust or scratches. Use this function to reduce such
noise.

None
Dust and scratches will not be reduced.
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Low
Select this to reduce small dust particles and scratches. Large ones may remain.

Medium
It is recommended that you normally select this setting.

High
Select this to reduce large dust particles and scratches; however, evidence of the reduction
process may remain or delicate parts of the image may be removed.

32 Important

 This function may not be effective for some types of photos.

»» Note

* It is recommended that you select None when scanning printed materials.

Fading Correction
Use this function to correct photos that have faded with time or have a colorcast. "Colorcast" is a
phenomenon where a specific color affects the entire picture due to the weather or ambient strong
colors.

None
Fading Correction will not be applied.

Low
Select this to correct a small amount of fading and colorcast.

Medium
It is recommended that you normally select this setting.

High
Select this to correct a large amount of fading and colorcast. This can affect the tone of the image.

3» Important

* You can set Fading Correction after preview.

* You can set this setting when Recommended is selected on the Color Settings tab of the
Preferences dialog box.

» Correction may not be applied properly if the scan area is too small.

Grain Correction
Use this function to reduce graininess (roughness) in photos taken with high-speed or sensitized film.

None
Graininess will not be reduced.

Low
Select this when the photo is slightly grainy.

Medium
It is recommended that you normally select this setting.

High
Select this when the photo is very grainy. This can affect the gradation and sharpness of the
image.

32 Important

» Correction may not be applied properly if the scan area is too small.
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Gutter Shadow Correction
Use this function to correct shadows that appear between pages when scanning open booklets.

When you set the Gutter Shadow Correction setting in the preview image, the result will be reflected.
Preview the effects before scanning, as results vary depending on the type of document and how it is
pressed.

Unclear or blurred text/lines caused by curved pages are not corrected.

None
Gutter shadow will not be corrected.

Low
Select this when the effect level is too strong with the medium setting.

Medium
It is recommended that you normally select this setting.

High
Select this when the effect level is too weak with the medium setting.

22 Important

* You can set Gutter Shadow Correction after preview.

» Do not place objects that weigh 4.4 Ibs (2.0 kg) or more on the platen. Also, do not press on the

document with a force exceeding 4.4 Ibs (2.0 kg). If you press heavily, the scanner may not work
correctly or you might break the glass.

Align the document with the edge of the Platen. If not, the shadow will not be corrected properly.

« Shadows may not be corrected properly depending on the document. If the page background is not
white, shadows may not be detected correctly or may not be detected at all.

» While scanning, press down on the spine with the same amount of pressure you used to preview
the scan. If the binding part is not even, the shadow will not be corrected properly.

(BT

* How to place the document depends on your model and the document to be scanned.

»» Note

» Cover the document with black cloth if white spots, streaks, or colored patterns appear in scan
results due to ambient light entering between the document and the Platen.
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« If the shadow is not corrected properly, adjust the cropping frame (scan area) on the preview
image.

= Adjusting Cropping Frames (ScanGear)
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Color Adjustment Buttons

The Color Adjustment Buttons allow you to make fine corrections to the image brightness and color tones
including adjustments to the image's overall brightness or contrast and adjustments to its highlight and
shadow values (histogram) or balance (tone curve).

£ 0% €< LN

3% Important

» The Color Adjustment Buttons are not available when you select Color Matching on the Color
Settings tab of the Preferences dialog box.

22> Note

+ Selectable settings depend on Color Mode settings.
* When you adjust the image via the Color Adjustment Buttons, the results will be reflected in the preview
image.

Click a Color Adjustment Button to set the following items:

e

(Saturation/Color Balance)
Adjust the saturation (vividness) and color tone of the image. Use this function to brighten colors that
have faded with time or due to colorcast. "Colorcast" is a phenomenon where a specific color affects the
entire picture due to the weather or ambient strong colors.

= Adjusting Saturation and Color Balance

i (Brightness/Contrast)
Adjust the brightness and contrast of the image. If the image is too dark or too bright, or if the image

quality is flat due to lack of contrast, you can adjust the levels of brightness and contrast.

= Adjusting Brightness and Contrast
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- (Histogram)

A histogram allows you to see the data concentration at each brightness level of an image. You can
specify the brightest level (highlight) and darkest level (shadow) within an image, cut the levels and
expand the middle of the tonal range of the image.

= Adjusting Histogram

(Tone Curve Settings)
Adjust the brightness of an image by selecting the type of graph (tone curve) showing the balance of
tone input and output. You can make fine adjustments to the brightness of a specific area.

= Adjusting Tone Curve

‘4 | (Final Review)
Make a final check of color adjustments. The final synthesized tone curve and the histogram derived

from the subsequent image processing will be displayed. There are no settings to make in this screen.

Final Review

Channed = gt \-

» For a color image, select a color in Channel to check either Red, Green, or Blue, or select Master
to check three colors together.

« If you place the cursor on the preview image, the portion will be enlarged and its RGB values (only
L when Color Mode is Grayscale) before and after the adjustments will be displayed.

4 (Threshold)

Set the boundary (threshold) at which black and white are divided. By adjusting the threshold level, you
can sharpen text in a document or reduce show-through in newspapers.

= Setting Threshold

Custom
You can name and save a set of tone curve and threshold settings of the Color Adjustment Buttons.

Select Add/Delete... from the pull-down menu; when Color Mode is set to anything but Black and
White, the Add/Delete Tone Curve Settings dialog box opens; when Color Mode is Black and
White, the Add/Delete Threshold Settings dialog box opens.
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Add/Delete Tone Cunve Settings n
Setting Name : Tone Curve Settings List :
Mew Setting | |
i =
Carel

Enter Setting Name and click Add; the name appears in Tone Curve Settings List or Threshold
Settings List. Click Save to save.

To delete an item, select it in Tone Curve Settings List or Threshold Settings List and click Delete.
Click Save to save the settings displayed in Tone Curve Settings List or Threshold Settings List.

You can load and apply the saved tone curve/threshold settings to a preview image. To load the
settings, select the saved item from the pull-down menu.

»» Note

» Save up to 20 items.

Defaults
Reset all adjustments (saturation/color balance, brightness/contrast, histogram, and tone curve).
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Preferences Dialog Box

In the Preferences dialog box, you can make advanced settings to ScanGear (scanner driver) functions via
the Scanner, Preview, Scan, and Color Settings tabs.

Click Preferences... in the ScanGear screen to open the Preferences dialog box.

Preferences n
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[ Cancel

Scanner Tab
Allows you to set the quiet mode, specify the folder in which to save images temporarily, and set the
music file to play during or at the end of a scan.

Preview Tab
Allows you to select what to do with Preview when ScanGear is started, how to display cropping frames
after previewing images, and the cropping size for thumbnails of scanned documents.

Scan Tab
Allows you to select what to do with ScanGear after scanning and set the Color Mode (48 bit output)
option for Advanced Mode tab.

Color Settings Tab
Allows you to select how to adjust color, and specify the monitor gamma value.
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Scanner Tab

On the Scanner tab, you can specify the following settings.

Preferences n
Semdner | Previen | Sean | Color Seltings
Select Foldar Where Temporary Flles ane Savpd
RO o
Soad Sattings
[C1Flay Music Curing Scannng
Clelay Sound when Scanning b Complsted
Calbaation Setleegs
Pigtean Calbestion ! Exagife
Fapeude 4t Evivy Stan = orh =
Test SCannef...
[T Cancel

Select Folder Where Temporary Files are Saved
Displays the folder in which to save images temporarily. To change the folder, click Browse... to specify
another one.

Sound Settings
You can set the machine to play music during/at the end of a scan.

Select the Play Music During Scanning or Play Sound When Scanning is Completed checkbox,
then click Browse... and specify a sound file.

You can specify the following files.

+ MIDI file (*.mid, *.rmi, *.midi)
 Audio file (*.wav, *.aif, *.aiff)
* MP3 file (*.mp3)

Calibration Settings
Platen Calibration
When you click Execute, calibration starts and the scanner will be adjusted to reproduce correct
color tones in scanned images. Perform calibration when the color tones in the preview image are
significantly different from the original item or when colors appear in white areas.

Execute at Every Scan
When you set to ON, the scanner will be calibrated every time before previewing and scanning, to
reproduce correct color tones in scanned images.

»>» Note

» Even when Execute at Every Scan is set to OFF, the scanner may be calibrated
automatically in some cases (such as immediately after you turn the machine on).

»» Note

+ Calibration may take time depending on your computer.
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Test Scanner...
Opens the Scanner Diagnostics dialog box from which you can run the scanner performance test.
Click Start to start the diagnostics.
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Preview Tab

On the Preview tab, you can specify the following settings.

Preferences n
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Preview at Start of ScanGear
Select what to do with Preview when ScanGear (scanner driver) is started.

Automatically Execute Preview
ScanGear will automatically start previewing at startup.

Display Saved Preview Image
The previously previewed image will be displayed.

The Color Adjustment Button settings, the Toolbar settings, and the Advanced Mode tab settings
are also saved.

None
No preview image will be displayed at startup.

»» Note

» Select None if you do not want to save the preview image.

Cropping Frame on Previewed Images
Select how to display cropping frames after previewing images.

Execute Auto Cropping on Previewed Images
The cropping frame (scan area) will automatically be displayed in the document size after
previewing.

Display the Last Frame on Previewed Images
A cropping frame of the same size as the last used cropping frame will be displayed after
previewing.

None
No cropping frame will be displayed after previewing.

Cropping Size for Thumbnail View
Select the cropping size for thumbnails of scanned documents.
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Larger
Displays 105 % (in width and height) of the area displayed for the standard size.

Standard
The standard size.

Smaller
Displays 95 % (in width and height) of the area displayed for the standard size.

»» Note

* When you change the Cropping Size for Thumbnail View setting, the preview images will be
refreshed and cropped to the new size. As the preview images are refreshed, the color
adjustments and other settings applied to them are reset.
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Scan Tab

On the Scan tab, you can specify the following settings.

Preferences “

Scanner | Frovdew | 5080 | ol Setkings
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Status of ScanGear dialog after scanning
Select what to do with ScanGear (scanner driver) after scanning images.

Close ScanGear automatically
Select this to return to the original application when scanning is completed.

Do not close ScanGear automatically
Select this to return to the ScanGear screen for another scan when scanning is completed.

Display the dialog to select next action
Select this to open a screen and select what to do when scanning is completed.

ScanGear ﬂ
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»» Note

» Even if Do not close ScanGear automatically or Display the dialog to select next action is set,
some applications may not support it.

Advanced Mode Settings
Enable 48/16 bit Output
Select this checkbox to display Color(48bit) in Color Mode on the Advanced Mode tab.

32 Important

» Some applications cannot receive images scanned in Color(48bit) or may close when such
images are received.
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7> Note

* When Color(48bit) is selected for Color Mode, deselecting this checkbox changes
Color(48bit) to Color.
* When using a model supporting 16 bit output, Grayscale(16bit) appears in Color Mode.
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Color Settings Tab

On the Color Settings tab, you can specify the following settings.

Preferences n
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Color Adjustment
Select one of the following.

Recommended
Select this to vividly reproduce the tone of a document on the screen. It is recommended that you
normally select this setting.

Color Matching
Select this to automatically match the scanner, monitor, and color printer colors, thus reducing time and
trouble to manually match the monitor and printer colors.

Source(Scanner)
Select scanner profile.

Target
Select target profile.

Monitor
Select this checkbox to display preview image with optimum correction for monitor.

Defaults
Returns to the default Color Matching settings.

»» Note

» The Color Adjustment Buttons on the Advanced Mode tab are not available when you select
Color Matching.
* This function is available when Color Mode is Color or Color(48bit).

None
Select this to disable color correction provided by ScanGear (scanner driver).

»» Note

* You can select one when Color Mode is Color, Color(48bit), or Grayscale.
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» Color Matching is available when ScanGear, monitor, color management-compliant application (such as
Adobe Photoshop), and printer are set up correctly.

Refer to the corresponding manual for the monitor, printer, and application settings.

Monitor Gamma
By setting the gamma value of a monitor, you can adjust the input data to the brightness characteristics
of the monitor. Adjust the value if your monitor's gamma value does not match the default value set in
ScanGear, and the colors of the original image are not accurately reflected in the monitor.

Click Defaults to return to the default Monitor Gamma value (2.20).

»» Note

» Refer to the manual of your monitor to check its gamma value. If it is not written in the manual,
contact the manufacturer.
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Placing Items (When Scanning from a Computer)

Learn how to place items on the platen of your scanner. Place items correctly according to the type of item
to be scanned. Otherwise, items may not be scanned correctly.

32 Important

» Do not place objects that weigh 4.4 Ibs (2.0 kg) or more on the platen. Also, do not press on the item
with a force exceeding 4.4 Ibs (2.0 kg). If you press heavily, the scanner may not work correctly or you
might break the glass.

* Close the document cover when scanning.

» When the scanner is placed upright, the item type may not be detected automatically. In that case,
specify the item type in IJ Scan Utility or ScanGear (scanner driver) and scan.

Placing Items

Place items as described below to scan by detecting the item type or size automatically.

32 Important

* When scanning by specifying the paper size in IJ Scan Utility or ScanGear (scanner driver), align an
upper corner of the item with the corner at the arrow (alignment mark) of the platen.

» Photos that have been cut to various shapes and items smaller than 1.2 inches (3 cm) square cannot
be cropped accurately when scanning.

» Reflective disc labels may not be scanned as expected.

For Photos, Postcards, Business Cards, or BD/DVD/CD For Magazines, Newspapers, or Documents

Place the item face-down on the platen and align an
upper corner of the item with the corner at the arrow
(alignment mark) of the platen. Portions placed on the
diagonally striped area cannot be scanned.

Placing a Single Item:

Place the item face-down on the platen, with 0.4 inch (1
cm) or more space between the edges (diagonally striped
area) of the platen and the item. Portions placed on the
diagonally striped area cannot be scanned.
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3% Important

3% Important

* Large items (such as A4 size photos) that cannot be
placed away from the edges/arrow (alignment mark)

of the platen may be saved as PDF files. To save in a

format other than PDF, scan by specifying the data
format.

+ Refer to "ltems You Can Place & How to Place
Items" for your model from Home of the Online
Manual for details on the portions in which items
cannot be scanned.

Placing Multiple ltems:

Allow 0.4 inch (1 cm) or more space between the edges
(diagonally striped area) of the platen and items, and
between items. Portions placed on the diagonally striped
area cannot be scanned.
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(A} more than 0.4 inch (1 cm)
3> Note

* You can place up to 12 items.
* Positions of slanted items (10 degrees or less) are
corrected automatically.
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Adjusting Cropping Frames (ScanGear)

"Cropping" is the act of selecting the area you want to keep in an image and discarding the rest when
scanning it.

On the Basic Mode tab and Advanced Mode tab, you can specify cropping frames (scan areas) on the
image(s) displayed in the Preview area of the screen.
When you perform a scan, each area specified with a cropping frame will be scanned as a separate image.

»>» Note

* In whole image view, you can specify multiple cropping frames on the preview image.
» Refer to "Adjusting Cropping Frames in the Image Stitch Window" for your model from Home of the
Online Manual for how to adjust cropping frames with IJ Scan Utility.

Initial Cropping Frame

In thumbnail view:

No cropping frame is specified. You can drag the mouse over a thumbnail to specify a cropping frame.

In whole image view:

An active cropping frame is automatically specified around the preview image. You can drag the cropping
frame in the Preview area to specify the area.

»>» Note

* You can change the auto crop setting in the Preferences dialog box. Refer to Cropping Frame on
Previewed Images in "Preview Tab" for details.

Cropping Frame Types

(1)

(1) Thick cropping frame (rotating or stationary)
Represents a selected cropping frame. Appears only in whole image view. You can select multiple
cropping frames by clicking them while pressing the Ctrl key. Output size, image corrections, and
other settings on the Basic Mode tab or Advanced Mode tab will be applied to all the selected
cropping frames.

(2) Thin cropping frame

In thumbnail view:

Output size, image corrections, and other settings on the Basic Mode tab or Advanced Mode tab
will be applied.

194



In whole image view:

Represents an unselected cropping frame. The settings on the Basic Mode tab or Advanced Mode
tab will not be applied.

Adjusting a Cropping Frame

The cursor will change into = jt Rﬂ '3;] (Arrow) when it is positioned over a cropping frame. If you
click and drag the mouse in the direction of the arrow, the cropping frame will expand or contract
accordingly.

The cursor will change into G%ED (Crosshair Arrow) when it is positioned within a cropping frame. Click and
drag the mouse to move the entire cropping frame.

»>» Note

» On the Advanced Mode tab, you can specify the cropping frame size by entering the values into =
(Width) and *= (Height) in Input Settings.

* You can rotate a cropping frame 90 degrees by clicking ) (Switch Aspect Ratio). However, &
(Switch Aspect Ratio) is not available when Output Size is Flexible.

Creating Multiple Cropping Frames

In thumbnail view:

You can only create one cropping frame per image.
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In whole image view:

Click and drag the mouse in a space outside the existing cropping frame to create a new cropping frame
in the Preview area. The new cropping frame will be the active cropping frame, and the old cropping frame
will be the unselected cropping frame.

You can create multiple cropping frames and apply different scan settings to each cropping frame.
You can also select multiple cropping frames by clicking them while pressing the Ctrl key.

If you select multiple cropping frames and change the settings on a tab at the right of ScanGear, the
settings will be applied to all the selected cropping frames.

When you create a new cropping frame, it retains the settings of the latest cropping frame.
2> Note

* Create up to 12 cropping frames.
» Scanning takes longer than usual when multiple cropping frames are selected.

Deleting Cropping Frames

In thumbnail view:

To delete a cropping frame, click an area outside the cropping frame on an image.
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In whole image view:

X

To delete a cropping frame, select it and click =~ (Remove Cropping Frame) on the Toolbar.
Alternatively, press the Delete key.

When there are multiple cropping frames, all the selected cropping frames (active cropping frame and
selected cropping frames) are deleted simultaneously.
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General Notes (Scanner Driver)

ScanGear (scanner driver) is subject to the following restrictions. Keep these points in mind when using it.

Scanner Driver Restrictions

When using the NTFS file system, the TWAIN data source may not be invoked. This is because the
TWAIN module cannot be written to the winnt folder for security reasons. Contact the computer's
administrator for help.

Some computers (including laptops) connected to the machine may not resume correctly from
standby mode. In that case, restart the computer.

Do not connect two or more scanner or multifunction printers with scanner function to the same
computer simultaneously. If multiple scanning devices are connected, you cannot scan from the
scanner buttons of the machine and also may experience errors while accessing the devices.
ScanGear cannot be opened in multiple applications at the same time. Within an application,
ScanGear cannot be opened for the second time when it is already open.

Be sure to close the ScanGear window before closing the application.

Make sure that you have adequate disk space available when scanning large images at high
resolutions. For example, at least 300 MB of free space is required to scan an A4 document at 600
dpi in full-color.

ScanGear and WIA driver cannot be used at the same time.

Do not enter the computer into sleep or hibernate state during scanning.

Calibration may take time if the machine is connected via USB1.1.

Scanning may fail if the computer has resumed from sleep or standby mode. In that case, disconnect
the USB cable from the computer, then reconnect it. If scanning still fails, restart the computer.

Applications with Restrictions on Use

If you start Media Center included in Windows XP Media Center Edition 2005, you may not be able to
scan using the scanner buttons of the machine. In that case, restart the computer.

You cannot scan images with Media Center included in Windows XP Media Center Edition 2005.
Scan with other applications such as IJ Scan Utility.

Some applications may not display the TWAIN user interface. In that case, refer to the application's
manual and change the settings accordingly.

Some applications do not support continuous scanning of multiple documents. In some cases, only
the first scanned image is accepted, or multiple images are scanned as one image.

To import scanned images into Microsoft Office 2000, first save them using IJ Scan Utility, then import
the saved files from the Insert menu.

When scanning Platen size images into Microsoft Office 2003 (Word, Excel, PowerPoint, etc.), click
Custom Insert in the Insert Picture from Scanner or Camera screen. Otherwise, images may not
be scanned correctly.

When scanning images into Microsoft Office 2007/Microsoft Office 2010 (Word, Excel, PowerPoint,
etc.), use Microsoft Clip Organizer.

Images may not be scanned correctly in some applications. In that case, increase the operating
system's virtual memory and retry.

When image size is too large (such as when scanning large images at high resolution), your computer
may not respond or the progress bar may remain at 0 % depending on the application. In that case,
cancel the action (for example by clicking Cancel on the progress bar), then increase the operating
system's virtual memory or reduce the image size/resolution and retry. Alternatively, scan the image
via IJ Scan Utility first, then save and import it into the application.
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Updating the ScanGear (Scanner Driver)

» Obtaining the Latest ScanGear (Scanner Driver)
» Deleting the Unnecessary ScanGear (Scanner Driver)
» Before Installing the ScanGear (Scanner Driver)

» Installing the ScanGear (Scanner Driver)
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Obtaining the Latest ScanGear (Scanner Driver)

Upgrading your current ScanGear (scanner driver) to the latest ScanGear may solve some problems you
have experienced.

Checking the Version of ScanGear

Start ScanGear and click d (Information) to display the version of ScanGear.

Obtaining ScanGear

To obtain ScanGear, access our website and download the ScanGear for your model.

32 Important

» ScanGear can be downloaded for free; however, Internet connection fees apply.
+ Install the latest ScanGear after deleting the old one. Refer to "Deleting the Unnecessary ScanGear
(Scanner Driver)" for how to delete ScanGear.

Related Topic

= Before Installing the ScanGear (Scanner Driver)
= |nstalling the ScanGear (Scanner Driver)
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Deleting the Unnecessary ScanGear (Scanner Driver)

You can delete the ScanGear (scanner driver) you no longer use.

When deleting ScanGear, close all running applications and remove the USB cable connecting the machine
and computer.

Windows 8.1 / Windows 8:

1. From the Settings charm, select Control Panel > Programs > Programs and Features.
2. Double-click CanoScan XXX Scanner Driver (where "XXX" is the model name).

3. When the Scanner Driver Uninstall dialog box appears, click Execute.

4. When a confirmation appears, click Yes.

5. When uninstallation is complete, click Complete.

ScanGear is deleted.

Windows 7 / Windows Vista:

1. From the Start menu, select Control Panel > Programs > Uninstall a program.
2. Double-click CanoScan XXX Scanner Driver (where "XXX" is the model name).
3. When the Scanner Driver Uninstall dialog box appears, click Execute.

4. When a confirmation appears, click Yes.

5. When uninstallation is complete, click Complete.
ScanGear is deleted.

»» Note

* In Windows 8.1, Windows 8, Windows 7, or Windows Vista a confirmation/warning dialog box may
appear when installing, uninstalling, or starting up software. This dialog box appears when
administrative rights are required to perform a task. If you are logged on to an administrator account,
click Yes (or Continue, Allow) to continue.

Windows XP:

1. From the Start menu, select Control Panel > Add or Remove Programs.

2. Select CanoScan XXX Scanner Driver (where "XXX" is the model name), then click

Remove.

3. When the Scanner Driver Uninstall dialog box appears, click Execute.
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4. When a confirmation appears, click Yes.

5. When uninstallation is complete, click Complete.

ScanGear is deleted.
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Before Installing the ScanGear (Scanner Driver)

Check the following points before installing ScanGear (scanner driver). Check these also when you cannot
install ScanGear.

Machine Status

« If the machine and computer are connected with a USB cable, disconnect the USB cable from the
computer.

Computer Settings

* Close all running applications.
* Log in as the administrator of the computer.

»>» Note

« If an older version of ScanGear is already installed, delete (uninstall) it beforehand. Refer to "Deleting
the Unnecessary ScanGear (Scanner Driver)" for how to delete ScanGear.

Related Topic

= Updating the ScanGear (Scanner Driver)
= |nstalling the ScanGear (Scanner Driver)
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Installing the ScanGear (Scanner Driver)

Access our website via the Internet to download the latest ScanGear (scanner driver).

Follow these steps to install the downloaded ScanGear.

1. Double-click the icon of the downloaded file.

The installation program starts.

> Note

* In Windows 8.1, Windows 8, Windows 7, or Windows Vista a confirmation/warning dialog box may
appear when installing, uninstalling, or starting up software. This dialog box appears when
administrative rights are required to perform a task. If you are logged on to an administrator
account, click Yes (or Continue, Allow) to continue.

Some applications require administrator account to continue. If you are logged on to a standard
account, switch to an administrator account and start over.

2. In the Welcome screen, click Next.

3. Read and understand the License Agreement, then click Yes.

ScanGear installation starts.

4. Connect the machine and computer with the supplied USB cable.

The computer recognizes the machine.

ScanGear is installed.

5. When the Installation Complete screen appears, click Complete.

A message prompting you to restart the computer may appear depending on your environment. Restart
the computer to complete the installation properly.

32 Important

» ScanGear can be downloaded for free; however, Internet connection fees apply.

Related Topic

= Obtaining the Latest ScanGear (Scanner Driver)
= Deleting the Unnecessary ScanGear (Scanner Driver)
= Before Installing the ScanGear (Scanner Driver)
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Useful Information on Scanning

» Adjusting Cropping Frames in the Image Stitch Window
» Resolution
» Data Formats

» Color Matching
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Adjusting Cropping Frames in the Image Stitch Window

"Cropping" is the act of selecting the area you want to keep in an image and discarding the rest when
scanning it.

In the Image Stitch window, you can specify a cropping frame on the image displayed in the Preview area.

»>» Note

» Refer to "Adjusting Cropping Frames (ScanGear)" for your model from Home of the Online Manual for
how to adjust cropping frames with ScanGear (scanner driver).

Initial Cropping Frame

No cropping frame is specified. When you select the Adjust cropping frames checkbox, an active
cropping frame is automatically specified around the image in the Preview area. You can drag the
cropping frame to specify the area.

When you perform a scan, the image in the area specified with the cropping frame will be scanned.

Adjusting a Cropping Frame

The cursor will change into = @ Rfﬂ 'ﬁﬂ (Arrow) when it is positioned over a cropping frame. Click and
drag the mouse to expand or contract the cropping frame.

The cursor will change into 4%) (Crosshair Arrow) when it is positioned within a cropping frame. Click and
drag the mouse to move the entire cropping frame.

Deleting Cropping Frames

To delete the cropping frame, deselect the Adjust cropping frames checkbox.
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Resolution

The data in the image you have scanned is a collection of dots carrying information about brightness and
color. The density of these dots is called "resolution”, and resolution will determine the amount of detail your
image contains. The unit of resolution is dots per inch (dpi). Dpi is the number of dots per inch (2.5 cm).

The higher the resolution (value), the more detail in your image; the lower the resolution (value), the less
detail.

' |
How to Set the Resolution

You can set the resolution in the following screens.

I1J Scan Utility:

A
Resolution on the E: (Scanning from a Computer) tab or Resolution on the ¥  (Scanning Using the

Scanner Buttons) tab of the Settings dialog box

ScanGear (Scanner Driver):

Output Resolution in Output Settings on the Advanced Mode tab

Appropriate Resolution Settings

Set the resolution according to the use of the scanned image.

Appropriate
Item Type Use Color Mode ——— ]
Resolution
Copyin
pying Color 300 dpi
(Printing)
Creating a postcard Color 300 dpi
Color photo
Saving to a computer Color 300 dpi
Using on a website or attachin
gor 9 | color 150 dpi
to e-mail
Saving to a computer Grayscale 300 dpi
Black and white photo Using on a website or attaching )
. Grayscale 150 dpi
to e-mail
. Color, Grayscale, or .
Copying ) 300 dpi
Black and White
Text document (document or
. . . Color, Grayscale, or .
magazine) Attaching to e-mail ) 150 dpi
Black and White
Scanning text using OCR Color or Grayscale 300 dpi
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32 Important

« If you double the resolution, the data size of the scanned image quadruples. If the file is too large, the
processing speed will slow down significantly, and you will experience inconvenience such as lack of
memory. Set the minimum required resolution according to the use of the image.

»» Note

» When you will be printing the scanned image by enlarging it, scan by setting a higher resolution than
the recommended one above.
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Data Formats

You can select a data format when saving scanned images. You should specify the most suitable data
format according to how you want to use the image on which application.
Available data formats vary by application and operating system (Windows or Mac OS).

See below for the characteristics of each image data format.

PNG (Standard File Extension: .png)
A data format often used on websites.

PNG is suitable for editing saved images.

JPEG (Standard File Extension: .jpg)
A data format often used on websites and for digital camera images.

JPEG features high compression rates. JPEG images slightly degrade every time they are saved, and
cannot be returned to their original state.

JPEG is not available for black and white images.

TIFF (Standard File Extension: .tif)
A data format featuring a relatively high compatibility between various computers and applications.

TIFF is suitable for editing saved images.

»» Note

» Some TIFF files are incompatible.
* |J Scan Utility supports the following TIFF file formats.

» Uncompressed, black and white binary

» Uncompressed, RGB (8 bits per channel)
» Uncompressed, RGB (16 bits per channel)
* Uncompressed, Grayscale

PDF (Standard File Extension: .pdf)
A data format for electronic documents, developed by Adobe Systems Incorporated.

It can be used on various computers and operating systems, and fonts can be embedded as well; therefore,
people in different environments can exchange the files without being aware of the differences.
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Color Matching

"Color Matching" is the act of making adjustments so that the color tones match between the original item,
the monitor display, and the color printout. On your scanner or printer, the color tones are adjusted as
shown below.

Example: When sRGB is selected as the output profile (target):

Input Profile (Source)

Scanner ‘

ScanGear (Scanner Driver)

'

Output Profile (Target)

sRGB ‘
I
I I
Qs/ Application/
Application Printer Driver
Monitor ‘ Printer ‘

The image's color space is converted from the scanner's color space to SRGB by ScanGear.

When displaying on a monitor, the image's color space is converted from sRGB to the monitor's color space
based on the operating system's monitor settings and the application's working space settings.

When printing, the image's color space is converted from sRGB to the printer's color space based on the
application's print settings and the printer driver's settings.
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Other Scanning Methods

» Scanning with WIA Driver

» Scanning Using the Control Panel (Windows XP Only)
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Scanning with WIA Driver

You can scan an item from a WIA (Windows Image Acquisition)-compliant application.

WIA is a driver model implemented in Windows XP or later. It allows you to scan items without using an
application.

The procedure varies depending on the application. The following procedures are examples only.

Refer to the application's manual for details.

Scanning with WIA Driver 2.0

The following is an example of scanning using "Windows Fax and Scan."

1. Place the item on the platen.

= Placing Iltems (When Scanning from a Computer)

2. Select New on the File menu of "Windows Fax and Scan," then click Scan....

The scan setting screen appears.

3. Specify the settings.

Scanner
The currently set product name is displayed. To change the scanner, click Change... and select
the product you want to use.

Profile
Select Photo (Default) or Documents according to the type of item to be scanned. To save a
new Profile, select Add profile.... You can specify the details in the Add New Profile dialog box.

Source
Select a scanner type.

Paper size
This setting is not available for your scanner.

Color format
Select the color mode in which to scan the item.

File type
Select a data format from JPEG, BMP, PNG, and TIFF.

Resolution (DPI)
Enter the resolution. Specify a value between 50 dpi and 600 dpi.

= Resolution

Brightness
Move the slider to adjust the brightness. Move it to the left to darken and right to brighten the
image. You can also enter a value (-100 to 100).

Contrast
Move the slider to adjust the contrast. Moving it to the left will decrease the contrast of the image,
thus softening the image. Moving it to the right will increase the contrast of the image, thus
sharpening the image. You can also enter a value (-100 to 100).
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Preview or scan images as separate files
Select this checkbox to preview or scan multiple images as separate files.

4. Click Preview to preview the image.

The preview image appears on the right.

5. Click Scan.

When scanning is completed, the scanned image appears in the application.

Scanning with WIA Driver 1.0

The following is an example of scanning using "Paint."

1. Place the item on the platen.

= Placing Iltems (When Scanning from a Computer)

2. Click From scanner or camera from the File menu of Paint. (Select the command to
scan an item in the application.)

3. Select the type of picture according to the item to be scanned.

Select from Color picture, Grayscale picture, Black and white picture or text, and Custom
Settings.

> Note

» To scan with the values previously set in Adjust the quality of the scanned picture, select
Custom Settings.

4. Click Adjust the quality of the scanned picture and set the preferences as required.

Brightness
Move the slider to adjust the brightness. Move it to the left to darken and right to brighten the
image. You can also enter a value (-127 to 127).

Contrast
Move the slider to adjust the contrast. Moving it to the left will decrease the contrast of the image,
thus softening the image. Moving it to the right will increase the contrast of the image, thus
sharpening the image. You can also enter a value (-127 to 127).

Resolution (DPI)
Enter the resolution. Specify a value between 50 dpi and 600 dpi.

= Resolution

Picture type
Select the type of scan you want for your item.

Reset
Click to restore the original settings.

5. Click Preview to preview the image.

The preview image appears on the right. Drag [ to specify the scan area.
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6. Click Scan.

When scanning is completed, the scanned image appears in the application.
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Scanning Using the Control Panel (Windows XP Only)

You can scan images via the Control Panel of Windows XP using the WIA driver.
1. From the Start menu, select Control Panel.

2. Click Printers and Other Hardware > Scanners and Cameras, then double-click
CanoScan XXX (where "XXX" is the model name).

The Scanner and Camera Wizard dialog box appears.
3. Click Next.

4. Select Picture type according to the item to be scanned.
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»» Note

» To scan with the values previously set in Custom settings, select Custom.

5. Click Custom settings to set the preferences as required.

Properties
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Brightness

Move the slider to adjust the brightness. Move it to the left to darken and right to brighten the image.
You can also enter a value (-127 to 127).
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Contrast
Move the slider to adjust the contrast. Moving it to the left will decrease the contrast of the image,
thus softening the image. Moving it to the right will increase the contrast of the image, thus
sharpening the image. You can also enter a value (-127 to 127).

Resolution (DPI)
Enter the resolution. Specify a value between 50 dpi and 600 dpi.

= Resolution

Picture type
Select the type of scan you want for your item.

Reset
Click to restore the original settings.

6. Click Preview to preview the image.

The preview image appears on the right. Drag M to specify the scan area.

7. Click Next and follow the instructions.
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Placing Items (When Scanning from a Computer)

Learn how to place items on the platen of your scanner. Place items correctly according to the type of item
to be scanned. Otherwise, items may not be scanned correctly.

32 Important

» Do not place objects that weigh 4.4 Ibs (2.0 kg) or more on the platen. Also, do not press on the item
with a force exceeding 4.4 Ibs (2.0 kg). If you press heavily, the scanner may not work correctly or you
might break the glass.

* Close the document cover when scanning.

* When the machine is placed upright, the item type may not be detected automatically. In that case,
specify the item type in IJ Scan Utility or ScanGear (scanner driver) and scan.

Placing Items

Place items as described below to scan by detecting the item type or size automatically.

32 Important

* When scanning by specifying the paper size in IJ Scan Utility or ScanGear, align an upper corner of
the item with the corner at the arrow (alignment mark) of the platen.

» Photos that have been cut to various shapes and items smaller than 1.2 inches (3 cm) square cannot
be cropped accurately when scanning.

» Reflective disc labels may not be scanned as expected.

For Photos, Postcards, Business Cards, or BD/DVD/CD For Magazines, Newspapers, or Documents

Place the item face-down on the platen and align an
upper corner of the item with the corner at the arrow
(alignment mark) of the platen. Portions placed on the
diagonally striped area cannot be scanned.

Placing a Single Item:

Place the item face-down on the platen, with 0.4 inch (1
cm) or more space between the edges (diagonally striped
area) of the platen and the item. Portions placed on the
diagonally striped area cannot be scanned.
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3% Important

3% Important

* Large items (such as A4 size photos) that cannot be
placed away from the edges/arrow (alignment mark) of
the platen may be saved as PDF files. To save in a
format other than PDF, scan by specifying the data
format.

» Refer to "ltems You Can Place & How to Place
Items" for details on the portions in which items
cannot be scanned.

Placing Multiple ltems:

Allow 0.4 inch (1 cm) or more space between the edges
(diagonally striped area) of the platen and items, and
between items. Portions placed on the diagonally striped
area cannot be scanned.
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(A} more than 0.4 inch (1 cm)
3> Note

* You can place up to 12 items.
* Positions of slanted items (10 degrees or less) are
corrected automatically.
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Scanning Using the Scanner Buttons

» What Are Scanner Buttons?

» Scanning Items and Saving the Scanned Images (AUTO SCAN Button)
» Scanning and Saving Items as PDF Files (PDF Buttons)

» Scanning and Printing/Copying Items (COPY Button)

» Scanning Items and Sending the Scanned Images (SEND Button)

» Scanner Button Settings

» Scanner Button Settings via IJ Scan Utility
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What Are Scanner Buttons?

The five buttons on the scanner are referred to as scanner buttons. You can create PDF files, print items,
send images, etc. by simply placing the item on the platen and pressing a scanner button.

PODF AUTO SCAN COpY SEND

22 Important

* When you press a scanner button, a program selection screen may appear instead of IJ Scan Utility. In
that case, set IJ Scan Utility as the program to start.
Refer to "Scanner Button Settings" for details.

PDF Buttons
Scan items and easily create PDF files, then save them.

»» Note

* These button names are not inscribed on the scanner.

E&m SCAN START Button
Starts scanning. Saves multiple items to a computer as one PDF file, as required.

gbl FINISH Button
Ends the PDF button operation and saves the images.

é AUTO SCAN Button
Detects the item type automatically and saves them to a computer.

<3 coPY Button
Scans items and prints them on a printer.

@ SEND Button
Scans items and attaches the scanned images to an e-mail or sends them to an application.

»>» Note

* You can specify how IJ Scan Utility responds when the scanner buttons are pressed.

= Scanner Button Settings via IJ Scan Utility

* The default save folders are as follows.

» Windows 8.1: Documents folder

* Windows 8: My Documents folder

* Windows 7: My Documents folder

* Windows Vista: Documents folder

* Windows XP: My Documents folder

220



Scanning and Saving Items as PDF Files (PDF Buttons)

You can save scanned images as PDF files.

1. Place the item on the platen.

= Placing Items (When Scanning from a Computer)

2. Press f-IEIE (SCAN START button).

Descriptions of the PDF buttons on the scanner appear.

3. Read the descriptions and click OK.
2> Note

» Select the Do not show this message again checkbox to scan items continuously using the
buttons on the scanner only.

Scanning starts.

4. Press f-IEEJ] (SCAN START button) to add a page or élH (FINISH button) to end.

A message appears after the scan.
+ Adding a page:

Press Eﬁﬂ] (SCAN START button). After the additional page is scanned, the message appears
again.

* Ending:

Press éIH (FINISH button) on the scanner.

The scanned images are saved in PDF format.
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Scanning Iltems and Saving the Scanned Images (AUTO SCAN
Button)

You can scan items by automatically detecting the item type and save them to a computer.

1. Place the item on the platen.

= Placing Items (When Scanning from a Computer)

2. Press the AUTO SCAN button.
Scanning starts.

> Note

» Scanned images are saved in the folder set for Save in in the Settings (AUTO SCAN) dialog box
displayed by clicking Settings.... In the Settings (AUTO SCAN) dialog box, you can also make
advanced scan settings.
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Scanning and Printing/Copying Items (COPY Button)

You can scan items and print them on a printer.

»» Note

* Prepare the printer when printing with the COPY button. Refer to the manual of your printer to prepare
it.

1. Place the item on the platen.

= Placing Items (When Scanning from a Computer)

2. Press the COPY button.

Scanning starts. The scanned image is printed on a printer.
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Scanning Iltems and Sending the Scanned Images (SEND Button)

You can attach scanned images to an e-mail, or send the images to compatible applications.

1. Place the item on the platen.

= Placing Items (When Scanning from a Computer)

2. Press the SEND button.

Scanning starts. The scanned image is attached to a new message, or sent to compatible applications.
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Scanner Button Settings

Set to start IJ Scan Utility when a scanner button is pressed.

Additionally, specify the scanner button settings via IJ Scan Utility to scan easily according to use.

= Scanner Button Settings via |J Scan Utility

22 Important

* Log on to an administrator account before making the settings.

Windows 8.1 / Windows 8:

1. Click the Settings charm > Control Panel > Hardware and Sound > Devices and
Printers.

2. Right-click the icon of your scanner, then select Scan properties.

3. In the User Account Control dialog box, click Yes.

4. In Actions on the Events tab, set IJ Scan Utility as the application to start.

Set Canon IJ Scan Utility for all events in Select an event.

If IJ Scan Utility is already set, click Cancel to end.

5. Click OK.

Windows 7:

1. From the Start menu, select Devices and Printers.

2. Right-click the icon of your scanner, then select Scan properties.

3. In the User Account Control dialog box, click Yes.

4. In Actions on the Events tab, set IJ Scan Utility as the application to start.

Set Canon IJ Scan Utility for all events in Select an event.

If 1IJ Scan Utility is already set, click Cancel to end.

5. Click OK.

Windows Vista:

1. From the Start menu, select Control Panel > Hardware and Sound > Scanners and
Cameras.
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2. Select CanoScan XXX (where "XXX" is the model name), then click Properties.

3. In the User Account Control dialog box, click Continue.

4. In the CanoScan XXX Properties dialog box (where "XXX" is the model name), select
the Events tab.

5. In Actions on the Events tab, set IJ Scan Utility as the application to start.

Set Canon IJ Scan Utility for all events in Select an event.

If IJ Scan Utility is already set, click Cancel to end.

6. Click OK.

Windows XP:

1. From the Start menu, select Control Panel > Printers and Other Hardware.

2. In the resulting screen, click Scanners and Cameras.

3. Right-click CanoScan XXX (where "XXX" is the model name), then click Properties.

4. In Actions on the Events tab, set |J Scan Utility as the application to start.
Set Canon IJ Scan Utility for all events in Select an event.

If IJ Scan Utility is already set, click Cancel to end.

5. Click OK.
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Scanner Button Settings via IJ Scan Utility

IJ Scan Utility allows you to specify how to respond when scanning using the scanner buttons.

22> Note

» The screens for specifying the AUTO SCAN button responses are used as examples in the following
descriptions.

1. Start IJ Scan Utility.

= Starting IJ Scan Utility

2. Click Settings....

Canon LV Scan Utility

The Settings dialog box appears.

A
3. Selectthe “ ¥ (Scanning Using the Scanner Buttons) tab.
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22> Note

» Refer to the following for details.
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= Settings (AUTO SCAN) Dialog Box
= Settings (PDF) Dialog Box

= Settings (COPY) Dialog Box

= Settings (SEND) Dialog Box

4. Set Scan Options.
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5. Specify the file name and other settings in Save Settings.
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7. Click OK.

The responses will be executed according to the specified settings when you start scanning using the
scanner buttons.
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Troubleshooting

Search Each Function

» Problems with Scanning

» Problems with Installation/Downloading
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Problems with Scanning

» Problems with Scanning
» Scan Results Not Satisfactory

» Software Problems
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Problems with Scanning

*» Error Message "Release the lock switch..." Is Displayed
» Scanner Does Not Work
» ScanGear (Scanner Driver) Does Not Start

» Error Message Appears and the ScanGear (Scanner Driver) Screen Does Not
Appear

» Scanner Buttons Do Not Work

» "Select the program to launch for this action” Is Displayed When a Scanner
Button Is Pressed

» When a Scanner Button Is Pressed, an Unexpected Application Starts
» Cannot Scan Multiple Items at One Time

» Cannot Scan Properly with Auto Scan

» Slow Scanning Speed

» "There is not enough memory." Message Is Displayed

» Computer Stops Operating during Scanning

» Scanner Does Not Work after Upgrading Windows

» Scanned Image Does Not Open

» Position or Size of the Image Cannot be Detected Correctly When Scanning
Using the Scanner Buttons
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Error Message "Release the lock switch..." Is Displayed

The scanner may be locked.

Exit the application, then unlock the scanner, and then reconnect the USB cable.

Refer to the printed manual: Getting Started for how to unlock the scanner.

233



Scanner Does Not Work
Connect the USB cable to a different USB port on the computer.

If the USB cable is connected to a USB hub, remove it from the USB hub and
connect it to a USB port on the computer.

Restart the computer.
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ScanGear (Scanner Driver) Does Not Start

Make sure that ScanGear (scanner driver) is installed.

If not installed, install ScanGear from the Setup CD-ROM or the web page.

Select your scanner on the application's menu.
32 Important

« If your scanner name is displayed multiple times, select the one that does not include WIA.

»» Note

» The operation may differ depending on the application.
» Use the WIA driver when scanning from a WIA-compliant application.

= Scanning with WIA Driver

Make sure that the application supports TWAIN.

You cannot start ScanGear from applications not supporting TWAIN.

Scan and save images with |J Scan Utility and open the files in your
application.
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Error Message Appears and the ScanGear (Scanner Driver) Screen
Does Not Appear

Connect the USB cable to a different USB port on the computer.

If the USB cable is connected to a USB hub, remove it from the USB hub and
connect it to a USB port on the computer.

Make sure that ScanGear (scanner driver) is installed.

If not installed, install ScanGear from the Setup CD-ROM or the web page.

OV Your scanner may be locked.

Close the running software program. Slide the scanner lock switch to the release position ( i ), then reconnect
the USB cable.

Select your scanner on the application's menu.
2> Note

» The operation may differ depending on the application.

Make sure that the application supports TWAIN.

You cannot start ScanGear from applications not supporting TWAIN.

Exit ScanGear if it is running on another application.
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Scanner Buttons Do Not Work

Reinstall the required applications from the Setup CD-ROM or the web page.
To use the COPY button, install the printer driver for your printer.

To use the COPY button, check that your printer operates properly.

To use the SEND button, install a compatible application or e-mail client.

If the e-mail client does not operate properly, check that the e-mail client's MAPI is
enabled. Refer to the e-mail client's manual for how to set MAPI.

The IJ Scan Utility screen may be hidden behind other windows.

Click Canon IJ Scan Utility on the taskbar to bring the IJ Scan Utility screen to the front.

Applications may not be assigned to the scanner buttons.

= Scanner Button Settings
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"Select the program to launch for this action" Is Displayed When a
Scanner Button Is Pressed

If IJ Scan Utility is not installed, install ScanGear (scanner driver) from the
Setup CD-ROM or the web page.

Set to start IJ Scan Utility when a scanner button is pressed.

= Scanner Button Settings
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When a Scanner Button Is Pressed, an Unexpected Application
Starts

Change the 1J Scan Utility settings.

Applications that correspond with the scanner buttons are managed by IJ Scan Utility. To change the assigned
M
applications, click Settings... in the IJ Scan Utility main screen and change Application Settings on the +

(Scanning Using the Scanner Buttons) tab of the Settings dialog box. Refer to the following pages for details.

= Settings (AUTO SCAN) Dialog Box
= Settings (PDF) Dialog Box

= Settings (COPY) Dialog Box

= Settings (SEND) Dialog Box
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Cannot Scan Multiple Items at One Time

Make sure that the items are placed correctly.

= Placing Items (When Scanning from a Computer)

Check if you can properly scan one item.

Some applications do not support multiple image scanning. In that case, scan each item individually.
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Cannot Scan Properly with Auto Scan

Make sure that the items are placed correctly.

= Placing Items (When Scanning from a Computer)

Multiple items scanning may not be supported.

Some applications do not support multiple image scanning. In that case, scan each item individually.
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Slow Scanning Speed

To view the image on a monitor, set the output resolution to around 150 dpi. To
print, set it to around 300 dpi.

= Resolution

Set Fading Correction, Grain Correction, etc. to None.

Refer to "Image Settings" for your model from Home of the Online Manual for details.

In 1J Scan Utility, deselect the Correct slanted text document / Detect the
orientation of text document and rotate image checkbox and scan again.

= Settings (Document Scan) Dialog Box
= Settings (Custom Scan) Dialog Box
= Settings (PDF) Dialog Box

= Settings (SEND) Dialog Box
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"There is not enough memory." Message Is Displayed

Exit other applications and try again.

oA Reduce the resolution or output size and scan again.

= Resolution
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Computer Stops Operating during Scanning

Restart the computer, reduce the output resolution in ScanGear (scanner
driver) and scan again.

Refer to "Output Settings" for your model from Home of the Online Manual for details.

AN Delete unnecessary files to obtain sufficient free hard disk space, then scan
again.
Error message may appear if there is not enough hard disk space to scan and save, when the image size is too

large (such as when scanning a large item at high resolution).

In Folder to Save Temporary Files of |J Scan Utility, specify a folder on a
drive with sufficient free space.

= Settings (General Settings) Dialog Box

Multiple devices may be connected to USB ports.

Disconnect devices other than your scanner.
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Scanner Does Not Work after Upgrading Windows

Disconnect the USB cable, then uninstall (delete) and reinstall ScanGear
(scanner driver) and IJ Scan Utility.

Step 1: Uninstall ScanGear.

Refer to "Deleting the Unnecessary ScanGear (Scanner Driver)" for your model from Home of the Online Manual
for how to delete ScanGear.

Step 2: Uninstall IJ Scan Utility.

* Windows 8.1 / Windows 8:

Click the Settings charm > Control Panel > Programs > Programs and Features.
Double-click Canon IJ Scan Utility.

When a confirmation appears, click Yes.

When uninstallation is complete, click OK.

HPoODN -

IJ Scan Utility is deleted.
2> Note

* In Windows 8.1 and Windows 8, a confirmation/warning dialog box may appear when installing,
uninstalling, or starting up software.
This dialog box appears when administrative rights are required to perform a task.
If you are logged on to an administrator account, follow the on-screen instructions.

* Windows 7 / Windows Vista:

. From the Start menu, select Control Panel > Programs > Programs and Features.
. Double-click Canon IJ Scan Utility.

. When a confirmation appears, click Yes.

. When uninstallation is complete, click OK.

A WODN -

IJ Scan Utility is deleted.
»» Note

* In Windows 7 and Windows Vista, a confirmation/warning dialog box may appear when installing,
uninstalling, or starting up software.
This dialog box appears when administrative rights are required to perform a task.
If you are logged on to an administrator account, follow the on-screen instructions.

* Windows XP:

From the Start menu, select Control Panel > Add or Remove Programs.
Select Canon IJ Scan Utility, then click Change/Remove.

When a confirmation appears, click Yes.

When uninstallation is complete, click OK.

Ao b=

IJ Scan Utility is deleted.

Step 3: Reinstall ScanGear and IJ Scan Utility.
Reinstall ScanGear and IJ Scan Utility from the Setup CD-ROM or the web page.
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Scanned Image Does Not Open

If the data format is not supported by the application, scan the image again and
select a popular data format such as JPEG when saving it.

Refer to the application's manual for details. If you have any questions, contact the manufacturer of the
application.
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Position or Size of the Image Cannot be Detected Correctly When
Scanning Using the Scanner Buttons

Make sure that the items are placed correctly.

= Placing Items (When Scanning from a Computer)

Check that the settings match the item to be scanned.

If you cannot scan properly using the AUTO SCAN button, specify the item type in IJ Scan Utility and scan
again.
= Scanning Photos

= Scanning Documents
= Scanning with Favorite Settings
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Scan Results Not Satisfactory

» Scan Quality (Image Displayed on the Monitor) Is Poor

» Scanned Image Is Surrounded by Extra White Areas

» Cannot Scan at the Correct Size

» Item Is Placed Correctly, but the Scanned Image Is Slanted

» Scanned Image Is Enlarged (Reduced) on the Computer Monitor
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Scan Quality (Image Displayed on the Monitor) Is Poor

Increase the scanning resolution if the image is jagged.

= Resolution

Set the display size to 100 %.

Some applications do not display images clearly if the display size is too small.

Update the calibration data.

Perform calibration by scanning after setting Execute at Every Scan in Calibration Settings to ON on the
Scanner tab in the Preferences dialog box of ScanGear (scanner driver). Calibration may take time depending
on your computer.

Refer to "Scanner Tab" for your model from Home of the Online Manual for details.

If moire (stripe pattern) appears, take the following measures and scan again.

+ Set one of the following settings in the Settings (Document Scan) dialog box, Settings (Custom Scan)
dialog box, Settings (Scan and Stitch) dialog box, Settings (COPY) dialog box or Settings (SEND) dialog
box of IJ Scan Utility, then scan from the IJ Scan Utility main screen.

o Set Select Source to Magazine and set Color Mode to Color
o Select the Reduce moire checkbox in Image Processing Settings

= Settings (Document Scan) Dialog Box
= Settings (Custom Scan) Dialog Box
= Settings (Scan and Stitch) Dialog Box
= Settings (COPY) Dialog Box

= Settings (SEND) Dialog Box

+ On the Basic Mode tab of ScanGear (scanner driver), select Magazine (Color) in Select Source.
Refer to "Basic Mode Tab" for your model from Home of the Online Manual for details.
+ On the Advanced Mode tab of ScanGear, set Descreen in Image Settings to ON.

Refer to "Image Settings" for your model from Home of the Online Manual for details.

»» Note

+ If moire appears when you scan a digital print photo, take the above measures and scan again.

Check the monitor's color depth.

Refer to Help of Windows or the monitor's manual for details on how to check the monitor's color depth.

LWL Clean the platen and document cover.

Clean the platen and document cover of the scanner, while taking care not to press the platen heavily.

= Maintenance

If the document is in poor condition (dirty, faded, etc.), then set Reduce Dust
and Scratches, Fading Correction, Grain Correction, etc. in Image Settings on the
Advanced Mode tab of ScanGear.

Refer to "Image Settings" for your model from Home of the Online Manual for details.
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If the color tone of images is different from the original document, take the
following measures and scan again.
» On the Advanced Mode tab of ScanGear, set Image Adjustment in Image Settings to None.
Refer to "Image Settings" for your model from Home of the Online Manual for details.
* On the Color Settings tab in the Preferences dialog box of ScanGear, set Color Matching.

Refer to "Color Settings Tab" for your model from Home of the Online Manual for details.

Cover your scanner with black cloth if white spots, streaks, or colored patterns
appear in scan results due to interference from ambient light.
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Scanned Image Is Surrounded by Extra White Areas

Specify the scan area.

u "4
[ |
Click z-‘—L (Auto Crop) in whole image view of ScanGear (scanner driver) to automatically display the cropping
frame (scan area) according to the item size.

You can also manually specify the scan area in thumbnail view or when there are white margins along the item
(for example, in photos), or when you want to create custom cropping frames.

= Adjusting Cropping Frames in the Image Stitch Window

»» Note

+ Refer to "Adjusting Cropping Frames (ScanGear)" for your model from Home of the Online Manual for how
to adjust cropping frames with ScanGear (scanner driver).
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Cannot Scan at the Correct Size

Make sure that the items are placed correctly.

= Placing Items (When Scanning from a Computer)
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Item Is Placed Correctly, but the Scanned Image Is Slanted

When Document or Magazine is selected for Select Source, deselect the
Correct slanted text document checkbox and scan the item again.

= Settings (Document Scan) Dialog Box
= Settings (Custom Scan) Dialog Box
= Settings (PDF) Dialog Box

= Settings (SEND) Dialog Box
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Scanned Image Is Enlarged (Reduced) on the Computer Monitor

Change the display setting in the application.

Refer to the application's manual for details. If you have any questions, contact the manufacturer of the
application.

»» Note

* You cannot reduce the image size in Paint. To reduce the display size, open the images in an application.

Change the resolution setting in ScanGear (scanner driver) and scan again.

The higher the resolution, the larger the resulting image will be.

= Resolution
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Software Problems

» The E-mail Client You Want to Use Does Not Appear in the Screen for Selecting
an E-mail Client
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The E-mail Client You Want to Use Does Not Appear in the Screen
for Selecting an E-mail Client

Check that the e-mail client's MAPI is enabled.

Refer to the e-mail client's manual for how to set MAPI.

If the problem is not solved even when MAPI is enabled, select None (Attach Manually) in the screen for
selecting an e-mail client, then manually attach the image to the outgoing e-mail.
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Problems with Installation/Downloading

» Cannot Install the MP Drivers

» The Found New Hardware Screen Appears When the Scanner Is Connected to a
Computer

» Installation Is Unsuccessful (Insufficient Free Hard Disk Space)
» Installation Is Unsuccessful (Insufficient Memory)

» About Inkjet Printer/Scanner/Fax Extended Survey Program
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Cannot Install ScanGear (Scanner Driver)

If the installation does not start even after the Setup CD-ROM is inserted
into your computer's disc drive:

Start the installation following the procedure below.

1. Follow the procedures as shown below.

* In Windows 8.1 or Windows 8, select the Explorer icon in taskbar on Desktop, then select
Computer from the list on the left.

* In Windows 7 or Windows Vista, click Start then Computer.

+ In Windows XP, click Start then My Computer.

|
2. Double-click the "~ j/ CD-ROM icon on the displayed window.

If the contents of the CD-ROM are displayed, double-click MSETUP4.EXE.

If you cannot install ScanGear (scanner driver) from the Setup CD-ROM, download and install the MP
Drivers from the web page.

> Note

« |If the CD-ROM icon is not displayed, try the following:

* Remove the CD-ROM from your computer, then insert it again.
* Restart your computer.

If the icon is not yet displayed, try different discs and see if they are displayed. If other discs are
displayed, there is a problem with the Setup CD-ROM. In this case, contact the service center.

If you are unable to proceed beyond the Scanner Connection:

Canon Cano5can

Scanner Connection

Make surs that the scanner is connected to the computer, and tum on
the scanner if it has an O button,

STEF 4 B

Information bd

Y The scanner is not detectad. Check the
connection,

Setup

Scanner Connecliom

Completion

[ Help
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> Note

» The scanner is not detected. Check the connection. may be displayed depending on the
computer you use.

Make sure that the USB cable is securely connected to the machine and the
computer.

Disconnect the USB cable from the machine and the computer, then connect
it again.

If you cannot resolve the problem, follow the procedure below to reinstall
ScanGear.

1. Click Cancel.

2. Click Start Over on the Installation Failure screen.

3. Click Exit on the "CanoScan XXX" screen (where "XXX" is the model name), then remove the Setup CD-
ROM.

Disconnect the USB cable from the machine and the computer.

Restart your computer.

Make sure that you have no application running.

Insert the Setup CD-ROM again, then install ScanGear.

N o oA

In other cases:

Reinstall ScanGear.

If ScanGear was not installed correctly, uninstall the CanoScan XXX Scanner Driver (where "XXX" is the
model name), restart your computer, and then reinstall ScanGear. To uninstall the CanoScan XXX
Scanner Driver, start the uninstaller from Control Panel.

When reinstalling ScanGear, install it from the Setup CD-ROM or MP Drivers from the web page.
»>» Note

« If the installer was forced to be terminated due to a Windows error, the system may be in an unstable
condition and you may not be able to install ScanGear. Restart your computer before reinstalling.
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The Found New Hardware Screen Appears When the Scanner Is
Connected to a Computer

The scanner may have been connected before installing the applications from
the Setup CD-ROM or the web page.

Disconnect the USB cable from the computer, then click Cancel in the Found New Hardware (Windows XP:
Found New Hardware Wizard) screen to close it. Then install the applications from the Setup CD-ROM or the
web page.
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Installation Is Unsuccessful (Insufficient Free Hard Disk Space)

Delete unnecessary files to obtain sufficient free hard disk space, then try again.

» From the Start menu, select All Programs > Accessories > System Tools > Disk Cleanup to delete
unnecessary files in the hard disk drive (C:).

 Select unnecessary file(s), then right-click and click Delete. Right-click Recycle Bin, then click Empty
Recycle Bin.

» From the Start menu, select Control Panel > Uninstall a program (Windows XP: Add or Remove
Programs), then delete unnecessary files.
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Installation Is Unsuccessful (Insufficient Memory)

Exit other applications or restart the computer and try again.
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About Inkjet Printer/Scanner/Fax Extended Survey Program

If you installed the Inkjet Printer/Scanner/Fax Extended Survey Program upon installing software from the
Setup CD-ROM or the web page, a confirmation screen for sending the usage status of the scanner and
applications appears every month for approximately 10 years.

Read the descriptions in the displayed screen and select one of the options below.

-l Canon Inkjet Printer/Scanner/Fax Extended Survey Program | < §

.\1 = Thank you for your cooperation in Inkjet Printer/ScennerFax Extend ed Survey Program.

& For development and marketing of produds that better mesk cusmmer needs, Canon requests that tha
information below, relzted to your Canen product, be sentto Canon (in case of wsing your Canon
praduct in China, e the legally 3aproved resssrch cormpany) throwgh the Internet

1. Information rdated @ Canon inkjst pinterf sennanfax A
SCorpita’s D5 verson, languagy, and diplay selting inforration
-Device driver and applicadon software usage logs

2. Infarmation radated @ Canon inkjet printesf fax
Printers ID number, insmilabes date and tdme, ink use informaton, nemaser of sheets printed, and maintenance
infarmation

TF your Canon praduct is shared for use, callective infarmation racorded in tha shared product will be sent,
In this survey, we will not send any ather infarmation, incduding your personal informztian. For this reason, from the

nfarmatmn that ic cant tnooe | wea 3ra nnahla o idansife cnacifie fastrenars

T you sgrea o the above, cick [Agrea]. Othervise, click [Do not agres].

If you vash to uninsizll this program, cick [Uninsz1). This will uninstzll the program, and ne furthar survay wall ba made,

| Donotagres | [ Agre |

If you agree:

Click Agree and follow the on-screen instructions. Information will be sent via the Internet. Once the
operation is completed, from the next time, information will be sent automatically without displaying the
confirmation screen.

»» Note

* An Internet security warning screen may appear when sending information.
In that case, make sure that the program name is "I[IJPLMUl.exe" and allow to continue.
» Deselect the Send automatically from the next time checkbox to open a confirmation screen

before sending the usage status from the next time too. Refer to "Changing the setting" to set to send

information automatically.

If you do not agree:

Click Do not agree. The confirmation screen closes. The usage status will not be sent this time.

After one month, the confirmation screen for sending the usage status opens again.

To uninstall the Inkjet Printer/Scanner/Fax Extended Survey Program:

To uninstall the Inkjet Printer/Scanner/Fax Extended Survey Program, click Uninstall and follow the on-
screen instructions.
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Changing the setting:
Windows 8.1/Windows 8:
1. Click the Settings charm > Control Panel > Programs > Programs and Features.
2. Double-click the Canon Inkjet Printer/Scanner/Fax Extended Survey Program.
3. When a confirmation appears, click Yes.

4. When uninstallation is complete, click OK.
Inkjet Printer/Scanner/Fax Extended Survey Program is deleted.

»» Note

* In Windows 8.1 and Windows 8, a confirmation/warning dialog box may appear when
installing, uninstalling, or starting up software.
This dialog box appears when administrative rights are required to perform a task.
If you are logged on to an administrator account, follow the on-screen instructions.

Windows 7/Windows Vista/Windows XP:

1. From the Start menu, select Control Panel > Uninstall a program (Windows XP: Add
or Remove Programs).

»» Note

* In Windows 7 and Windows Vista, a confirmation/warning dialog box may appear when
installing, uninstalling, or starting up software.
This dialog box appears when administrative rights are required to perform a task.
If you are logged on to an administrator account, follow the on-screen instructions.

2. Select Canon Inkjet Printer/Scanner/Fax Extended Survey Program.

3. Select Change.

Follow the on-screen instructions and select Yes to open a confirmation screen before sending the
usage status from the next time.

Select No to send the usage status automatically.

»» Note

+ Select Uninstall (Windows XP: Remove) to delete the Inkjet Printer/Scanner/Fax Extended
Survey Program. Follow the on-screen instructions to complete.
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